WF-C869R User's Guide
Contents

WF-C869R User's Guide............................................................................................................................ 15

Product Basics .......................................................................................................................................... 16

Installing the Optional Cabinet and Paper Cassettes ......................................................................................................................... 16
Installing the Optional Cabinet ......................................................................................................................... 16
Installing the Optional Paper Cassette Units .............................................................................................. 24
Enabling the Optional Paper Cassettes - Windows ........................................................................................... 31
Enabling the Optional Paper Cassettes - Mac ............................................................................................ 33

Using the Control Panel ..................................................................................................................... 34

Control Panel Buttons and Lights .................................................................................................. 34
Status Icon Information .................................................................................................................. 35
Selecting the Date and Time ........................................................................................................ 36
Selecting Your Country or Region ........................................................................................................ 38
Setting a Password and Locking the Control Panel ............................................................................... 40
Entering Characters on the LCD Screen ............................................................................................ 43
Using Presets .................................................................................................................................... 43
Setting User Feature Restrictions (Access Control) ..................................................................................... 46
Changing LCD Screen Language .................................................................................................. 47
Adjusting Control Panel Sounds .................................................................................................. 48
Adjusting the Screen Brightness .................................................................................................. 49
Turning Off the Operation Time Out Setting ..................................................................................... 50
Preventing PC Connection via USB ........................................................................................................ 51

Product Parts Locations ................................................................................................................ 53

Product Parts - Front ...................................................................................................................... 54
Product Parts - Inside ...................................................................................................................... 58
Product Parts - Back ...................................................................................................................... 60

Checking for Software Updates ........................................................................................................ 61
Using Power Saving Settings ........................................................................................................ 62
Changing the Sleep Timer Settings .............................................................................................. 62
Changing the Power Off Timer Settings ............................................................................................. 64

Epson Connect Solutions for Smartphones, Tablets, and More ..................................................................... 65
Setting Up Epson Connect Services ................................................................. 66
Using Epson Email Print .................................................................................. 67
Using the Epson iPrint Mobile App ................................................................. 68
Using Epson Remote Print .............................................................................. 68
Using Epson Scan to Cloud ........................................................................... 69
Using AirPrint ................................................................................................. 70
Using Google Cloud Print ............................................................................. 70
Setting Up Google Cloud Print on a Chromebook ........................................ 71
Android Printing Using the Epson Print Enabler .......................................... 72
Using Fire OS Printing .................................................................................. 73
Using Windows 10 Mobile Printing .............................................................. 73
Using Epson Print and Scan App with Windows Tablets ............................... 74

Wi-Fi or Wired Networking ............................................................................ 75
Wi-Fi Infrastructure Mode Setup ................................................................. 75
  Selecting Wireless Network Settings from the Control Panel .................. 76
Wi-Fi Direct Mode Setup ............................................................................. 79
  Enabling Wi-Fi Direct Mode ..................................................................... 80
Wi-Fi Protected Setup (WPS) ..................................................................... 82
  Using WPS to Connect to a Network ......................................................... 82
Printing a Network Status Sheet ................................................................. 83
Configuring Email Server Settings ............................................................. 84
Changing or Updating Network Connections ............................................. 85
  Accessing the Web Config Utility ........................................................... 86
Changing a USB Connection to a Wi-Fi Connection .................................. 86
Changing a Wi-Fi Connection to a Wired Network Connection .............. 86
Connecting to a New Wi-Fi Router ............................................................. 87
Disabling Wi-Fi Features ............................................................................ 87

Enabling Epson Universal Print Driver (PCL) or PostScript Printing ............ 89
Installing the Epson Universal Print Driver - Windows ............................ 89
Installing the PostScript (PS3) Printer Software - Windows ...................... 93
Installing the PostScript (PS3) Printer Software - Mac ............................. 93
Selecting PDL (Page Description Language) Settings ............................... 94
  PDL Print Configuration Options ......................................................... 96
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting Maintenance Options - Epson Universal Print Driver - Windows</td>
<td>184</td>
</tr>
<tr>
<td>Extended Settings - Epson Universal Print Driver - Windows</td>
<td>185</td>
</tr>
<tr>
<td>Selecting Default Print Settings - Epson Universal Print Driver - Windows</td>
<td>186</td>
</tr>
<tr>
<td>Locking Printer Settings - Epson Universal Print Driver - Windows</td>
<td>188</td>
</tr>
<tr>
<td>Epson Universal Print Driver Locked Setting Options</td>
<td>189</td>
</tr>
<tr>
<td>Adding Network Printers - Epson Universal Print Driver - Windows</td>
<td>190</td>
</tr>
<tr>
<td>Printing with the PostScript (PS3) Printer Software - Windows</td>
<td>193</td>
</tr>
<tr>
<td>Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows</td>
<td>193</td>
</tr>
<tr>
<td>Selecting Basic Print Settings - PostScript Printer Software - Windows</td>
<td>194</td>
</tr>
<tr>
<td>Selecting Additional Layout and Print Options - PostScript Printer Software - Windows</td>
<td>197</td>
</tr>
<tr>
<td>Selecting Default Print Settings - PostScript Printer Software - Windows</td>
<td>198</td>
</tr>
<tr>
<td>Printing with the PostScript (PS3) Printer Software - Mac</td>
<td>199</td>
</tr>
<tr>
<td>Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac</td>
<td>200</td>
</tr>
<tr>
<td>Selecting Basic Print Settings - PostScript Printer Software - Mac</td>
<td>201</td>
</tr>
<tr>
<td>Selecting Page Setup Settings - PostScript Printer Software - Mac</td>
<td>206</td>
</tr>
<tr>
<td>Selecting Print Layout Options - PostScript Printer Software - Mac</td>
<td>207</td>
</tr>
<tr>
<td>Sizing Printed Images - PostScript Printer Software - Mac</td>
<td>208</td>
</tr>
<tr>
<td>Managing Color - PostScript Printer Software - Mac</td>
<td>208</td>
</tr>
<tr>
<td>Printing Your Document or Photo - PostScript Printer Software - Mac</td>
<td>209</td>
</tr>
<tr>
<td>Checking Print Status - PostScript Printer Software - Mac</td>
<td>210</td>
</tr>
<tr>
<td>Cancelling Printing Using a Product Button</td>
<td>211</td>
</tr>
<tr>
<td><strong>Scanning</strong></td>
<td>212</td>
</tr>
<tr>
<td>Starting a Scan</td>
<td>212</td>
</tr>
<tr>
<td>Starting a Scan Using the Product Control Panel</td>
<td>212</td>
</tr>
<tr>
<td>Scanning to Email</td>
<td>214</td>
</tr>
<tr>
<td>Scanning to a Network Folder or FTP Server</td>
<td>216</td>
</tr>
<tr>
<td>Adding and Assigning Scan Jobs with Document Capture</td>
<td>219</td>
</tr>
<tr>
<td>Control Panel Scanning Options</td>
<td>220</td>
</tr>
<tr>
<td>Starting a Scan Using the Epson Scan 2 Icon</td>
<td>223</td>
</tr>
<tr>
<td>Starting a Scan from a Scanning Program</td>
<td>225</td>
</tr>
<tr>
<td>Starting a Scan from a Smart Device</td>
<td>227</td>
</tr>
<tr>
<td>Scanning with Document Capture Pro or Document Capture</td>
<td>227</td>
</tr>
<tr>
<td>Scanning in Epson Scan 2</td>
<td>230</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Solving Setup Problems</td>
<td>373</td>
</tr>
<tr>
<td>Product Does Not Turn On or Off</td>
<td>374</td>
</tr>
<tr>
<td>Noise After Ink Installation</td>
<td>374</td>
</tr>
<tr>
<td>Software Installation Problems</td>
<td>374</td>
</tr>
<tr>
<td>Solving Network Problems</td>
<td>375</td>
</tr>
<tr>
<td>Product Cannot Connect to a Wireless Router or Access Point</td>
<td>375</td>
</tr>
<tr>
<td>Network Software Cannot Find Product on a Network</td>
<td>377</td>
</tr>
<tr>
<td>Product Does Not Appear in Mac Printer Window</td>
<td>378</td>
</tr>
<tr>
<td>Cannot Print Over a Network</td>
<td>378</td>
</tr>
<tr>
<td>Cannot Scan Over a Network</td>
<td>380</td>
</tr>
<tr>
<td>Solving Copying Problems</td>
<td>381</td>
</tr>
<tr>
<td>Product Makes Noise, But Nothing Copies</td>
<td>381</td>
</tr>
<tr>
<td>Product Makes Noise When It Sits for a While</td>
<td>381</td>
</tr>
<tr>
<td>Originals Do Not Feed From the Automatic Document Feeder</td>
<td>381</td>
</tr>
<tr>
<td>Solving Paper Problems</td>
<td>382</td>
</tr>
<tr>
<td>Paper Feeding Problems</td>
<td>383</td>
</tr>
<tr>
<td>Paper Jam Problems in the Front Cover (A)</td>
<td>384</td>
</tr>
<tr>
<td>Paper Jam Problems in the Rear Paper Feed Slot (B1)</td>
<td>386</td>
</tr>
<tr>
<td>Paper Jam Problems in the Cassette (C1/C2/C3/C4)</td>
<td>386</td>
</tr>
<tr>
<td>Paper Jam Problems in the Rear Cover 1 (D1)</td>
<td>388</td>
</tr>
<tr>
<td>Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit</td>
<td>390</td>
</tr>
<tr>
<td>Document Jams in the Automatic Document Feeder (F)</td>
<td>393</td>
</tr>
<tr>
<td>Paper Ejection Problems</td>
<td>398</td>
</tr>
<tr>
<td>Solving Problems Printing from a Computer</td>
<td>398</td>
</tr>
<tr>
<td>Nothing Prints</td>
<td>398</td>
</tr>
<tr>
<td>Product Icon Does Not Appear in Windows Taskbar</td>
<td>399</td>
</tr>
<tr>
<td>Printing is Slow</td>
<td>400</td>
</tr>
<tr>
<td>Solving PostScript Printing Problems</td>
<td>401</td>
</tr>
<tr>
<td>Nothing Prints Using the PostScript Printing Software</td>
<td>402</td>
</tr>
<tr>
<td>Documents Print Incorrectly Using the PostScript Printing Software</td>
<td>402</td>
</tr>
<tr>
<td>Accessing Printer Properties - PostScript - Windows</td>
<td>402</td>
</tr>
<tr>
<td>Solving Page Layout and Content Problems</td>
<td>403</td>
</tr>
<tr>
<td>Inverted Image</td>
<td>403</td>
</tr>
</tbody>
</table>
Too Many Copies Print ................................................................. 404
Blank Pages Print ........................................................................ 404
Incorrect Margins on Printout........................................................ 404
Incorrect Characters Print .............................................................. 405
Incorrect Image Size or Position ...................................................... 405
Slanted Printout ........................................................................... 406
Solving Print Quality Problems ..................................................... 406
White or Dark Lines in Printout ....................................................... 406
Blurry or Smeared Printout ............................................................. 407
Faint Printout or Printout Has Gaps ................................................ 408
Grainy Printout ........................................................................... 409
Incorrect Colors .......................................................................... 410
Solving Scanning Problems ............................................................. 411
Scanning Software Does Not Operate Correctly .............................. 411
Cannot Start Epson Scan 2 ............................................................. 412
Solving Scanned Image Quality Problems ..................................... 413
Image Consists of a Few Dots Only ................................................ 413
Line of Dots Appears in All Scanned Images .................................. 413
Straight Lines in an Image Appear Crooked ................................... 414
Image is Distorted or Blurry ............................................................ 414
Image Colors are Patchy at the Edges .......................................... 414
Image is Too Dark ........................................................................ 415
Back of Original Image Appears in Scanned Image ....................... 415
Ripple Patterns Appear in an Image .............................................. 415
Scanned Image Colors Do Not Match Original Colors ................ 416
Scanned Image Edges are Cropped ................................................. 416
Solving Faxing Problems ............................................................... 416
Cannot Send or Receive Faxes ....................................................... 417
Cannot Receive Faxes with a Telephone Connected to Your Product 418
Fax Memory Full Error Appears ..................................................... 419
Sent Fax Quality is Poor ............................................................... 419
Sent Fax is Received in an Incorrect Size ...................................... 420
Received Fax Quality is Poor ......................................................... 420
Received Fax is Not Printed ................................................................. 421
Solving USB Device Problems .............................................................. 421
  Cannot View or Print from a USB Device .......................................... 421
  Cannot Save Files on a USB Device ................................................. 422
  Cannot Transfer Files To or From a USB Device ......................... 422
Uninstall Your Product Software .......................................................... 423
  Uninstalling Product Software - Windows .................................... 423
  Uninstalling Product Software - Mac .......................................... 424
Where to Get Help .............................................................................. 425
Technical Specifications ..................................................................... 426
  Windows System Requirements ................................................. 426
  Mac System Requirements .......................................................... 427
  Paper Specifications ..................................................................... 428
  Printable Area Specifications ..................................................... 429
  Scanning Specifications .............................................................. 430
  Automatic Document Feeder (ADF) Specifications ......................... 431
  Fax Specifications ........................................................................ 431
  Ink Pack Specifications ............................................................... 432
  Dimension Specifications ............................................................. 433
  Electrical Specifications .............................................................. 434
  Environmental Specifications ....................................................... 434
  Interface Specifications .............................................................. 434
  External USB Device Specifications ............................................. 435
  Network Interface Specifications ................................................ 435
  Safety and Approvals Specifications .......................................... 436
  PS3 Mode Fonts ........................................................................... 438
  PCL Mode Fonts (URW) ................................................................ 440
  Symbol Sets ................................................................................ 442
Notices ............................................................................................... 447
  Important Safety Instructions ..................................................... 447
    General Product Safety Instructions ........................................ 447
    Optional Cabinet Safety Instructions ....................................... 449
    Ink Pack Safety Instructions .................................................. 449
Welcome to the WF-C869R User's Guide.
For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

- Installing the Optional Cabinet and Paper Cassettes
- Using the Control Panel
- Product Parts Locations
- Checking for Software Updates
- Using Power Saving Settings
- Epson Connect Solutions for Smartphones, Tablets, and More
- Using AirPrint
- Using Google Cloud Print
- Setting Up Google Cloud Print on a Chromebook
- Android Printing Using the Epson Print Enabler
- Using Fire OS Printing
- Using Windows 10 Mobile Printing
- Using Epson Print and Scan App with Windows Tablets

Installing the Optional Cabinet and Paper Cassettes

Follow the instructions in this section to install the optional cabinet and paper cassettes to your product. If you are installing the optional cabinet, install the cabinet under the bottom optional cassette unit first.

- Installing the Optional Cabinet
- Installing the Optional Paper Cassette Units

Parent topic: Product Basics

Installing the Optional Cabinet

You can install the optional cabinet to provide mobility and extra storage space.

1. Turn off the product, and unplug the power cord and any connected cables.

   **Warning:** To avoid electric shock, make sure you unplug the power cord.

2. Remove the cabinet from its packaging and remove any protective materials.
3. Make sure you have all the items shown here:

1. Optional cabinet
2. Side stands (×2)
3. Front reinforcing bar
4. Rear reinforcing bar
5. Front cover
6. Cabinet screws (×2)
7. Rear brackets (×2)
8. Bracket screws (×2)
9. Side stand and reinforcing bar screws (×8)
4. Place the stands between the cabinet's casters as shown.

5. Secure the stands to the cabinet with the included screws.

**Caution:** Make sure the stands are securely attached or the product may fall over.
6. Attach and secure the reinforcing bars to the stands with the included screws.

7. Place the cabinet on a flat surface and lock the front casters.
8. Attach the front cover to the stands.

9. Remove the output tray from the product.
10. Remove paper cassette 2 from the product.

**Note:** If you are installing the optional cabinet under the optional paper cassette unit, remove the paper cassette from the optional cassette unit instead.
11. Lift up your product or optional cassette unit and gently lower it onto the cabinet with the corners aligned. Secure the product or optional cassette unit to the cabinet with the included screws using a screwdriver.

*Note:* Screws may be left over after installation.
Warning: To lift the product, have two or more people hold it as shown here. Lifting from other areas may cause the product to fall or cause you to pinch your fingers when placing the product down.

12. Secure the back of the product or paper cassette unit to the cabinet using the included brackets and screws.

13. Insert the paper cassette you removed and attach the output tray.
14. Connect the power cord and other connection cables, then plug in the product.

Parent topic: Installing the Optional Cabinet and Paper Cassettes
Installing the Optional Paper Cassette Units

You can install up to two optional paper cassette units to provide more paper capacity. If you are using the optional cabinet, install the cabinet under the bottom optional cassette unit first.

1. Turn off the product, and unplug the power cord and any connected cables.

   **Warning:** To avoid electric shock, make sure you unplug the power cord.

2. Uninstall any optional cassette units already installed on the product.

   **Note:** To uninstall optional cassette units, turn off the product, unplug the power cord, disconnect any cables, and follow the rest of these instructions in reverse.

3. Remove the paper cassette unit from its packaging and remove any protective materials.

4. Make sure you have all the items shown here:

   ![Diagram of paper cassette unit with labeled parts](image)

   - 1. Optional cassette
   - 2. Screws (×4)
   - 3. Paper size label
   - 4. Cassette number sticker
5. Remove the output tray.

6. Remove paper cassette 2 from the product.
7. Remove the paper cassette from the optional paper cassette unit.

8. Stack all optional paper cassette units on top of each other and secure them to each other with the included screws.
9. Lift up your product and gently lower it onto the paper cassette unit with the corners aligned. Secure the product to the paper cassette unit with the included screws using a screwdriver.

**Note:** Screws may be left over after installation.
**Warning:** To lift the product, have two people hold it as shown here. Lifting from other areas may cause the product to fall or cause you to pinch your fingers when placing the product down.

10. Secure the back of the paper cassette units to each other and to the product using the included brackets and screws.
11. Insert a label into the holder indicating the paper size to be loaded in each of the paper cassettes.
12. Insert the paper cassette and place the correct sticker on the cassette unit to indicate the cassette number.

13. Connect the power cord and other connection cables, then plug in the product.
14. Turn on the product.
15. Pull out and reinsert the paper cassettes in the optional paper cassette units and confirm that each cassette unit number is displayed on the screen.
16. Enable the optional paper cassette units in the printer software.

- Enabling the Optional Paper Cassettes - Windows
- Enabling the Optional Paper Cassettes - Mac

**Parent topic:** Installing the Optional Cabinet and Paper Cassettes

**Related tasks**
- Synchronizing Printer Settings - Epson Universal Print Driver - Windows
- Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

Enabling the Optional Paper Cassettes - Windows

You need to enable the optional paper cassette units before you can use them with the printer software.

Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the link below to enable the optional cassette units.

1. Do one of the following:
   - **Windows 10**: Click (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name and select Printer properties.
   - **Windows 7**: Click and select Devices and Printers. Right-click your printer name and select Printer properties.
   - **Windows Vista**: Click and select Control Panel. Click Printer under Hardware and Sound, then right-click your printer name and select Properties.
   - **Windows XP**: Click Start and select Printers and Faxes. Right-click your product name and select Properties.

2. Click the Optional Settings tab.
You see a window like this:

3. Make sure **Acquire from Printer** is selected, and click **Get**.
   The optional paper sources are listed in the Current Printer Information section.
4. Click **OK**.
   The optional paper cassettes are now enabled.

**Parent topic:** Installing the Optional Paper Cassette Units

**Related tasks**
- Synchronizing Printer Settings - Epson Universal Print Driver - Windows
- Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
- Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
- Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - Mac

You need to enable the optional paper cassette units before you can use them with the printer software.

**Note:** If you are using the PostScript (PS3) printer software, see the link below to enable the optional cassette units.

1. In the Apple menu or the Dock, select **System Preferences**.
2. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
3. Select **Driver** or **Options**.
   
   You see a screen like this:

   ![Options settings screen](image)

4. Select the number of cassette units installed as the **Lower Cassette** setting.
5. Click **OK**.

The optional paper cassettes are now enabled.

**Parent topic:** Installing the Optional Paper Cassette Units
Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Selecting the Date and Time
Selecting Your Country or Region
Setting a Password and Locking the Control Panel
Setting User Feature Restrictions (Access Control)
Changing LCD Screen Language
Adjusting Control Panel Sounds
Adjusting the Screen Brightness
Turning Off the Operation Time Out Setting
Preventing PC Connection via USB
Parent topic: Product Basics

Control Panel Buttons and Lights

1. The power button and light
2. The NFC (Near Field Communication) tag
3 The Received Fax light
4 The home button
5 The LCD screen
6 The log out button
7 The help button
8 The stop button
9 The Interrupt button
10 The Reset button
11 The Paper Setting button
12 The Job/Status button, the Error light, and the Data light
13 The numeric keypad
14 The Contacts button
15 The clear button

Status Icon Information

**Parent topic:** Using the Control Panel

**Status Icon Information**

Your product displays status icons on the LCD screen for certain product status conditions. Press the icon to view or change the current network settings.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄</td>
<td>Displays additional information or instructions, such as loading paper or placing a document.</td>
</tr>
<tr>
<td>📜</td>
<td>Displays the Printer Status screen.</td>
</tr>
<tr>
<td>🏷️</td>
<td>Quiet Mode is enabled. Noise is reduced during printing, but the print speed may be reduced. Press this icon to change the settings.</td>
</tr>
<tr>
<td>🏷️</td>
<td>Quiet Mode is disabled. Press this icon to change the settings.</td>
</tr>
<tr>
<td>🎈</td>
<td>The Mute setting is enabled. The printer does not make any sound when you press buttons on the control panel.</td>
</tr>
<tr>
<td>Icons</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>✉️</td>
<td>Displays the Fax Data Information screen.</td>
</tr>
<tr>
<td>🌙</td>
<td>Press this icon to enable sleep mode and turn off the LCD screen.</td>
</tr>
<tr>
<td>🔴</td>
<td>The indicated setting has changed.</td>
</tr>
<tr>
<td>🟢</td>
<td>There is a problem with the indicated setting. Press the icon to resolve the problem.</td>
</tr>
<tr>
<td>🌑</td>
<td>No Ethernet connection.</td>
</tr>
<tr>
<td>🌑</td>
<td>An Ethernet connection is established.</td>
</tr>
<tr>
<td>🌑</td>
<td>No Wi-Fi connection.</td>
</tr>
<tr>
<td>🌑</td>
<td>A Wi-Fi network error has occurred or the product is searching for a connection.</td>
</tr>
<tr>
<td>🌑</td>
<td>A Wi-Fi connection is established. The number of bars indicates the connection’s signal strength.</td>
</tr>
<tr>
<td>🌑</td>
<td>No Wi-Fi Direct connection.</td>
</tr>
<tr>
<td>🌑</td>
<td>A Wi-Fi Direct connection is established.</td>
</tr>
<tr>
<td>📜</td>
<td>Access to the product’s functions are restricted to authorized users. Press the icon to log in to the printer using a user name and password. Contact your administrator if you do not know the login information.</td>
</tr>
<tr>
<td>📜</td>
<td>Access to the product’s functions are restricted to authorized users and a user is currently logged in. Press the icon to log out of the current user account.</td>
</tr>
</tbody>
</table>

**Parent topic:** [Control Panel Buttons and Lights](#)

**Selecting the Date and Time**

Before using your product, select the current date, time, and daylight saving phase in your area, and choose your preferred date and time format.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

![General Settings](image)

4. Select **Basic Settings**.

![Basic Settings](image)

5. Select **Date/Time Settings**.
You see a screen like this:

6. Select **Daylight Saving Time**.
7. Select the setting that applies to your area:
   - **Winter**: it is winter or your region does not use Daylight Saving Time (DST)
   - **Summer**: it is spring or summer and your region uses Daylight Saving Time (DST)

   **Note**: If your region uses Daylight Saving Time (DST), you must change this setting to match the season. When you change from **Winter** to **Summer**, your product automatically sets its clock ahead one hour. When you change from **Summer** to **Winter**, it sets its clock back one hour.

8. Select **Date/Time**.
9. Select the date format you want to use.
10. Use the numeric keypad to enter the current date.
11. Select the time format you want to use.
12. Use the numeric keypad to enter the current time.

**Parent topic**: Using the Control Panel

**Selecting Your Country or Region**

Before using your product, select the country or region in which you are using your product.
Note: If you change the country or region, your fax settings return to their defaults and you must select them again. This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select **Basic Settings**.

5. Scroll down and select **Country/Region**.

6. Scroll up or down, if necessary, and select your country or region.
   You see a confirmation screen.

7. If the setting is correct, select **Yes**. (If not, select **No** and retry.)

**Parent topic:** Using the Control Panel

**Setting a Password and Locking the Control Panel**

You can set an administrator password to lock the following settings and prevent them from being changed:

- Network settings
- Web Service settings
- Scan settings
- System Administration settings
- Fax settings
- Web Config settings
- EpsonNet Config settings
Note: For more information on administration settings, see the Administrator’s Guide.

1. Press the home button, if necessary.
2. Select Settings.
   You see a screen like this:

   ![General Settings screen](image)

4. Scroll down and select System Administration.
5. Select Security Settings.
6. Scroll down and select Admin Settings.
7. Select Admin Password.
8. Select Register.
You see a screen like this:

![Keyboard](image)

9. Use the displayed keyboard to enter a password and select **OK**.
10. Enter your password again to confirm.

   **Note:** Keep a copy of your password in a safe place.

11. Select **OK**.
12. Turn **Lock Setting** on.

When the control panel is locked, you must enter the password to access any of the locked settings.

**Note:** If you forget your password, contact Epson for assistance.

- Entering Characters on the LCD Screen
- Using Presets

**Parent topic:** Using the Control Panel

**Related tasks**

Setting User Feature Restrictions (Access Control)
Entering Characters on the LCD Screen

Follow these guidelines to enter characters for passwords and other settings.

- To move the cursor, select the left or right arrows.
- To change the case of letters, select .
- To delete the previous character, select .
- To enter numbers or symbols, select 123#.
- To enter a space, select Space.

Parent topic: Setting a Password and Locking the Control Panel

Using Presets

You can save frequently used copy, fax, and scan settings as presets. This lets you easily reuse them whenever necessary.

Note: Presets can be locked by an administrator. If you cannot access or change presets, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Presets**.
   You see a screen like this:

   ![Presets screen](image)

   *No preset is registered.*
   *Add new preset.*

   ![Add New button](image)

3. Select **Add New**. Enter the Administrator password, if necessary.

   **Note:** You can save up to 50 presets.

4. Select the function for which you want to set up a preset.
You see the main screen for that function, such as the Copy screen:

![Copy Screen Image]

5. Select the settings you want to save and select Register.

You see a screen like this:

![Registration Screen Image]

6. Select Name.
You see a screen like this:

7. Use the displayed keyboard to enter a name for the preset and select **OK**.
8. Select **OK**.

When you copy, fax, or scan, you can use the preset by selecting **Presets** and selecting your preset name from the list.

**Parent topic:** Setting a Password and Locking the Control Panel

**Related tasks**

- **Entering Characters on the LCD Screen**
- **Setting User Feature Restrictions (Access Control)**

**Setting User Feature Restrictions (Access Control)**

Using Web Config Access Control Settings, you can restrict product features for individual users to prevent misuse of the product. Restricted features require the user to enter an ID and password on the product control panel.

After you setup feature restrictions, you must enable them using the product control panel.

**Note:** For more information on administration settings, see the *Administrator’s Guide*.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:

![General Settings](image)

4. Scroll down and select **System Administration**.
5. Select **Security Settings**.
6. Select **Access Control**.
7. Select **On**.
8. Enable **Accept Unknown User Jobs** to allow users to print from generic drivers or use the WSD scanning function.

**Parent topic:** Using the Control Panel

**Related tasks**
- Setting a Password and Locking the Control Panel
- Entering a User ID and Password for Printing
- Entering a User ID and Password for Scanning

**Changing LCD Screen Language**

You can change the language used on the LCD screen.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.
1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:

![General Settings]

4. Select **Basic Settings**.
5. Scroll down and select **Language**.
6. Select a language.

**Parent topic:** Using the Control Panel

### Adjusting Control Panel Sounds

You can adjust the sound level heard when you press buttons on the control panel.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
You see a screen like this:

![General Settings screen](image)

4. Select **Basic Settings**.
5. Select **Sound**.
6. Select **Normal Mode** or **Quiet Mode**.

   **Note:** Press the icon on the home screen to switch between Normal Mode and Quiet Mode.

7. Select **Button Press**.
8. Press to decrease or to increase the sound.
9. Select **OK** to exit.

   **Note:** You can also adjust the **Sound Type** and the sound level for various product functions.

**Parent topic:** Using the Control Panel

**Adjusting the Screen Brightness**

You can adjust the brightness of the LCD screen.
1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:

   ![General Settings](image)

4. Select **Basic Settings**.
5. Select **LCD Brightness**.
6. Do one of the following:
   - Press the – or + icons to decrease or increase the brightness.
   - Press the brightness level on the LCD screen, select a number from the on-screen keypad, and press **OK**.
7. Select **OK** to exit.

**Parent topic:** Using the Control Panel

### Turning Off the Operation Time Out Setting

The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes of inactivity. This feature is enabled by default, but you can turn it off.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.
1. Press the \home button, if necessary.
2. Select Settings.
   You see a screen like this:

   ![General Settings screen]

4. Select Basic Settings.
5. Scroll down and set Operation Time Out to Off.

   **Parent topic:** [Using the Control Panel](#)

**Preventing PC Connection via USB**

You can disable access from a USB-connected computer. This restricts non-network access to the product and protects the security of confidential scanned documents.

1. Press the \home button, if necessary.
2. Select Settings.
You see a screen like this:

4. Select **Printer Settings**.
   You see a screen like this:

   ![Screen with Printer Settings]

5. Scroll down and select **PC Connection via USB**.
6. Select **Disable**.
Product Parts Locations

See these sections to identify the parts on your product.

- Product Parts - Front
- Product Parts - Inside
- Product Parts - Back

Parent topic: Product Basics
Product Parts - Front

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, you can use these codes to locate and correct the problem.

1. Automatic Document Feeder (ADF) cover (F)
2. ADF edge guides
3  ADF input tray (F)
4  ADF output tray
5  Ink cases (P1, P2)
6  Paper cassettes 1 and 2 (C1 and C2)
7  Optional cassettes 3 and 4 (C3 and C4)
3  Rear paper feed slot (B1)
4  Feeder guard
5  Output tray
6  Paper cassette edge guides
7  Paper cassette

**Parent topic:** Product Parts Locations
Product Parts - Inside

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use these codes to locate and correct the problem.

1  Document cover
2  Scanner glass
3  Control panel
4  USB Type A port for external devices
5  Print head
6  Front cover (A)

**Parent topic:** Product Parts Locations
Product Parts - Back

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use these codes to locate and correct the problem.

1  Rear cover 2 (D2)
2  AC inlet
3  Rear cover 1 (D1)
4  Paper cassette rear covers (E)
5  Service USB port for future use (do not remove sticker)
6 Line port
7 EXT port
8 LAN port
9 USB port

Note: If you are using a USB connection, make sure you insert the cable in the correct orientation.

Parent topic: Product Parts Locations

Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Note: Epson periodically provides firmware updates to address issues of security, performance, minor bug fixes and ensure your printer functions as designed. Your printer was designed to work only with genuine Epson ink packs, therefore some updates may affect the functionality of third-party ink.

• Windows: Your printer software automatically checks for updates. You can also manually update the software by selecting Software Update here:
  • Accessing the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking .
• On the **Maintenance** tab in the printer settings window

You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

• **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

• **macOS 10.12.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

**Parent topic:** Product Basics

## Using Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period of time. You can make the time period shorter and select other options to save energy and resources.

**Changing the Sleep Timer Settings**

**Changing the Power Off Timer Settings**

**Parent topic:** Product Basics

## Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the **home** button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
You see a screen like this:

![General Settings menu](image)

4. Select **Basic Settings**.
5. Select **Sleep Timer**. Enter the administrator password, if necessary.

You see a screen like this:
6. Do one of the following:
   • Press the – or + icon to decrease or increase the number of minutes.
   • Press the number of minutes on the LCD screen, select the number of minutes from the on-screen keypad, and press OK.
7. Select OK.
8. Select Wake from Sleep.
9. Select Wake with LCD Screen Touch.
10. Do one of the following:
    • Select On to wake the printer from sleep mode by tapping the LCD touchscreen or by pressing a button on the control panel.
    • Select Off to only wake the printer from sleep mode by pressing a button on the control panel. This prevents unintentional operations due to objects bumping the LCD touchscreen.

**Parent topic:** Using Power Saving Settings

### Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the \( \text{Home} \) home button, if necessary.
2. Select Settings.
You see a screen like this:

![General Settings Screen](image)

4. Select **Basic Settings**.
5. Do one of the following depending on the setting you see displayed on the LCD screen:
   - Select **Power Off Timer**, then select a time period between **30 minutes** and **12h** (12 hours).
   - Select **Power Off Settings**, then select **Power Off If Inactive** to adjust the time before the product turns off automatically or **Power Off If Disconnected** to turn the product off after 30 minutes of inactivity over the network.

**Parent topic:** Using Power Saving Settings

---

**Epson Connect Solutions for Smartphones, Tablets, and More**

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages from your home, office, or even across the globe.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Print from anywhere with these Epson Connect solutions:
- Epson Email Print
• Epson iPrint Mobile App
• Epson Remote Print

Scan and send a file as an email or upload it to an online service directly from your Epson product with Epson Scan to Cloud or the Epson iPrint Mobile App.

Setting Up Epson Connect Services
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Using Epson Scan to Cloud

Parent topic: Product Basics

Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your product, you can activate it using the product control panel.

1. Press the \( \Rightarrow \) home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

You see a screen like this:
4. Select **Web Service Settings**.
5. Select **Epson Connect Services**
   You see a screen like this:

   ![](image)

6. Select **Register**.
7. Follow the instructions on the screen to activate your product's email address.

**Parent topic:** [Epson Connect Solutions for Smartphones, Tablets, and More](#)

### Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the attachments will print automatically.

1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below to use your product control panel to activate your unique email address. Or visit epson.com/connect (U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email Print, create your Epson Connect account, and register your product to the Epson Connect service.
3. Now you are ready to send and print emails to your product's Email Print address.
**Note:** Go to epsonconnect.com and log into your Epson Connect account to personalize your product's email, adjust print settings, and set up other Epson Connect services.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

### Using the Epson iPrint Mobile App

Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can scan and save a file on your device, send it as an email, or upload it to an online service such as Box, Dropbox, Evernote, or Google Drive.

1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print or scan with your mobile device and your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

### Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

**Note:** Make a note of your product's email address.
3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print Driver software.

4. Download and install the Remote Print software.

5. Enter the email address and optional access key of your Epson product during Remote Print setup.

6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer application and choose the Remote Print option for your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

---

**Using Epson Scan to Cloud**

The Epson Scan to Cloud service allows you to scan and send a file as an email or upload it to an online service directly from your Epson product. Register an email address or online services such as Box, DropBox, Evernote, or Google Drive with your Epson Connect account.

1. Connect your Epson product to your network. See the link below.

2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

   **Note:** Make a note of your product's email address and password.

3. Visit epsonconnect.com to sign into your account with the email address and password you selected.

4. Select your product, select **Scan to Cloud**, and select **Destination List**.

5. Click **Add**, then follow the instructions on the screen to create your destination list.

6. Now you are ready to use Scan to Cloud. Select the setting for scanning to Scan to Cloud on your Epson product control panel.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking
Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and Mac with the latest version of OS X or macOS.

Note: If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking
Selecting Default Paper Settings - Administrator

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Note your product's IP address by checking your network status. See the link below.
3. Connect your computer or your mobile device to the same wireless network as your Epson product.
4. Enter your product's IP address into the address bar of a web browser.
5. Select the **Google Cloud Print Services** option.

   **Note:** If you don't see the **Google Cloud Print Services** option, turn your product off and back on. If the option still doesn't appear, select the **Firmware Update** option and follow the on-screen instructions to update your product.

6. Click **Register**.
7. Select the checkbox to agree to the Usage Advisory and click **Next**.
8. Click **OK** to launch the sign-in page.

    A separate browser window opens.

9. Enter your Google Account username and password and click **Sign in**, or, if you don't have an account, click **Sign up for a new Google Account** and follow the on-screen instructions.

10. Click **Finish printer registration** to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, computer, Apple or Android device with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

---

**Setting Up Google Cloud Print on a Chromebook**

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

   **Note:** See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:
   - Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.
Note: If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click Add to Cloud Print.

- Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
- If you see a registration confirmation screen instead, click Register.

4. Click Add Device.
5. Click the Register button that appears next to your product.
6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation message.
7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone, or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson product and print.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.
Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. With just a few taps in Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your product to print whatever is on the screen.

   **Note:** If you see a message telling you that a plug-in is required, tap **OK** and tap **Download**. If your Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria Print Service app to print.

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. Look for the print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your product to print whatever is on the screen.
Using Epson Print and Scan App with Windows Tablets

You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan app does not support Windows 10 Mobile printing.

1. Connect your Epson product to your wireless network. See the link below.
2. Download the Epson Print and Scan app from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open the Epson Print and Scan app and select your Epson product.
   Now you are ready to print photos or scan.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

- Wi-Fi Infrastructure Mode Setup
- Wi-Fi Direct Mode Setup
- Wi-Fi Protected Setup (WPS)
- Printing a Network Status Sheet
- Configuring Email Server Settings
- Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
Selecting Wireless Network Settings from the Control Panel

Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install the necessary software by downloading it from the Epson website. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

1. Press the home button, if necessary.
2. Press the icon.
You see a screen like this:

3. Select **Router**.
4. Select **Start Setup, Change Settings**, or **Change to Wi-Fi Connection**.
5. Select **Wi-Fi Setup Wizard**.
6. Select the name of your wireless network or select **Enter Manually** to enter the name manually. Use the displayed keypad to enter your network name.
7. Select the **Password** field and enter your wireless password using the displayed keypad.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

- To move the cursor, press the left or right arrows.
- To change the case of letters, press ![Uppercase](image).
- To delete the previous character, press ![Delete](image).
- To enter numbers and symbols, press ![123](image).
- To enter a space, press ![Space](image).

8. Press **OK** when you finish entering your password.

9. Confirm the displayed network settings and select **Start Setup** to save them.

10. If you want to print a network setup report, select **Print Check Report**. (Otherwise, select **OK**.)

11. Press the home button to exit.

You see the ![Print](image) icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software as described on the **Start Here** sheet.
**Note:** If you don’t see the 📣 icon, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

**Parent topic:** Wi-Fi Infrastructure Mode Setup  
**Related references**  
Status Icon Information  
**Related tasks**  
Entering Characters on the LCD Screen

## Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network access point for up to 4 devices.

1. Epson product  
2. Computer with a wireless interface  
3. Other wireless device

**Enabling Wi-Fi Direct Mode**

**Parent topic:** Wi-Fi or Wired Networking
**Enabling Wi-Fi Direct Mode**

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

1. Press the home button, if necessary.

2. Press the icon.

   You see a screen like this:

   ![Network Connection Settings](image)

3. Select **Wi-Fi Direct**.

4. Scroll down and select **Start Setup**.

5. Select **Start Setup** again.
You see a screen like this:

![Wi-Fi Direct Screen](image)

6. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then enter the password shown.

7. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software as described on the Start Here sheet.

**Note:** If you don't see the icon on the LCD screen, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

**Parent topic:** Wi-Fi Direct Mode Setup

**Related references**

- Status Icon Information

**Related tasks**

- Entering Characters on the LCD Screen
Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled **WPS** on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

**Using WPS to Connect to a Network**

**Parent topic:** Wi-Fi or Wired Networking

**Using WPS to Connect to a Network**

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the ⏐ home button, if necessary.

2. Press the 📁 icon.
   
   You see a screen like this:

   ![Network Connection Settings](image)

3. Select **Router**.
4. Select **Push Button Setup (WPS)**.
5. Follow the instructions on the LCD screen to complete WPS setup.

6. Press the \( \rightarrow \) home button to exit.

You see the \( \text{WiFi} \) icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software as described on the Start Here sheet.

**Note:** If you don’t see the \( \text{WiFi} \) icon, repeat these steps to try again.

**Parent topic:** Wi-Fi Protected Setup (WPS)

### Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

1. Press the \( \rightarrow \) home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

You see a screen like this:

![General Settings Screen](image)

4. Select **Network Settings**.
5. Select **Network Status**.
6. Select **Print Status Sheet**.
7. Select **Print**.

Examine the settings shown on the network status sheet to diagnose any problems you have.

**Parent topic:** [Wi-Fi or Wired Networking](#)

**Configuring Email Server Settings**

To use features such as scanning to email or forwarding faxes to email, you need to configure the email server. You can select settings for the email server using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the  button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:

![General Settings](#)

4. Scroll down and select **Advanced**.
5. Select **Email Server**.
6. Select **Server Settings**.
   
   You see a screen like this:

   ![Email Server Authentication Method](image)

   - Off
   - POP before SMTP (selected)
   - SMTP-AUTH

7. Select one of the options shown above, then select the settings you want to use. Contact your internet service provider if necessary to confirm the authentication method for the email server.

8. Select **Proceed** to save your settings.

9. Select **Close** to exit.

10. Select **Connection Check** to verify the connection to the email server.

**Parent topic:** Wi-Fi or Wired Networking

**Related tasks**
- Scanning to Email
- Forwarding Received Faxes

**Changing or Updating Network Connections**

See these sections to change or update how your product connects to a network.

- Accessing the Web Config Utility
- Changing a USB Connection to a Wi-Fi Connection
- Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser. You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

Note: For more information on administration settings, see the Administrator's Guide.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   You see the available Web Config utility options.

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select **Wired network connection**.
8. If you see a Select Setup Option screen, select **Set up printer for the first time**.
9. Continue following the rest of the on-screen instructions.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

Disabling Wi-Fi Features

### Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
   - **Windows:** Uninstall your product software.
   - **Mac:** Go to the next step.
2. Download and install your product software from the Epson website using the instructions on the **Start Here** sheet.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

Uninstalling Product Software - Windows

### Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.
**Note:** Before disabling Wi-Fi features, make a note of your product’s SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.
2. Press the icon.
   
   You see a screen like this:

   ![Network Connection Settings](image)

3. Select **Router**.
4. Select **Change Settings**.
5. Select **Others**.
6. Select **Disable Wi-Fi**.
7. Select **Yes** to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure you have installed the software as described on the Start Here sheet.

To download the Epson Universal Print Driver or PostScript drivers, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - Mac
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PCL or PS3 (PostScript) Status Sheet

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before installing the printer software. Depending on your model, not all printer languages may be supported.

1. To download the EPSON Universal Print Driver file, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. After downloading the installer file, double-click the downloaded file to install the software.
3. Follow the on-screen instructions until you see this screen:

![EPSON Printer Utilities Setup](image)

4. Select **Yes: Network connection** and click **OK**.

   **Note:** Select the **Set Default of Printer Control Language to PCL6** checkbox if you want to set the default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-R. (You can change this setting later as needed.)
After the software finishes searching for products, you see a screen like this:

5. Do one of the following:
   • If you are installing one product, make sure **Add EPSON Universal Print Driver** is selected and continue with the next step.
   • If you are installing more than one product, select **Add found printers** and go to step 9.

   **Note:** You can customize and filter your product search results by clicking **Display Settings**.
6. Open the **Select a port to connect a printer** menu and select an existing printer port, if necessary. Otherwise, skip this option to create a new port automatically.

7. Select the product you want to install from the Found Printers list.

   **Note:** Deselect the **Set as default printer** checkbox if you do not want the product to be set as your default printer.

8. Click **OK**, then skip the remaining steps.

9. If you are installing more than one product, select the products from the Found Printers list and click **Add to Printer Folder**.

![EPSON Printer Utilities Setup](image)

- **Add EPSON Universal Print Driver**
- **Add found printers**

Select printers from the following list, and then click the 'Add to Printer Folder' button. (You can select multiple printers from the list.)

**Found Printers:**
- WF-XXXX 192.168.1.XXXX AC1826B5731
- WF-XXXX 192.168.1.XXXX 64EB836551C6
- WF-XXXX 192.168.1.XXXX 64EB83741F3D
- WP-XXXX 192.168.1.XXXX 0026A3E85E9C
- WF-XXXX 192.168.1.XXXX AC1826C6609C
- ET-XXXX 192.168.1.XXXX 4D224A443A1

**Printers to be added:**

<table>
<thead>
<tr>
<th>Name of added printer</th>
<th>IP Address</th>
</tr>
</thead>
</table>
| EPSON Universal Print Driver WF-XXXX 192.168.1.XXXX
| EPSON Universal Print Driver WF-XXXX 192.168.1.XXXX |
The selected products appear in the lower section of the screen.

10. Select the checkbox next to the product you want to make your default printer, if necessary.

11. Click **OK**.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software or Epson Universal Print Driver, you need to install the PostScript (PS3) printer software before you can adjust the print settings and print to your network printer.

**Note:** Make sure your product is turned on and connected to the same network as your computer before installing the printer software.

1. To download the **Drivers and Utilities Combo Package - PS3 PostScript** file, visit [epson.com/support](http://epson.com/support) (U.S.), [epson.ca/support](http://epson.ca/support) (Canada), or [epson.com.jm/support](http://epson.com.jm/support) (Caribbean) and select your product.

2. After downloading the installer file, double-click the downloaded file to install the software.

3. Click **OK**.

4. Click **Accept**.

5. Click **Install**.

6. Click **Next** and follow the on-screen instructions.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Installing the PostScript (PS3) Printer Software - Mac

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer software before you can adjust the print settings and print to your network printer.

**Note:** Make sure your product is turned on and connected to the same network as your computer before installing the printer software.

1. To download the **Drivers and Utilities Combo Package - PS3 PostScript** file, visit [epson.com/support](http://epson.com/support) (U.S.), [epson.ca/support](http://epson.ca/support) (Canada), or [epson.com.jm/support](http://epson.com.jm/support) (Caribbean) and select your product.

2. After downloading the installer file, double-click the downloaded file to install the software.
3. Double-click **EPSON**.
4. Click **Continue** on the next two screens.
5. Click **Agree**.
6. Click **Install**.
7. If necessary, enter the administrator password.
8. Click **Start** and follow the on-screen instructions.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:
4. Select **Printer Settings**.
   You see a screen like this:

   ![Printer Settings Screen]

5. Select **PDL Print Configuration**.
   You see a screen like this:

   ![PDL Print Configuration Screen]
6. Select one of the options shown above, then select the PDL print configuration options you want to use.

7. When you are finished, press the home button to exit.

**PDL Print Configuration Options**

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

---

## PDL Print Configuration Options

Select the **PDL Print Configuration** options you want to use for PCL or PostScript printing.

<table>
<thead>
<tr>
<th>PDL Print Configuration option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Size</td>
<td>Various sizes</td>
<td>Sets the default paper size for PCL or PostScript printing</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Various paper types</td>
<td>Sets the default paper type for PCL or PostScript printing</td>
</tr>
<tr>
<td>Orientation</td>
<td>Portrait</td>
<td>Sets the default orientation for PCL or PostScript printing</td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td>Quality</td>
<td>Draft</td>
<td>Sets the quality for PCL or PostScript printing</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>Ink Save Mode</td>
<td>On/Off</td>
<td>Saves ink by reducing print density</td>
</tr>
<tr>
<td>Print Order</td>
<td>Last Page on Top</td>
<td>Starts printing from the first page of a file</td>
</tr>
<tr>
<td></td>
<td>First Page on Top</td>
<td>Starts printing from the last page of a file</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>1 to 999</td>
<td>Selects the number of copies to print</td>
</tr>
<tr>
<td>Binding Margin</td>
<td>Left Edge</td>
<td>Specifies the binding edge for double-sided documents</td>
</tr>
<tr>
<td></td>
<td>Top Edge</td>
<td></td>
</tr>
<tr>
<td>Auto Paper Ejection</td>
<td>On/Off</td>
<td>Ejects paper automatically when printing is stopped during a print job</td>
</tr>
<tr>
<td><strong>PDL Print Configuration option</strong></td>
<td><strong>Available settings</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>2-Sided Printing</td>
<td>On/Off</td>
<td>Selects duplex printing</td>
</tr>
<tr>
<td><strong>PCL Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Font Source</strong></td>
<td>Resident</td>
<td>Uses a font preinstalled on the printer</td>
</tr>
<tr>
<td></td>
<td>Download</td>
<td>Uses a font you have downloaded</td>
</tr>
<tr>
<td><strong>Font Number</strong></td>
<td>1 to 111</td>
<td>Selects the default font number for the default font source</td>
</tr>
<tr>
<td><strong>Pitch</strong></td>
<td>0.44 to 99.99 cpi</td>
<td>Selects the default font pitch if the font is scalable and fixed-pitch (availability depends on font source and number settings)</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>4.00 to 999.75 pt</td>
<td>Selects the default font height if the font is scalable and proportional (availability depends on font source and number settings)</td>
</tr>
<tr>
<td><strong>Symbol Set</strong></td>
<td>Various</td>
<td>Selects the default symbol set. If the selected font is not available for the selected symbol set, the font source and number are replaced with <strong>IBM-US</strong> (the default setting).</td>
</tr>
<tr>
<td><strong>Form</strong></td>
<td>5 to 128 lines</td>
<td>Sets the number of lines for the selected paper size and orientation. Changes the line spacing (VMI) stored in the printer. Later changes in page size or orientation cause changes in the <strong>Form</strong> value based on the stored VMI.</td>
</tr>
<tr>
<td><strong>CR Function</strong></td>
<td>CR</td>
<td>Selects the line feed command when printing with a driver from a specific operating system</td>
</tr>
<tr>
<td></td>
<td>CR+LF</td>
<td></td>
</tr>
<tr>
<td><strong>LF Function</strong></td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CR+LF</td>
<td></td>
</tr>
<tr>
<td>PDL Print Configuration option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Paper Source Assign</td>
<td>4</td>
<td>Makes the paper source select command compatible with HP LaserJet 4</td>
</tr>
<tr>
<td></td>
<td>4K</td>
<td>Makes the paper source select command compatible with HP LaserJet 4000, 5000, and 8000</td>
</tr>
<tr>
<td></td>
<td>5S</td>
<td>Makes the paper source select command compatible with HP LaserJet 5S</td>
</tr>
<tr>
<td>PS3 Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Sheet</td>
<td>On/Off</td>
<td>Prints a sheet showing the status when errors occur during PostScript or PDF printing</td>
</tr>
<tr>
<td>Coloration</td>
<td>Color</td>
<td>Selects the color mode for PostScript printing</td>
</tr>
<tr>
<td></td>
<td>Mono</td>
<td></td>
</tr>
<tr>
<td>Image Protect</td>
<td>On/Off</td>
<td>Disable to lower the print quality automatically if the printer's memory becomes full</td>
</tr>
<tr>
<td>Binary</td>
<td>On/Off</td>
<td>Enable when printing files that contain binary images (available when the product is connected to the network). Allows you to print binary images even if the driver is set to ASCII.</td>
</tr>
<tr>
<td>Text Detection</td>
<td>On/Off</td>
<td>Converts a text file to a PostScript file when printing (available when Printing Language is set to PS3)</td>
</tr>
<tr>
<td>PDF Page Size</td>
<td>Various sizes</td>
<td>Selects the paper size when printing a PDF file. If Auto is selected, the paper size is determined based on the size of the first page.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings

You can select printer language and interface settings using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see a screen like this:

   ![General Settings](image)

   - Basic Settings
   - Printer Settings
   - Network Settings
   - Web Service Settings

   ![Printer Settings](image)

   - Paper Source Settings
   - Printing Language
   - Universal Print Settings
   - PDL Print Configuration

4. Select **Printer Settings**.
   You see a screen like this:
5. Select **Printing Language**.
6. Select the printing language and interface options for your connection type.
7. When you are finished, press the home button to return to the Home screen.

### Printing Language and Interface Options

Parent topic: **Enabling Epson Universal Print Driver (PCL) or PostScript Printing**

#### Printing Language and Interface Options

Select the printing language and interface options you want to use.

<table>
<thead>
<tr>
<th>Option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB I/F Timeout Setting</strong></td>
<td>0.5 to 300 seconds</td>
<td>Specify the length of time before ending USB communication from a computer using the PCL or PostScript driver. This setting is necessary to avoid endless USB communication.</td>
</tr>
<tr>
<td><strong>Printing Language</strong></td>
<td>Auto</td>
<td>Select the language for the USB or network interface</td>
</tr>
<tr>
<td></td>
<td>PCL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PS3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PDF</td>
<td></td>
</tr>
<tr>
<td><strong>PC Connection via USB</strong></td>
<td>Enable</td>
<td>Select whether to allow USB communication with the product</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: **Selecting Printer Language and Interface Settings**

#### Printing a PCL or PS3 (PostScript) Status Sheet

You can print a PCL or PS3 (PostScript) status sheet to confirm the current font information.

1. Press the home button, if necessary.
2. Select **Settings**.
You see a screen like this:

3. Scroll down and select **Print Status/Print**.
4. Select **Print Status Sheet**.
5. Select **PCL Font List** or **PS3 Font List**.
6. Select **Print** to print the status sheet.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing
Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in the Cassette
Loading Paper and Envelopes in the Rear Paper Feed Slot
Paper Loading Capacity
Double-sided Printing Capacity
Available Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Loading Paper in the Cassette

You can load paper up to this size in the paper cassette: A3 (11.7 × 16.5 inches [297 × 420 mm])

Note: If the optional paper cassette units are installed, do not remove more than one cassette at a time.

1. Make sure the product is not operating and pull out the paper cassette.
2. Slide the front edge guide outward all the way, then slide the side edge guides to the paper size you are using.

3. Load paper with the printable side facedown and slide the front edge guide against the paper.

Note: Make sure the paper fits beneath the arrow mark inside the edge guides.
4. Make sure the paper size label matches the size of the paper loaded in the paper cassette. If necessary, remove the label holder and change the paper size indicated on the label.

5. Insert the paper cassette all the way into the product.

   **Note:** If the **Paper Size Auto Detect** setting is enabled, your product will automatically detect the size of the paper you loaded.

6. If necessary, press the **Paper Setting** button and select the size and type of paper you loaded on the product LCD screen.

Always follow these paper loading guidelines:
- Load only the recommended number of sheets.
- Load paper short edge first, no matter which way your document faces.
- Load the printable side facedown.
- Load letterhead or pre-printed paper top edge first.
- Do not load paper above the arrow mark inside the edge guides.
- Check the paper package for any additional loading instructions.

**Parent topic:** Loading Paper

**Related references**
- Paper Loading Capacity
- Paper Specifications

**Related tasks**
- Loading Paper and Envelopes in the Rear Paper Feed Slot
Loading Paper and Envelopes in the Rear Paper Feed Slot

You can print envelopes or documents in a variety of paper types and sizes in the rear paper feed slot.

1. Open the feeder guard and pull up the paper support.

2. Slide the edge guides outward.
3. If you are inserting a stack of paper, fan the sheets and tap the stack on a flat surface to even the edges.

**Note:** You can load one sheet of binder paper with holes on one of the long edges as shown. Do not select automatic 2-sided printing for this type of paper.

![Diagram of paper orientation and restrictions]

4. Do one of the following:
   - Insert paper, glossy or printable side up and short edge first, in the center of the slot.

![Diagram of paper insertion]

**Caution:** To prevent paper feeding problems, make sure you do not load paper above the arrow marks inside the edge guides.
• Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the center of the slot.

5. Slide the edge guides against the paper, but not too tightly.

6. Extend the output tray.
7. Press the **Paper Setting** button.
   You see a screen like this:

![Paper Setting screen](image)

8. Select the size and type of paper you loaded.
   Always follow these paper loading guidelines:
   - Load only the recommended number of sheets.
   - Load paper short edge first, no matter which way your document faces.
   - Load the printable side faceup.
   - Load letterhead or pre-printed paper top edge first.
   - Do not load paper above the arrow mark inside the edge guides.
   - If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one envelope at a time.
   - If print quality declines when printing multiple envelopes, try loading one envelope at a time.
   - Do not load envelopes that are curled, folded, or too thin.
   - Check the paper package for any additional loading instructions.

**Parent topic:** Loading Paper

**Related references**

Paper Specifications
## Paper Loading Capacity

### Related tasks
- Loading Paper in the Cassette

### Paper Loading Capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
<th>Paper cassettes</th>
<th>Rear paper feed slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) Up to the arrow mark</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) and larger 50 sheets</td>
<td></td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) Up to the arrow mark</td>
<td></td>
<td>85 sheets</td>
</tr>
<tr>
<td>Recycled paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), and Legal (8.5 × 14 inches [216 × 356 mm]) Up to the arrow mark</td>
<td></td>
<td>85 sheets</td>
</tr>
<tr>
<td>Colored paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), and Legal (8.5 × 14 inches [216 × 356 mm]) Up to the arrow mark</td>
<td></td>
<td>85 sheets</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), and Legal (8.5 × 14 inches [216 × 356 mm]) Up to the arrow mark</td>
<td></td>
<td>85 sheets</td>
</tr>
<tr>
<td>Epson Bright White Paper¹</td>
<td>200 sheets (cassette 1)</td>
<td></td>
<td>50 sheets</td>
</tr>
<tr>
<td></td>
<td>400 sheets (cassettes 2 to 4)</td>
<td></td>
<td>50 sheets</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>—</td>
<td></td>
<td>10 sheets</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)*</td>
<td></td>
<td>10 sheets</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)*</td>
<td></td>
<td>10 sheets</td>
</tr>
</tbody>
</table>

¹: Epson Bright White Paper 13 × 19 inches (330 × 483 mm)
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
<th>Rear paper feed slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>—</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) and larger* 10 sheets</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) and smaller 20 sheets</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thick paper 1 (25 to 41 lb [91 to 150 g/m²])</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) and Legal (8.5 × 14 inches [216 × 356 mm]) 150 sheets (cassette 1) 250 sheets (cassettes 2 to 4)</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm]) and Legal (8.5 × 14 inches [216 × 356 mm]) 20 sheets</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm]) 150 sheets (cassette 1) 300 sheets (cassettes 2 to 4)</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm]) 40 sheets</td>
</tr>
<tr>
<td>Paper type</td>
<td>Loading capacity</td>
<td>Rear paper feed slot</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Thick paper 2 (41 to 55 lb [151 to 200 g/m²])**   | **Paper cassettes** A3 (11.7 × 16.5 inches [297 × 420 mm]) and Legal (8.5 × 14 inches [216 × 356 mm])
120 sheets (cassette 1)
200 sheets (cassettes 2 to 4) | A3 (11.7 × 16.5 inches [297 × 420 mm]) and Legal (8.5 × 14 inches [216 × 356 mm])
15 sheets                                                                                             |
| **Thick paper 3 (55 to 68 lb [201 to 256 g/m²])**   | —                                                                               | A3 (11.7 × 16.5 inches [297 × 420 mm]) and Legal (8.5 × 14 inches [216 × 356 mm])
10 sheets
Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm])
30 sheets                                                                                              |
| **Envelopes**                                       | —                                                                               | Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm])
20 sheets                                                                                              |

*Only available when printing from a computer.

**Parent topic:** [Loading Paper](#)
## Double-sided Printing Capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Double-sided Printing Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>—</td>
</tr>
<tr>
<td>Copier paper</td>
<td></td>
<td>50 sheets (rear paper feed)</td>
</tr>
<tr>
<td>Letterhead paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycled paper</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>Up to the arrow mark (cassettes 1 to 4)</td>
</tr>
<tr>
<td>Colored paper</td>
<td></td>
<td>30 sheets (rear paper feed)</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>High quality plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), and Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>Up to the arrow mark (cassettes 1 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>85 sheets (rear paper feed)</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]),</td>
<td>200 sheets (cassette 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>400 sheets (cassettes 2 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50 sheets (rear paper feed)</td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Double-sided Printing Capacity</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Letter (8.5 \times 11 \text{ inches} \ [216 \times 279 \text{ mm}], Legal (8.5 \times 14 \text{ inches} \ [216 \times 356 \text{ mm}], A3 (11.7 \times 16.5 \text{ inches} \ [297 \times 420 \text{ mm}], and 13 \times 19 \text{ inches} \ [330 \times 483 \text{ mm})</td>
<td>—</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Letter (8.5 \times 11 \text{ inches} \ [216 \times 279 \text{ mm}) and smaller, A3 (11.7 \times 16.5 \text{ inches} \ [297 \times 420 \text{ mm}) and larger</td>
<td>—</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double-sided Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thick paper 1 (25 to 41 lb [91 to 150 g/m²])</td>
<td>A3 (11.7 \times 16.5 \text{ inches} \ [297 \times 420 \text{ mm}) and Legal (8.5 \times 14 \text{ inches} \ [216 \times 356 \text{ mm})</td>
<td>150 sheets (cassette 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>250 sheets (cassettes 2 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 sheets (rear paper feed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 sheets (rear paper feed)</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 \times 11.7 \text{ inches} \ [210 \times 297 \text{ mm})</td>
<td>150 sheets (cassette 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>300 sheets (cassettes 2 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40 sheets (rear paper feed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40 sheets (rear paper feed)</td>
</tr>
</tbody>
</table>
### Paper Type and Size

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Double-sided Printing Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Auto</td>
</tr>
<tr>
<td>Thick paper 2 (41 to 55 lb [151 to 200 g/m²])</td>
<td>A3 (11.7 x 16.5 inches [297 x 420 mm]) and Legal (8.5 x 14 inches [216 x 356 mm])</td>
<td>120 sheets (cassette 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>200 sheets (cassettes 2 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 sheets (rear paper feed)</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches [216 x 279 mm]) and A4 (8.3 x 11.7 inches [210 x 297 mm])</td>
<td>120 sheets (cassette 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>250 sheets (cassettes 2 to 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30 sheets (rear paper feed)</td>
</tr>
<tr>
<td>Thick paper 3 (55 to 68 lb [201 to 256 g/m²])</td>
<td>A3 (11.7 x 16.5 inches [297 x 420 mm]) and Legal (8.5 x 14 inches [216 x 356 mm])</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches [216 x 279 mm]) and A4 (8.3 x 11.7 inches [210 x 297 mm])</td>
<td>—</td>
</tr>
<tr>
<td>Envelopes</td>
<td>No. 10 (4.1 x 9.5 inches [105 x 241 mm])</td>
<td>—</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper

**Related tasks**
- Selecting Double-sided Printing Settings - Windows
- Selecting Double-sided Printing Settings - Mac

### Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 x 11 inches [216 x 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper</td>
<td>Letter (8.5 x 11 inches [216 x 279 mm])</td>
<td>S042384</td>
<td>150</td>
</tr>
<tr>
<td>Matte Double-sided</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 x 10 inches (203 x 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td>Paper Matte</td>
<td>Letter (8.5 x 11 inches [216 x 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches (279 x 356 mm)</td>
<td>S041468</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 x 16.5 inches [297 x 420 mm])</td>
<td>S041260</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>13 x 19 inches (330 x 483 mm)</td>
<td>S041263</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 x 11 inches [216 x 279 mm])</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 x 6 inches (102 x 152 mm)</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches [216 x 279 mm])</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 x 17 inches (279 x 432 mm)</td>
<td>S041156</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>13 x 19 inches (330 x 483 mm)</td>
<td>S041143</td>
<td>20</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>16:9 wide (4 × 7.1 inches [102 × 181 mm])</td>
<td>S042109</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches (279 × 356 mm)</td>
<td>S041466</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041290</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041288</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041289</td>
<td>20</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041327</td>
<td>20</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper
### Paper or Media Type Settings - Printing Software

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Recycled paper</td>
<td>Recycled</td>
</tr>
<tr>
<td>Colored paper</td>
<td>Color</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td>Preprinted</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Thick paper up to 25 to 41 lb (91 to 150 g/m²)</td>
<td>Thick Paper 1</td>
</tr>
<tr>
<td>Thick paper up to 41 to 55 lb (151 to 200 g/m²)</td>
<td>Thick Paper 2</td>
</tr>
<tr>
<td>Thick paper up to 55 to 68 lb (201 to 256 g/m²)</td>
<td>Thick Paper 3</td>
</tr>
</tbody>
</table>

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product’s control panel settings.

**Parent topic:** Loading Paper
Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the product.

1. Press the Paper Setting button.
   You see a screen like this:

   ![Paper Setting Screen]

2. Select the paper source you want to select settings for.
You see a screen like this:

3. Select **Paper Size**.
4. Select the paper size you loaded.
5. Select **Paper Type**.
6. Select the paper type for the paper you loaded.
7. Turn on the **Paper Size Auto Detect** setting to automatically detect the size of the paper loaded in the paper source.
8. Select another paper source to change or press the home button to exit.

**Paper Type Settings - Control Panel**

**Parent topic:** Loading Paper

---

### Paper Type Settings - Control Panel

Select a **Paper Type** setting that matches the paper you loaded.

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Paper type loaded</td>
<td>Paper Type setting</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Recycled paper</td>
<td>Recycled</td>
</tr>
<tr>
<td>Colored paper</td>
<td>Color</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td>Preprinted</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Prem. Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Prem. Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Thick paper up to 25 to 41 lb (91 to 150 g/m²)</td>
<td>Thick Paper 1</td>
</tr>
<tr>
<td>Thick paper up to 41 to 55 lb (151 to 200 g/m²)</td>
<td>Thick Paper 2</td>
</tr>
<tr>
<td>Thick paper up to 55 to 68 lb (201 to 256 g/m²)</td>
<td>Thick Paper 3</td>
</tr>
</tbody>
</table>

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator

As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

Selecting the Default Printer Settings
Selecting the Universal Print Settings

Parent topic: Loading Paper
Selecting the Default Printer Settings

You can change default printer settings using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   
   You see a screen like this:

   ![General Settings Screen](image)

   - **Basic Settings**
   - **Printer Settings**
   - **Network Settings**
   - **Web Service Settings**

4. Select **Printer Settings**.
You see a screen like this:

![Printer Settings](image)

5. Select one of these options for the **Auto Error Solver** setting:
   - Turn on this setting to display a warning and print single-sided when a 2-sided printing error occurs, or to print only what the printer could process when a full memory error occurs.
   - Turn off this setting to display an error message and stop printing if an error occurs.

6. Select **Paper Source Settings**.
7. Select the Paper Source Settings options you want to use.
8. When you are finished, press the home button to exit.

### Paper Source Settings Options

**Parent topic:** Selecting Default Paper Settings - Administrator

**Paper Source Settings Options**

Select the paper source options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Paper Source Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setting</td>
<td>Various</td>
<td>Select the paper size and type for each paper source</td>
</tr>
<tr>
<td>Paper Source Settings option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rear Paper Feed Priority</td>
<td>On, Off</td>
<td>Select <strong>On</strong> to give printing priority to paper loaded in the rear paper feed slot</td>
</tr>
<tr>
<td>A4/Letter Auto Switching</td>
<td>On, Off</td>
<td>Select <strong>On</strong> to switch the selected paper size to match the loaded paper (Letter or A4) if the wrong size is selected</td>
</tr>
<tr>
<td>Auto Select Settings</td>
<td>Copy, Fax, Other</td>
<td>Select <strong>On</strong> for any of these settings to automatically print on paper from any source containing paper that matches your paper settings</td>
</tr>
<tr>
<td>Error Notice</td>
<td>Paper Size Notice, Paper Type Notice</td>
<td>Select <strong>On</strong> for either of these settings to display an error message when the selected paper type or size does not match the loaded paper</td>
</tr>
<tr>
<td>Paper Setup Auto Display</td>
<td>On, Off</td>
<td>Select <strong>On</strong> to automatically display a menu that lets you select the paper size and type when you load paper in the product</td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting the Default Printer Settings

**Selecting the Universal Print Settings**

You can change the default universal print settings using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the \( \text{Home} \) button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
You see this screen:

4. Select **Printer Settings**.

You see this screen:

5. Select **Universal Print Settings**.
6. Adjust the settings as necessary.
7. When you are finished, press the home button to exit.

Universal Print Settings Options

Parent topic: Selecting Default Paper Settings - Administrator

Universal Print Settings Options

Select the universal print setting options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Universal Print Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Offset</td>
<td>—</td>
<td>Adjust the top or left margin</td>
</tr>
<tr>
<td>Left Offset</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Top Offset in Back</td>
<td>—</td>
<td>Adjust the top or left margin of the back page when printing double-sided.</td>
</tr>
<tr>
<td>Left Offset in Back</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Check Paper Width</td>
<td>On</td>
<td>Select On to check the paper width before printing. This prevents printing beyond the edges of the paper when the paper size settings are incorrect, but may reduce the printing speed.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Skip Blank Page</td>
<td>On</td>
<td>Select On to skip printing of blank pages automatically</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting the Universal Print Settings
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

**Caution:** Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

**Placing Originals on the Scanner Glass**

You can place originals up to this size on the scanner glass: A3 (11.7 × 16.5 inches [297 × 420 mm]).

1. Open the document cover.
2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the original to the edges of the indicated corner.

![Image of placing original on scanner glass](image)

**Note:** You can place multiple originals on the scanner glass. Just make sure they are at least 0.8 inch (20 mm) away from each other.

**Note:** The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the scanner glass.
3. Close the document cover gently to keep your original in place.

**Caution:** Do not push down on the document cover or scanner glass or you may damage the product.

**Parent topic:** Placing Originals on the Product

**Related topics**

Copying  
Scanning  
Faxing

---

**Placing Originals in the Automatic Document Feeder**

You can place single- or multi-page original documents in the Automatic Document Feeder (ADF). You can also use the ADF to scan both sides of a 2-sided document. Make sure the originals meet the Automatic Document Feeder specifications before loading them.

**Caution:** Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or other materials that could obstruct the feeder.

**Caution:** Do not place photographs or valuable artwork in the ADF. Place fragile or valuable originals on the scanner glass to avoid wrinkling or damaging them.
1. Slide the ADF edge guide outward.

2. Fan your stack of originals and tap them gently on a flat surface to even the edges.
3. Insert the originals into the ADF faceup and short edge first.

The ADF icon on the Copy, Scan, and Fax screens lights up.

**Note:** The ADF should automatically detect the size of your original. If the document size isn't automatically detected, you need to manually select it.
4. Slide the ADF edge guide against the originals, but not too tightly.

**Parent topic:** Placing Originals on the Product

**Related references**

*Mac System Requirements*

**Related topics**

*Copying*  
*Scanning*  
*Faxing*
Copying

See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos

Copying Options

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special papers.

1. Place your original document or photo on the scanner glass, or place multi-page documents in the ADF.
2. Load the paper you want to print on.
3. Press the home button, if necessary.
4. Select Copy.

You see a screen like this:
5. To print more than one copy, press a number key on the product's control panel, or select **Copies** and use the displayed keypad to enter the number of copies.

6. Change any of the displayed settings as necessary.

7. Select **Advanced** to view and change additional copy settings, if necessary.

8. Select **Preview** to preview your copy on the LCD screen.

9. Select **Preset** to save your copy settings.

   **Note:** Presets can be locked by an administrator. If you can't access or change this setting, contact your administrator for assistance.

10. When you are ready to copy, press the **Copy** icon.

    **Note:** To cancel printing, press the ⏹ stop button or select **Cancel**.

**Parent topic:** Copying

**Related references**

Copying Options

**Related tasks**

Using Presets

**Related topics**

Loading Paper

Placing Originals on the Product

### Copying Options

Select the copying options you want to use for your copies.

**Note:** Not all options or settings may be available, depending on other copying settings.

**Basic Settings**

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W</td>
<td>—</td>
<td>Copies the document in black and white</td>
</tr>
<tr>
<td>Color</td>
<td>—</td>
<td>Copies the document in color</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Paper Setting</td>
<td>Various sources</td>
<td>Select the paper source that you want to use. If you select <strong>Auto</strong>, paper is fed automatically depending on the paper settings you selected for the paper sources.</td>
</tr>
<tr>
<td>Original Size</td>
<td>Various sizes</td>
<td>Select the document size of your original</td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjusts the lightness or darkness of copies</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td><strong>Reduce to Fit Paper</strong></td>
<td>Automatically decreases the size of the image by the percentage you select</td>
</tr>
<tr>
<td></td>
<td><strong>100%</strong></td>
<td>Copies the original at its full size</td>
</tr>
<tr>
<td></td>
<td><strong>Auto</strong></td>
<td>Automatically sizes the image to fit the paper size you selected</td>
</tr>
<tr>
<td></td>
<td><strong>50%-&gt;200% and other conversions</strong></td>
<td>Automatically converts from one size to another</td>
</tr>
<tr>
<td>2-Sided</td>
<td><strong>1&gt;1-Sided</strong></td>
<td>Select to make 2-sided copies. When you select <strong>1&gt;2-Sided</strong> or <strong>2&gt;1-Sided</strong>, also select the <strong>Advanced</strong> tab to select the orientation and binding edge for your originals or copies.</td>
</tr>
<tr>
<td></td>
<td><strong>2&gt;2-Sided</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>1&gt;2-Sided</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2&gt;1-Sided</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Advanced settings**

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Page</td>
<td><strong>Single Page</strong></td>
<td>Copies each page of the original onto an individual sheet</td>
</tr>
<tr>
<td></td>
<td><strong>2-up</strong></td>
<td>Copies multiple page documents onto one sheet. Scroll down and select the document orientation and layout order settings as necessary.</td>
</tr>
<tr>
<td></td>
<td><strong>4-up</strong></td>
<td></td>
</tr>
<tr>
<td>Original Type</td>
<td><strong>Text</strong></td>
<td>Specifies the document type of your originals and adjusts the quality of your copies</td>
</tr>
<tr>
<td></td>
<td><strong>Text &amp; Image</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Photo</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Text &amp; Image(Best)</strong></td>
<td></td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Finishing</td>
<td>Group (Same Pages)</td>
<td>Select to print multiple copies of a multi-page document in unordered groups</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="unordered groups image" /></td>
</tr>
<tr>
<td></td>
<td>Collate (Page Order)</td>
<td>Select to print multiple copies of a multi-page document in ordered sets</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="ordered sets image" /></td>
</tr>
<tr>
<td>Mixed Size Originals</td>
<td>Off</td>
<td>Select On to copy originals of varying sizes in their original sizes</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Orientation (Original)</td>
<td>Up Direction</td>
<td>Specifies the orientation of your originals</td>
</tr>
<tr>
<td></td>
<td>Left Direction</td>
<td></td>
</tr>
<tr>
<td>Book&gt;2Pages</td>
<td>Off</td>
<td>Select On to copy two pages of a book onto separate sheets of paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Image Quality</td>
<td>Various settings</td>
<td>Select advanced quality settings such as <strong>Saturation</strong> and <strong>Sharpness</strong></td>
</tr>
<tr>
<td>Binding Margin</td>
<td>Off</td>
<td>Select On to adjust the margin and orientation of the pages when copying a book</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Reduce to Fit Paper</td>
<td>Off</td>
<td>Select On to automatically decrease the image by the percentage you select</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Remove Shadow</td>
<td>Off</td>
<td>Select On to erase the shadows that appear in the center of a document when copying a book or that appear around a document when copying thick paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove Punch Holes</td>
<td>Off</td>
<td>Select <strong>On</strong> to erase the binding holes on a document</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>ID Card Copy</td>
<td>Off</td>
<td>Select <strong>On</strong> to copy both sides of an ID card onto one side of a sheet of paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Copying
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select Enable automatic checking and click OK. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with the Standard Epson Printer Software - Windows
Printing with the Epson Standard Printer Software - Mac
Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - Mac
Cancelling Printing Using a Product Button

Printing with the Standard Epson Printer Software - Windows

You can print with the standard Epson printer software using any Windows printing program, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Entering a User ID and Password for Printing
Selecting Default Print Settings - Windows
Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select Properties or Preferences to view your print settings.
You see the **Main** tab of your printer settings window:

![Main tab of printer settings window](image)

4. For the **Paper Source** setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the **Document Size** setting.

   **Note:** You can also select the **User-Defined** setting to create a custom paper size.

6. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.

7. Select the type of paper you loaded as the **Paper Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.
8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

10. To print on both sides of the paper, select the **2-Sided Printing** setting and select the options you want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the **Copies** options.

13. To preview your job before printing, select **Print Preview**.

14. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.

15. To reduce noise during printing when you select **Plain Paper/Bright White Paper**, select **On** in the **Quiet Mode** menu.

   **Paper Source Options - Windows**
   **Print Quality Options - Windows**
   **Multi-Page Printing Options - Windows**

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related references**

- Paper or Media Type Settings - Printing Software
- Double-sided Printing Capacity

**Related tasks**

- Printing Your Document or Photo - Windows
- Entering a User ID and Password for Printing

**Paper Source Options - Windows**

You can select any of the available options in the Paper Source menu to print on the paper loaded in that source.

**Note:** **Paper Cassette 2** through **Paper Cassette 4** are available only if you have installed the optional cassettes.
Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Paper Cassette 3
Selects the paper in cassette 3 as the paper source.

Paper Cassette 4
Selects the paper in cassette 4 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows

Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on plain paper.

Standard
For everyday text and image printing.

Standard - Vivid
For text and graphics with good quality and print speed.

High
For photos and graphics with high print quality.

More Settings
Opens a window that lets you choose among levels of speed and quality.

Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and border options.
2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
   • **Auto (Long-edge binding)** to print your double-sided print job by automatically flipping the paper on the long edge.
   • **Auto (Short-edge binding)** to print your double-sided print job by automatically flipping the paper on the short edge.
   • **Manual (Long-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the long edge to print the other side (recommended for paper types that do not support automatic duplexing).
   • **Manual (Short-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the short edge to print the other side (recommended for paper types that do not support automatic duplexing).

2. Click the Settings button.
You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Click the **Print Density** button.
   You see this window:

![Print Density Adjustment window](image)

6. Select the type of document you are printing as the Document Type setting. The software automatically sets the **Adjustments** options for that document type.

7. If necessary, select the **Adjustments** options you want to use.

8. Click **OK** to return to the **Main** tab.

9. Print a test copy of your double-sided document to test the selected settings.

10. Follow any instructions displayed on the screen during printing.

   - [Double-sided Printing Options - Windows](#)
   - [Print Density Adjustments - Windows](#)

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related references**
- [Double-sided Printing Capacity](#)

**Related tasks**
- [Selecting Basic Print Settings - Windows](#)
Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows

Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   - Select the **Fit to Page** option to size your image to fit the paper you loaded. Select the size of your document or photo as the **Document Size** setting, and the size of your paper as the **Output Paper** setting. If you want to center your image on the paper, select the **Center** option.
   - Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.

2. Select one of the following Color Correction options:
   - Select **Automatic** to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
• Select **Custom** and click the **Advanced** button to manually adjust the color correction settings or turn off color management in your printer software.

• Select **Image Options** to access additional settings for improving printed images.

3. To add the following features, click the **Watermark Features** button:

• **Anti-Copy Pattern**: adds a watermark that only appears when your printout is copied

• **Watermark**: adds a visible watermark to your printout

  **Note:** Click the **Add/Delete** button to create your own watermark, and click the **Settings** button to customize the watermark.

• **Header/Footer**: adds information such as the date and time to the top or bottom of your printout

  **Note:** Click the **Settings** button to customize the text and location of the header or footer.

4. To add a password to your print job, select the **Confidential Job** checkbox, then enter a password. Confidential jobs are stored in the product's memory without being printed. To print the job, enter the password for the confidential job on the product's control panel.

  **Note:** Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.

**Custom Color Correction Options - Windows**

**Image Options and Additional Settings - Windows**

**Header/Footer Settings - Windows**

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related tasks**

**Printing Your Document or Photo - Windows**
Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

Color Controls
- Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and Density, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
- Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.
ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Layout and Print Options - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows

Header/Footer Settings - Windows
You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

Note: These settings are not saved with your document.

You can select to print the following information:
- User Name
- Computer Name
- Date
- Date/Time
- Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the **Main** or **More Options** tab.

**Note:** You can create your own preset by clicking the **Add/Remove Presets** button.

1. Click the **Main** or **More Options** tab.

You see the available **Printing Presets** on the left:
2. Place your cursor over one of the **Printing Presets** to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click **OK**.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

### Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select **Printer Settings**.
3. Click the **Maintenance** tab.
You see the maintenance options:

4. Click the **Extended Settings** button.
You see this window:

![Extended Settings window](image)

5. Select any of the extended settings to customize your print.
6. Click **OK** to close the Extended Settings window.
7. Click **OK** to close the printer software window.

Extended Settings - Windows

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

Extended Settings - Windows

You can select these settings on the Extended Settings window.

**Enable EPSON Status Monitor 3**

Enables product monitoring for ink and paper supplies and other issues.

**Check Paper Width Before Printing**

Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print speed.

**Thick Paper and Envelopes**

Prevents ink from smearing when you print on envelopes or other thick paper.

**Short Grain Paper**

Prevents ink from smearing when you print on envelopes or other thick paper, and the **Thick Paper** setting does not help.
Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier filing.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper, preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.

1. Click OK to save your settings.
You see your application's Print window, such as this one:

![Print window](image)

2. Click **OK** or **Print** to start printing.

**Parent topic**: Printing with the Standard Epson Printer Software - Windows

### Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:
   - **Windows 10**: Click 📑 and select 🗄 (Settings) > Devices > Printers & scanners. Select your product name and select **Manage** > **Printer properties**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel** > **Hardware and Sound** > **Devices and Printers**. Right-click your product and select **Printer properties**.
   - **Windows 7**: Click 📑 and select **Devices and Printers**. Right-click your product and select **Printer properties**.
• **Windows Vista:** Click 📲 and select Control Panel. Click Printer under Hardware and Sound, then right-click your product and select Properties.

• **Windows XP:** Click Start and select Printers and Faxes. Right-click your product and select Properties.

2. Click the Optional Settings tab.

   **Note:** You can prevent access to the Optional Settings tab by changing the user or group permissions in the Security tab.

3. Click Driver Settings.

   You see this window:

![Driver Settings Window](image)

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.

6. Click OK.
Locked Setting Options

Parent topic: Printing with the Standard Epson Printer Software - Windows

Locked Setting Options

Select the options you want to use for any locked print settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Copy Pattern</td>
<td>Various data items</td>
<td>Lets you select the data to use for the pattern or prohibit anti-copy patterns</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized anti-copy pattern</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the arrangement, size, and other settings for the custom anti-copy pattern</td>
</tr>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>2-sided printing</td>
<td>Off</td>
<td>Allows printing on one side of the paper only</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows printing on both sides of the paper</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

Parent topic: Locking Printer Settings - Windows
Entering a User ID and Password for Printing

If you enabled Access Control on the product, you must enter a user ID and password in the printer driver to be able to print.

Note: If you do not know the user ID or password, contact your administrator for assistance.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the Maintenance tab.

2. Click the Printer and Option Information button.

3. Select the Save Access Control Settings checkbox.

4. Click the Settings button.
5. Enter your user name and password.
6. Click OK.

Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.

You see the printer settings window:
3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
   These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

Changing the Language of the Printer Software Screens

Parent topic: Printing with the Standard Epson Printer Software - Windows

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select Printer Settings.
   You see the printer settings window.

3. Click the Maintenance tab.
You see the maintenance options:

4. Select the language you want to use as the **Language** setting.
5. Click **OK** to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows

**Changing Automatic Update Options**

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the ⚛ icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click ⚛.
2. Select **Software Update Settings**.
You see this window:

![Software Update Settings window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click **OK** to exit.

**Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related tasks**

- Checking for Software Updates

---

**Printing with the Epson Standard Printer Software - Mac**

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac
- Selecting Print Layout Options - Mac
Selecting Double-sided Printing Settings - Mac
Managing Color - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.
You see these settings:

9. Select the **Paper Source** you wish to print from.
10. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

11. Select the **Print Quality** setting you want to use.
12. Select any of the available print options.

---

**Paper Source Options - Mac**
**Print Quality Options - Mac**
**Print Options - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Related references**

- Paper or Media Type Settings - Printing Software

**Related tasks**

- Selecting Page Setup Settings - Mac
Paper Source Options - Mac
You can select any of the available options in the Paper Source menu to print on the paper loaded in that source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 3
Selects the paper in cassette 3 as the paper source.

Cassette 4
Selects the paper in cassette 4 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac

Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

Draft
For draft printing on plain paper.

Normal
For everyday text and image printing.

Normal - Vivid
For everyday text and image printing with good quality and print speed.

Fine
For text and graphics with good quality and print speed.

Quality
For text and graphics with increased quality and print speed.

High Quality
For photos and graphics with high print quality.

Best Quality
For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - Mac

Print Options - Mac

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

Grayscale

Prints text and graphics in black or shades of gray.

Mirror Image

Lets you flip the printed image horizontally.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

![Paper Size: US Letter](8.50 by 11.00 inches)

Note: If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.

Parent topic: Printing with the Epson Standard Printer Software - Mac
Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
- To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
- To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with the Epson Standard Printer Software - Mac

Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up menu on the print window.
Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network. This screen may be different, depending on the Mac OS version you are using.

1. Select one of the **Two-sided Printing** options.
2. Select the type of document you are printing as the **Document Type** setting. The software automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

**Double-sided Printing Options and Adjustments - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac
Related references
Double-sided Printing Capacity

Double-sided Printing Options and Adjustments - Mac
You can select any of the available options in the Two-sided Printing Settings or Output Settings pop-up menu to set up your double-sided print job.

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Managing Color - Mac
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

   ![Color Matching](image)

2. Select one of the available options.
3. Select **Color Options** from the pop-up menu in the print window.

![Color Options Menu](image)

**Note:** The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

**Color Matching and Color Options - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Color Matching and Color Options - Mac**

You can select these settings on the **Color Matching** and **Color Options** menus.

**Color Matching Settings**

**EPSON Color Controls**

Lets you manage color using controls in your printer software or turn off color management.

**ColorSync**

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.
Color Options Settings

Manual Settings
Let you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
3. Select Driver or Options.
You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.

**Printing Preferences - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Printing Preferences - Mac**

You can select these settings on the **Options** or **Driver** tab.

**Thick Paper and Envelopes**
Prevents ink from smearing when you print on envelopes or other thick paper.

**Skip Blank Page**
Ensures that your product does not print pages that contain no text or images.

**Quiet Mode**
Lessens noise during printing but may decrease print speed.

**High Speed Printing**
Speeds up printing but may reduce print quality.
Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier filing.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.

Parent topic: Printing with the Epson Standard Printer Software - Mac
1. Click the printer icon when it appears in the Dock.
   You see the print status window:

![Print status window](image)

2. Select the following options as necessary for your Mac OS version:
   - To cancel printing, click the print job and click or Delete.
   - To pause a print job, click the print job and click or Hold. To resume a print job, click the paused print job and click or Resume.
   - To pause printing for all queued print jobs, click or Pause Printer.
   - To display other printer information, click or Supply Levels.

Parent topic: Printing Your Document or Photo - Mac

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in these sections.

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows
Selecting Maintenance Options - Epson Universal Print Driver - Windows
Selecting Default Print Settings - Epson Universal Print Driver - Windows
Locking Printer Settings - Epson Universal Print Driver - Windows
Adding Network Printers - Epson Universal Print Driver - Windows
Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the product, such as an optional cassette unit.

1. Do one of the following:
   - **Windows 10:** Click 📧 and select 📦 (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printer properties.
   - **Windows 8.x:** Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows 7:** Click and select Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows Vista:** Click 📦 and select Control Panel. Click Printer under Hardware and Sound, then right-click EPSON Universal Print Driver and select Properties.
   - **Windows XP:** Click Start and select Printers and Faxes. Right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
You see a window like this:

3. Make sure **Acquire from Printer** is selected and click **Get**.

   **Note:** Select the **Only Optional Information** checkbox if you only want to enable optional equipment, such as an optional cassette unit.

   The product's settings and other information appears in the Current Printer Information area.

4. Click **OK**.

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Related tasks**

- Enabling the Optional Paper Cassettes - Windows
Selecting Basic Print Settings - Epson Universal Print Driver - Windows

Select the basic settings for the document or photo you want to print.

**Note:** The names of settings on the universal print driver screens may vary slightly, depending on the version of the print driver you have installed.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select **EPSON Universal Print Driver** as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.
You see the **Main** tab of your printer settings window:

![Printer settings window](image)

**Note:** For more information about a setting, right-click it and select **Help**.

4. For the **Paper Source** setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the **Document Size** setting.

   **Note:** You can also select the **User-Defined** setting to create a custom paper size.

6. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.
7. Select the type of paper you loaded as the **Paper Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black or shades of gray, select the **Grayscale** setting.

10. To print on both sides of the paper, select one of the **2-Sided Printing** settings.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the **Copies** options.

13. To preview your job before printing, select **Print Preview**.

14. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Related references**
- Paper or Media Type Settings - Printing Software
- Paper Source Options - Windows
- Print Quality Options - Windows
- Multi-Page Printing Options - Windows
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows

You can select a variety of additional layout and printing options for your document or photo on the More Options tab.

![Printing Preferences window showing options for document size and zoom](image)

**Note:** For more information about a setting, right-click it and select Help.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   - Select the **Fit to Page** option to size your image to fit the paper you loaded. Select the size of your document or photo as the **Document Size** setting, and the size of your paper as the **Output Paper** setting. If you want to center your image on the paper, select the **Center** option.
   - Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.
2. Select one of the following Color Correction options:
   • Select **Automatic** to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   • Select **Custom** and click the **Advanced** button to manually adjust the color correction settings or turn off color management in your printer software.
   • Select **Image Options** to access additional settings for improving printed images.

3. To add the following features, click the **Watermark Features** button:
   • **Watermark**: adds a visible watermark to your printout.
     
     **Note**: Click the **Add/Delete** button to create your own watermark, and click the **Settings** button to customize the watermark.
   
   • **Header/Footer**: adds information such as the date and time to the top or bottom of your printout.
     
     **Note**: Click the **Settings** button to customize the text and location of the header or footer.

4. To add a password to your print job, select the **Confidential Job** checkbox, then enter a password. Confidential jobs are stored in the product’s memory without being printed. To print the job, enter the password for the confidential job on the product's control panel.

   **Note**: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.

**Parent topic**: Printing with the Epson Universal Print Driver - Windows

**Related references**

- Custom Color Correction Options - Windows
- Image Options and Additional Settings - Windows
- Header/Footer Settings - Windows
Selecting Maintenance Options - Epson Universal Print Driver - Windows

You can select maintenance and other optional settings on the Maintenance tab.

Note: For more information about a setting, right-click it and select Help.

- **Nozzle Check** lets you print a nozzle check pattern to check for clogged nozzles.
- **Head Cleaning** lets you clean the print head.
- **Network printer search** lets you search for and connect to a product on the network.
- **Job Arranger Lite** lets you save your print job as a project that can be modified and combined with other print jobs.
- **Extended Settings** lets you change a variety of print settings.
- **Print Queue** displays all the print jobs in queue. You can also cancel or restart print jobs.
• **Printer and Option Information** displays information on the printer settings and any optional equipment installed.

• **Language** lets you change the language of the printer software screens.

**Extended Settings - Epson Universal Print Driver - Windows**

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Related concepts**

Print Head Nozzle Check

Print Head Cleaning

**Extended Settings - Epson Universal Print Driver - Windows**

You can select from these settings on the Extended Settings window.

- **Printer Control Language**
  
  Lets you select the printer control language.

- **Graphics Mode**
  
  Lets you select the mode by which to output PDL commands to the product.

- **TrueType Font**
  
  Lets you select how you want to print TrueType fonts.

- **Offset Settings**
  
  Lets you make fine-tune adjustments to the print position of data on your printout.
Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver’s Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the product to collate your print jobs instead. (This setting is automatically enabled if there is not enough memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows
When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Do one of the following:
   - **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printing Preferences.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.
- **Windows 7**: Click and select **Devices and Printers**. Right-click **EPSON Universal Print Driver** and select **Printing Preferences**.

- **Windows Vista**: Click and select **Control Panel**. Click **Printer** under **Hardware and Sound**, right-click **EPSON Universal Print Driver**, and select **Printing Preferences**.

- **Windows XP**: Click **Start** and select **Printers and Faxes**. Right-click **EPSON Universal Print Driver** and select **Printing Preferences**.

You see the printer settings window:

![Printer settings window](image)

**Note**: For more information about a setting, right-click it and select **Help**.

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click **OK**.
These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Locking Printer Settings - Epson Universal Print Driver - Windows**

Administrators can lock some printer settings to prevent unauthorized changes.

1. Do one of the following:
   - **Windows 10:** Click and select (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printer properties.
   - **Windows 8.x:** Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows 7:** Click and select Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows Vista:** Click and select Control Panel. Click Printer under Hardware and Sound, then right-click EPSON Universal Print Driver and select Properties.
   - **Windows XP:** Click Start and select Printers and Faxes. Right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
You see this window:

![Epson Universal Print Driver Locked Setting Options](image)

4. Select the checkbox for the settings you want to lock. To lock all print settings, select **All Document Settings**.
5. Under **Advanced Settings**, select the setting option you want to use for each locked setting.
6. Click **OK**.

**Epson Universal Print Driver Locked Setting Options**

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Epson Universal Print Driver Locked Setting Options**

Select the options you want to use for any locked print settings.
### Setting Options Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>2-sided printing</td>
<td>Off</td>
<td>Allows printing on only one side of the paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows printing on both sides of the paper</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

**Adding Network Printers - Epson Universal Print Driver - Windows**

You can use the Epson Universal Print Driver to find and add network printers.

1. Do one of the following:
   - **Windows 10**: Click 📱 and select 📄 (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printer properties.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows 7**: Click 📱 and select Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
• **Windows Vista:** Click and select **Control Panel.** Click **Printer** under **Hardware and Sound,** then right-click **EPSON Universal Print Driver** and select **Properties.**

• **Windows XP:** Click **Start** and select **Printers and Faxes.** Right-click **EPSON Universal Print Driver** and select **Properties.**

2. Click the **Optional Settings** tab.

   You see this window:

   ![EPSON Universal Print Driver Properties](image)

   - **Current Printer Information**
   - **Printer Utility**
   - **Network printer search**
   - **Driver Settings**

3. Click **Network printer search.**

4. When you see the search results, select **Add found printers.**
You see a screen like this:

5. Select the printer or printers you want to add.
6. Click **Add to Printer Folder**.
   The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click **OK**.

**Parent topic:** Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product is connected via USB, you will need to install the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

Selecting Basic Print Settings - PostScript Printer Software - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

If you installed optional paper cassette units, you need to enable the optional cassette units before you can use them with the PS3 printer software.

1. Do one of the following:

   - **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name and select Printer properties.
   - **Windows 7**: Click and select Devices and Printers. Right-click your product name and select Printer Properties.
   - **Windows Vista**: Click and select Control Panel. Click Printer under Hardware and Sound, then right-click your product name, and select Properties.
   - **Windows XP**: Click Start and select Printers and Faxes. Right-click your product name and select Properties.

2. Click the Device Settings tab.
You see a window like this:

3. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
4. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Basic Print Settings - PostScript Printer Software - Windows

Select the basic settings for the document or photo you want to print.

The PostScript printer software supports plain paper printing on these paper and envelope sizes:

- A4 (8.3 × 11.7 inches [210 × 297 mm])
• Letter (8.5 × 11 inches [216 × 279 mm])
• No. 10 (4.1 × 9.5 inches [105 × 241 mm])

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the **Preferences** button.

   You see the Layout tab of your printer settings window:

   ![Printing Preferences Window](image)

4. Select the orientation of your document.
5. To print on both sides of the paper, select one of the **Print on Both Sides** settings.
6. To change the printing order of the pages, select one of the **Page Order** settings.
7. To print multiple pages on one sheet of paper, adjust the **Pages per Sheet** setting.
8. To create a folded booklet out of your photo or document, select the **Booklet** option.
9. Click the **Paper/Quality** tab.
   
   You see this window:

![Printing Preferences window](image)

10. Select the **Paper Source** that matches where you loaded the paper you want to print on.
11. Select **Plain** as the **Media** setting.
12. Select one of the following as the **Color** setting:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black only, select the **Black & White** setting.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Windows

**Related references**
- Paper Source Options - Windows
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

You can select a variety of additional layout and printing options for your document or photo by clicking the Advanced button.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the Print Quality option that matches the print quality you want to use.
3. To use the Windows Image Color Management system, set the ICM Method setting to one of the ICM Handling options and select the ICM Intent setting you want to use.
4. Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.
5. Select the TrueType Font setting to determine font substitutes.
6. Enable the Advanced Printing Features setting to allow detailed settings for printing features.
7. Adjust the **Pages Per Sheet Layout** setting to change the order of multiple pages on a single sheet of paper when you have adjusted the **Pages Per Sheet** setting on the **Layout** tab.

8. Adjust the **Booklet Binding Edge** setting to change the orientation of your printed booklet.

9. Expand the PostScript Options heading to access the advanced PostScript printer software features.

10. Select any of the remaining **Printer Features** options to customize your printouts.

Parent topic: **Printing with the PostScript (PS3) Printer Software - Windows**

**Selecting Default Print Settings - PostScript Printer Software - Windows**

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Do one of the following:
   - **Windows 10**: Click 📐 and select 📐 (Settings) > **Devices** > **Printers & scanners**. Select your product name and select **Manage** > **Printing preferences**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel** > **Hardware and Sound** > **Devices and Printers**. Right-click your product name and select **Print Preferences**.
   - **Windows 7**: Click 📐 and select **Devices and Printers**. Right-click your product name and select **Printing Preferences**.
   - **Windows Vista**: Click 📐 and select **Control Panel**. Click **Printer** under **Hardware and Sound**, right-click your product name, and select **Printing Preferences**.
   - **Windows XP**: Click **Start** and select **Printers and Faxes**. Right-click your product name and select **Printing Preferences**.
You see the printer settings window:

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click **OK**.
   
   These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Windows

### Printing with the PostScript (PS3) Printer Software - Mac

You can print with the PostScript (PS3) printer software using any Mac printing program, as described in these sections.

**Note:** The PostScript printer software supports products that are connected via Ethernet. If your product is connected via USB, you will need to install the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

If you installed optional paper cassette units, you need to enable the optional cassette units before you can use them with the PS3 printer software.

1. In the Apple menu or the Dock, select **System Preferences**.
2. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
3. Select **Driver** or **Options**.

You see a screen like this:
4. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
5. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Related tasks
Enabling the Optional Paper Cassettes - Mac

Selecting Basic Print Settings - PostScript Printer Software - Mac

Select the basic settings for the document or photo you want to print.

The PostScript printer software supports plain paper printing on these paper and envelope sizes:

- A4 (8.3 × 11.7 inches [210 × 297 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

![Printer Settings](image)

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Paper Feed** from the pop-up menu.

You see these settings:

9. Select **All Pages From** or **First Page From** and select the paper source you want to print from.
10. Select **Printer Features** from the pop-up menu.

You see these settings:

11. Select **Plain** as the **MediaType** setting.

12. Select one of the following **Print Quality** options:
   - For fast printing with reduced quality, select **Fast**.
   - For printing text and graphics with good quality and print speed, select **Fine**.
• For the best printing with reduced speed, select **Maximum**.

13. Select **Color** from the Feature Sets pop-up menu.

You see these settings:

![Printer Features window](image)

14. Select a **Color Mode** option:
   • To print a color document or photo, select the **Color** setting.
   • To print text and graphics in black only, select the **Monochrome** setting.

15. Select any of the available print options.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Related tasks**
- Selecting Page Setup Settings - PostScript Printer Software - Mac
- Selecting Print Layout Options - PostScript Printer Software - Mac
- Printing Your Document or Photo - PostScript Printer Software - Mac
Selecting Page Setup Settings - PostScript Printer Software - Mac

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

![Paper Size and Orientation Settings](image)

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

1. Select the size of the paper you loaded as the **Paper Size** setting. You can also select a custom setting to create a custom paper size.
2. Select the orientation of your document or photo as shown in the print window.

**Note:** You can reduce or enlarge the size of the printed image by selecting **Paper Handling** from the pop-up menu and selecting a scaling option.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Related tasks**

- Selecting Basic Print Settings - PostScript Printer Software - Mac
Selecting Print Layout Options - PostScript Printer Software - Mac

You can select a variety of layout options for your document or photo by selecting **Layout** from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the **Pages per Sheet** pop-up menu. To arrange the print order of the pages, select a **Layout Direction** setting.
- To print borders around each page on the sheet, select a line setting from the **Border** pop-up menu.
- To print on both sides of the page, select one of the **Two-Sided** settings.
- To invert or flip the printed image, select the **Reverse page orientation** or **Flip horizontally** settings.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac
Sizing Printed Images - PostScript Printer Software - Mac

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu on the Print window.

- To print only selected pages in a multi-page document, select an option from the Pages to Print pop-up menu.
- To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
- To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and select a paper size from the Destination Paper Size pop-up menu.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Managing Color - PostScript Printer Software - Mac

You can adjust the Color Matching settings to fine-tune the colors in your printout.
1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching menu](image)

2. Do one of the following:
   - To print using standard color profiles for your product and paper to help match image colors, select **ColorSync**. Select one of the available **Profile** options to change the active color profile.
   - To use the product's default color matching, select **In printer**.

*Parent topic:* [Printing with the PostScript (PS3) Printer Software - Mac](#)

**Printing Your Document or Photo - PostScript Printer Software - Mac**

Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Printer Features](image)

**Checking Print Status - PostScript Printer Software - Mac**

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Checking Print Status - PostScript Printer Software - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

2. Select the following options as necessary for your Mac OS version:
   - To cancel printing, click the print job and click or Delete.
   - To pause a print job, click the print job and click or Hold. To resume a print job, click the paused print job and click or Resume.
   - To pause printing for all queued print jobs, click Pause or Pause Printer.
   - To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - PostScript Printer Software - Mac

Cancelling Printing Using a Product Button

If you need to cancel printing, press the stop button on your product.

Parent topic: Printing from a Computer
Scanning

You can scan your originals and save them as digital files.

Starting a Scan
Scanning with Document Capture Pro or Document Capture
Scanning in Epson Scan 2
Scanning Special Projects
Entering a User ID and Password for Scanning
Creating Contacts for Scanning

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Note: You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smart Device

Parent topic: Scanning

Related tasks
Scanning with Document Capture Pro or Document Capture

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel

You can scan an image to a variety of destinations using your product's control panel.

1. Make sure you installed the product software and connected the product to your computer or network.

Note: Restart your computer after installing the product software to enable scanning from the control panel.
2. Place your original on the product for scanning.

   **Note:** To scan a double-sided or multi-page document, place your originals in the ADF.

3. Press the home button, if necessary.
4. Select **Scan**.

   You see a screen like this:

5. Select one of the following **Scan to** options:
   - **Network Folder/FTP** saves your scan file to a specified folder on a network.
   - **Email** lets you send scanned files through a pre-configured email server.
   - **Document Capture Pro** lets you scan over a network using your saved job settings in Document Capture Pro or Document Capture.

   **Note:** You cannot use this option to scan an image to Document Capture or Document Capture Pro when your product is connected to your computer's USB port.

   - **Memory Device** saves your scan file on a USB device and lets you select the file format, quality, and other settings.
   - **Cloud** sends your scanned files to a destination that you have registered with Epson Connect.
• **Computer (WSD)** lets you manage network scanning in Windows 10, Windows 8.x, Windows 7, or Windows Vista (English only). To use this feature, you must first set up WSD (Web Services for Devices) on the computer.

6. Follow the instructions in the links below to complete your scan.

   - Scanning to Email
   - Scanning to a Network Folder or FTP Server
   - Adding and Assigning Scan Jobs with Document Capture Pro or Document Capture
   - Control Panel Scanning Options

**Parent topic:** Starting a Scan

**Related tasks**
- Using Epson Scan to Cloud
- Using Presets
- Entering Characters on the LCD Screen

**Related topics**
- Placing Originals on the Product

### Scanning to Email

You can scan an original and email the scanned file using your product's control panel. You need to have a preconfigured email server before you can scan to email. You can either enter the email address directly on the product's control panel or select an address from the **Contacts** list. Make sure the date and time are set correctly so the time stamps on your emails are accurate.

**Note:** You can also use the Scan to Document Capture Pro function to scan and email the scanned file.

1. Place your original on the product for scanning.

   **Note:** To scan a double-sided or multi-page document, place all of the pages in the ADF.

2. Press the **home** button, if necessary.

3. Select **Scan**.
You see a screen like this:

4. Select **Email**.

You see a screen like this:

5. Do one of the following:
   - Select **Contacts** and choose an email address from the **Contacts** list.
• Select **Keyboard** to use the displayed keyboard to enter the address for the recipient and press **OK**.
• Select **History** to choose an email address from your recent scan history.
• Select an email address from any displayed frequent contacts.

6. Select **Scan Settings**.

7. Select **File Format** to choose the file format for your scan.

8. Scroll down and change the **Subject** and **Filename settings** if necessary.

9. Select any additional scan settings as necessary.

10. Select **Presets** to save your scan settings.

   **Note:** Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

11. Press the **Send** icon.

   Your product scans your original and emails the scanned file.

**Parent topic:** Starting a Scan Using the Product Control Panel

### Scanning to a Network Folder or FTP Server

You can scan an image and save it to a network folder using your product's control panel. You can either enter the folder path directly on the product's control panel or select a folder from the **Contacts** list.

**Note:** Make sure the date and time are set correctly before using this feature.

1. Place your original on the product for scanning.
   
   **Note:** To scan a double-sided or multi-page document, place your originals in the ADF.

2. Press the home button, if necessary.

3. Select **Scan**.
You see a screen like this:

4. Select **Network Folder/FTP**.
   
   You see a screen like this:

   ![Network Folder/FTP Screen](image)

5. Do one of the following:
   - Select **Contacts** and choose a saved location from the **Contacts** list.
• Select **Keyboard**, then select the **Communication Mode** field and select **Network Folder (SMB)** or **FTP**. Then select the **Location** field and enter the folder location, and press **OK**. Enter other information as necessary.

Enter the folder path name for the **Location** setting in one of the following formats depending on the **Communication Mode** setting you selected:

- **SMB**: `\host name\folder`
- **FTP**: `ftp://host name/folder name`
- Select an email address from any displayed frequent contacts.

6. Select **Scan Settings**.

7. Select **File Format** to choose the file format for your scan.

8. Scroll down and select **File Settings**. Change the **File Name** if necessary.

9. Select any additional scan settings as necessary.

10. Select **Presets** to save your scan settings.

    **Note:** Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

11. Press the **Start** icon.

    Your product scans your original and saves it in the selected location.

**Parent topic:** Starting a Scan Using the Product Control Panel

**Related references**

- Control Panel Scanning Options

**Related tasks**

- Selecting the Date and Time
- Entering Characters on the LCD Screen
- Creating Contacts for Scanning

**Related topics**

- Placing Originals on the Product
Adding and Assigning Scan Jobs with Document Capture Pro or Document Capture

You can view, change, or add available default scan settings when you scan using the Document Capture Pro option on the product control panel. You do this by accessing the scan jobs in the Document Capture Pro (Windows) or Document Capture (Mac) program.

1. Start Document Capture Pro or Document Capture on a computer connected to the product.

2. Click the Manage Job icon from the toolbar at the top of the window.
   You see a window showing the current scan job list.

3. If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings as necessary, and click OK.
   You can now use the new scan job when you scan with Document Capture Pro or Document Capture.

   **Note:** See the Help information in Document Capture Pro or Document Capture for details.

4. If you want to assign scan jobs to the selection list on the product control panel, do one of the following:
   • **Windows:** Click Event Settings.
   • **Mac:** Click the icon at the bottom of the window, then click Event Settings.
5. Select the jobs that you want to assign to any of the pull-down menus.

You can now use the added scan jobs when you scan from the product control panel.

6. Click OK, then click OK again.

**Parent topic:** Starting a Scan Using the Product Control Panel

**Related topics**

Placing Originals on the Product

Control Panel Scanning Options

Select the options you want to use for scanning.

**Note:** Not all options or settings may be available, depending on the Scan to option selected.
<table>
<thead>
<tr>
<th>Scan to setting</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Location</td>
<td><strong>Communication Mode</strong></td>
<td>Lets you select <strong>Network Folder (SMB)</strong> or <strong>FTP</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Location</strong></td>
<td>Lets you enter a folder path in which to save scanned images</td>
</tr>
<tr>
<td></td>
<td><strong>User Name</strong></td>
<td>Lets you enter a user name for the selected folder path</td>
</tr>
<tr>
<td></td>
<td><strong>Password</strong></td>
<td>Lets you enter a password for the selected folder path</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Mode</strong></td>
<td>Lets you select the connection mode</td>
</tr>
<tr>
<td></td>
<td><strong>Port Number</strong></td>
<td>Lets you enter a port number</td>
</tr>
<tr>
<td>Contacts</td>
<td>---</td>
<td>Select an email address or folder path to send or save scanned images</td>
</tr>
<tr>
<td>Color Mode</td>
<td><strong>Color</strong></td>
<td>Select whether to scan images in color or black and white</td>
</tr>
<tr>
<td></td>
<td><strong>B&amp;W</strong></td>
<td></td>
</tr>
<tr>
<td>File Format</td>
<td><strong>JPEG</strong></td>
<td>Select for photos. You can also select the <strong>Compression Ratio</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>PDF</strong></td>
<td>Select for documents. You can also select the <strong>Compression Ratio</strong> and <strong>PDF Settings</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>TIFF (Single Page)</strong></td>
<td>Select for scanned files that you can print from a device. Multi Page TIFF documents are scanned in black and white.</td>
</tr>
<tr>
<td></td>
<td><strong>TIFF (Multi Page)</strong></td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td><strong>200dpi</strong></td>
<td>Select for documents</td>
</tr>
<tr>
<td></td>
<td><strong>300dpi</strong></td>
<td>Select for photos</td>
</tr>
<tr>
<td></td>
<td><strong>600dpi</strong></td>
<td>Select for highest quality printing</td>
</tr>
<tr>
<td>2-Sided</td>
<td><strong>1-Sided</strong></td>
<td>Lets you scan 2-sided originals placed in the ADF. If you select <strong>2-Sided</strong>, you can also select the <strong>Orientation (Original)</strong> and the <strong>Binding (Original)</strong>.</td>
</tr>
<tr>
<td>Scan to setting</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Scan Area</td>
<td>Auto Detect</td>
<td>Select to automatically adjust the scan area</td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>Half Letter</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>Auto Cropping</td>
<td>Select for photos with dark edges</td>
</tr>
<tr>
<td></td>
<td>Max Area</td>
<td>Select for most photos</td>
</tr>
<tr>
<td>Original Type</td>
<td>Text</td>
<td>Specifies the type of original you are scanning</td>
</tr>
<tr>
<td></td>
<td>Text &amp; Image</td>
<td>Specifies the type of original you are scanning</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td>Specifies the type of original you are scanning</td>
</tr>
<tr>
<td>Density</td>
<td>−4 to +4</td>
<td>Adjusts the lightness or darkness of scanned images.</td>
</tr>
<tr>
<td>Remove Shadow</td>
<td>On</td>
<td>Erases the shadows that appear in the center of a document when copying a book or the shadows that appear around a document when copying thick paper</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Erases the shadows that appear in the center of a document when copying a book or the shadows that appear around a document when copying thick paper</td>
</tr>
<tr>
<td>Remove Punch Holes</td>
<td>On</td>
<td>Erases the binding holes on a document</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Erases the binding holes on a document</td>
</tr>
<tr>
<td>Subject</td>
<td>—</td>
<td>Lets you enter a subject for your email</td>
</tr>
<tr>
<td>Attached File Max Size</td>
<td>Various sizes</td>
<td>Lets you select the maximum file size that can be attached to an email</td>
</tr>
<tr>
<td>File Name</td>
<td>—</td>
<td>Lets you enter a prefix, the date, and the time to the file name for your scanned file</td>
</tr>
</tbody>
</table>

**Note:** When you turn on password settings, you can use the LCD screen keyboard to set the password.

**Parent topic:** Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- **Windows 10:** Click 📱 and select **EPSON > Epson Scan 2**.
- **Windows 8.x:** Navigate to the **Apps** screen and select **Epson Scan 2**.
- **Windows (other versions):** Click 📱 or **Start**, and select **All Programs** or **Programs**. Select **EPSON > Epson Scan 2 > Epson Scan 2**.
- **Mac:** Open the **Applications** folder, open the **Epson Software** folder, and select **Epson Scan 2**.
You see an Epson Scan 2 window like this:
Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

**Note:** In certain programs, you may need to select your product as the "source" first. If you see a **Select Source** option, choose it and select your product. With Windows, do not select a **WIA** option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
You can start a scan from a smart device using the Epson iPrint app. You can save the scanned document to your device or a cloud service, e-mail it, or print it.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

**Note:** Your device must be connected to the same wireless network as your Epson product.

1. Download the Epson iPrint app from your device's app store or from Epson's website.
2. Place your original on the product for scanning.
3. Open the Epson iPrint app and select your product.
4. Select the scan settings and scan your original.
5. Save your scanned image to a file or cloud location.

When you scan with Document Capture Pro (Windows) or Document Capture (Mac), the program automatically saves your scanned file on your computer in the folder you specify. You can select settings, preview, and change the scanned file settings as necessary.
1. Do one of the following to start Document Capture Pro or Document Capture:
   • **Windows 10:** Click and select EPSON Software > Document Capture Pro.
   • **Windows 8.x:** Navigate to the Apps screen and select Document Capture Pro.
   • **Windows (other versions):** Click or Start, and select All Programs or Programs. Select EPSON Software > Document Capture Pro.
   • **Mac:** Open the Applications folder, open the Epson Software folder, and select Document Capture. Select your product and click OK, if necessary.

   You see a window like this:

   ![Document Capture Pro window](image)

2. Click the \(\text{\(\rightarrow\)}\) Scan icon.
You see a window like this:

![Scan window]

3. If you want to use a scan job that you created instead, select it from the Job list in the Document Capture Pro or Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

   **Note:** See the Help information in Document Capture Pro or Document Capture for details.

5. If you want to select detailed scan settings, do one of the following:
   - **Windows:** Click Detailed Settings. Select any displayed scan settings you want to use and click OK.
   - **Mac:** If you installed Epson Scan, close the Scan Settings window, open the Scan menu at the top of the screen and select **Displays the EPSON Scan Setup Screen.** Click the Scan icon. Select any displayed scan settings you want to use and click OK.
6. Click **Scan**.
   You see a preview of your scan in the Document Capture Pro or Document Capture window.

7. Check the scanned images and edit them as necessary.

8. Click one of the Destination icons to choose where to save your scanned file.

   ![Destination icons](image)

   **Note:** You may need to click the arrow next to the icons in order to see all of them. The available icons may vary, depending on the software version you are using.

9. Select settings as necessary, then click **OK**, **Send**, or **Print** to save the scanned file.

**Parent topic:** [Scanning](#)

**Related topics**

[Placing Originals on the Product](#)

### Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document and save the scanned image in various file formats in your operating system’s Documents or My Documents folder, or open it in your scanning program. You can preview the scanned image and select or change settings as necessary.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Start Epson Scan 2.
You see this window:
2. Select the **Document Source** setting that matches where you placed your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the source.

3. Select the **Scanning Side** setting if you are scanning from the ADF.

4. Select the **Document Size** setting that matches the size of your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the size. You can select **Customize** to enter a custom size, if necessary.

5. Select the image type of your original and how you want it scanned as the **Image Type** setting.

6. Select the **Resolution** setting you want to use for your scan.

7. Click the **Preview** button.

   Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

8. Reinsert your original into the ADF, if necessary.

9. Select any of the additional settings that you want to use on the **Main Settings** tab.

10. Click the **Advanced Settings** tab and select any settings that you want to use.

11. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.
12. Enter the file name for your scanned file in the **File Name** field. If necessary, select **Settings** to modify the file name settings.

13. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to create a new folder.

14. Click **Scan**.

   The product scans your original and saves the scanned file in the location you specified.

---

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

- **Dual Image Output**
  
  Scans the original image twice using different output settings (Windows only).

- **After Scanning Option**
  
  When scanning multi-page originals, lets you add additional pages or add and edit the pages in a job and save all of the scanned pages as one file.

  **Note:** You must select a file format that supports multi-page such as **PDF** or **Multi-TIFF**.

**Parent topic:** Scanning in Epson Scan 2

---

**Additional Scanning Settings - Advanced Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

- **Text Enhancement**
  
  Sharpens the appearance of letters in text documents.
Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned image, adjust this setting to prevent this.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Correct Document Skew
Corrects skewed originals, image contents, or both.

Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.
Note: The required Epson Scan 2 OCR Component is installed automatically when you install your product software as instructed on the Start Here sheet. If you install your scanner software programs individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. If you are using the ADF, reload the ejected original.
6. Select Searchable PDF as the Image Format setting.
7. Select Options from the Image Format list.
   You see this window:
   
   ![Image Format Options window]
   
   8. Select any of the options on the General tab.
9. Select the Text tab.
10. Make sure the language used in the document text is selected as the Text Language setting.
11. Click **OK**.
12. Confirm the **File Name** setting and select a **Folder** setting for your document.
13. Click **Scan**.

The scanned image is saved as a searchable PDF.

Parent topic: Scanning in Epson Scan 2

Related topics

Placing Originals on the Product

**Image Format Options**

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

**BITMAP (*.bmp)**
A standard image file format for most Windows programs.

**JPEG (*.jpg)**
An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)

**PNG (*.png)**
An image format that does not lose quality during editing.

**TIFF (*.tif)**
A file format created for exchanging data between many programs, such as graphic and DTP software.

**Multi-TIFF (*.tif)**
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

**PDF (*.pdf)**
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.

**Searchable PDF (*.pdf)**
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

Parent topic: Scanning in Epson Scan 2
Scan Resolution Guidelines

The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

- Larger file sizes
- It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
- The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the resolution setting you need:

- You will scan the image at its original size but enlarge it later in an image-editing program.
  - Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.
- You will scan the image at 100% or a smaller size.
  - Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
    - Email/view on a computer screen/post on the web: 96 to 200 dpi
    - Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan projects.

Scanning to a SharePoint Server or Cloud Service
Scanning Multi-Page Originals as Separate Files

Parent topic: Scanning

Scanning to a SharePoint Server or Cloud Service

You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud service.
1. Do one of the following to start Document Capture Pro:
   
   - **Windows 10**: Click and select **EPSON Software > Document Capture Pro**.
   
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Document Capture Pro**.
   
   - **Windows (other versions)**: Click or **Start**, and select **All Programs** or **Programs**. Select **EPSON Software > Document Capture Pro**.
   
   - **Mac**: Open the **Applications** folder, open the **Epson Software** folder, and select **Document Capture**. Select your product and click **OK**, if necessary.

   You see a window like this:

   ![Document Capture Pro window](image)

   2. Click the **Scan** icon.
   
   3. Select any displayed scan settings you want to use.

   **Note**: See the Help information in Document Capture Pro or Document Capture for details.

   4. Click **Scan**.
   
   You see a preview of your scan in the Document Capture Pro or Document Capture window.
5. Click one of the cloud service Destination icons to choose where to save your scanned file.

   • Web Folder (WebDAV)
   • Evernote (Windows only)
   • Google Drive
   • SugarSync
   • Microsoft SharePoint server (Windows only)

   **Note:** You may need to click the arrow next to the icons in order to see all of them. The available icons may vary, depending on the software version you are using.

6. Select your Destination settings.

   **Note:** The settings may vary, depending on the software version you are using. See the Help information in Document Capture Pro or Document Capture for details.

7. Select any other scan settings as necessary, and click **Send**.

   Your originals are scanned and uploaded to the indicated server.

   **Note:** You can also create a scan job for uploading scanned images to a SharePoint server or a cloud service. You can use the scan job when you scan with Document Capture Pro or Document Capture or when you scan using the Document Capture Pro option on the product control panel.

**Parent topic:** Scanning Special Projects

### Scanning Multi-Page Originals as Separate Files

You can use Document Capture Pro (Windows only) to scan multi-page originals as separate scanned files. You indicate where you want the new scanned files to start by inserting a blank page or barcode between the pages of your original.

**Note:** The settings may vary, depending on the software version you are using. See the Help information in Document Capture Pro for details.
1. Load a multi-page original with blank pages or barcodes inserted where you want to start a new scanned file.

2. Do one of the following to start Document Capture Pro:
   - **Windows 10**: Click \(\text{Start}\) and select **EPSON Software > Document Capture Pro**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Document Capture Pro**.
   - **Windows (other versions)**: Click \(\text{Start}\) or **Start**, and select **All Programs** or **Programs**. Select **EPSON Software > Document Capture Pro**.

   You see this window:

   ![Document Capture Pro Window](image)

3. Click the \(\text{Scan}\) icon.

4. Select any displayed scan settings you want to use.

   **Note**: See the Help information in Document Capture Pro for details.

5. Click **Scan**.

   You see a preview of your scan in the Document Capture Pro window.
6. Open the **File** menu and select **Batch Save**.
7. Click **File Name Settings**.
8. Select **Apply Job Separation** and click **Separation Settings**.
9. Select the method you used to separate the originals, select a folder name specification and click **OK**.
10. Select any other settings from the File Name settings window as necessary and click **OK**.
11. Select any other settings from the Batch Save window as necessary and click **OK**.

Your originals are saved into separate files as specified.

**Note:** You can also create a scan job for scanning multi-page originals as separate scanned files. You can use the scan job when you scan with Document Capture Pro or when you scan using the Document Capture Pro option on the product control panel.

**Parent topic:** Scanning Special Projects

### Entering a User ID and Password for Scanning

If you enabled Access Control on your product, a user ID and password may be required to scan. You can enter the user ID and password in Epson Scan 2.

**Note:** If you do not know the user ID or password, contact your administrator for assistance.

1. Start Epson Scan 2.
2. Select **Settings** from the **Scanner** drop-down list.
You see this window:

You can create a list of contacts for scanning to email or to a network folder or FTP.

**Note:** Contacts can be locked by an administrator. If you cannot access or change contacts, contact your administrator for assistance. You can create up to 2,000 contacts and contact groups combined (including fax contacts).

1. Press the home button, if necessary.
2. Select Settings.
3. Select Contacts Manager. Enter the administrator password, if necessary.
4. Select Register/Delete.
You see a screen like this:

5. Select **Add Entry**.
6. Select **Add Contact**.
7. Do one of the following:
   - To create a contact for scanning to email, select **Email**.
   - To create a location for scanning to a network folder or FTP, select **Network Folder/FTP**.
8. Select the number you want to use for the contact you are adding.
9. Select the **Name** field, use the displayed keyboard to enter the contact name (up to 30 characters), and press **OK**.
10. Select the **Index Word** field, use the displayed keyboard to enter a word to use when searching for an entry (up to 30 characters), and press **OK**. (This field is optional.)
11. Do one of the following:
   - For an email contact, select the **Email Address** field, use the displayed keyboard to enter the address, and press **OK**.
   - For a network folder or FTP location, select the **Communication Mode** field and select **Network Folder (SMB)** or **FTP**. Then select the **Location** field, use the displayed keyboard to enter the location, and press **OK**. Enter other information if necessary.
Enter the folder path name for the **Location** setting in one of the following formats depending on the **Communication Mode** setting you selected:

- **SMB**: `\host name\folder`
- **FTP**: `ftp://host name/folder name`

12. Select **OK**.

**Note**: If you need to edit or delete scanning contacts, the procedures are the same as for fax contacts.

**Parent topic**: Scanning

**Related tasks**
Entering Characters on the LCD Screen
Editing or Deleting a Contact

**Related topics**
Setting Up Contacts Using the Product Control Panel
Faxing

See these sections to fax using your product.

**Note:** This product allows you to store names, telephone numbers, and fax data in its memory even when the power is turned off. Make sure you restore all of the default settings if you give away or dispose of the product. This will erase all of your network settings and fax data.

**Note:** When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product, you can fax using the printer buttons or the utilities included with the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Contacts and Contact Groups
Sending Faxes
Receiving Faxes
Checking Fax Status
Printing Fax Reports

Connecting a Telephone or Answering Machine
You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the same telephone line to receive calls, you can connect a telephone or answering machine to your product using an additional phone cable.

**Note:** If you do not connect a telephone to your product, make sure Receive Mode is set to **Auto**. Otherwise, you cannot receive faxes.
1. Connect a phone cable to your telephone wall jack and to the **LINE** port on your product.

**Note:** If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your product. Contact your DSL or ISDN provider for the necessary equipment.
DSL connection

1. Telephone wall jack
2. DSL filter
3. DSL modem
ISDN connection

1 ISDN wall jack
2 Terminal adapter or ISDN router
2. If you are connecting a telephone or answering machine to your product using a second phone cable, remove the cap from the **EXT** port on your product.
3. Connect a second phone cable to your telephone or answering machine and to the EXT port on your product.

**Note:** If you connect an answering machine and **Receive Mode** is set to **Auto**, set the number of rings before your product answers a call to a number that is higher than your answering machine's setting for the number of rings.

Any phone or answering machine must be connected to the EXT port for your product to detect an incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP, cable phone systems, or fiberoptic digital services such as FIOS.

**Parent topic:** Faxing

**Related references**

[Cannot Receive Faxes with a Telephone Connected to Your Product](#)
Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

**Note:** If you leave your product unplugged for a long period of time, you may need to reset the date and time settings for faxes.

- Setting Up Basic Fax Features
- Selecting Advanced Fax Settings
- Setting Up the Fax Utility - Windows
- Setting Up Fax Features Using the Fax Utility - Mac

**Parent topic:** Faxing

Setting Up Basic Fax Features

See these sections to select the basic settings you need to use the product's fax features.

- Using the Fax Setup Wizard
- Selecting the Line Type
- Setting the Number of Rings to Answer

**Parent topic:** Setting Up Fax Features

Using the Fax Setup Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically displayed when the product is turned on for the first time. You can also change these settings individually from the Fax Settings menu.

**Note:** These settings can be locked by an administrator. If you cannot access or change these setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

![General Settings](image)

4. Scroll down and select **Fax Settings**.
5. Scroll down and select **Fax Setting Wizard**.
   
   A confirmation screen appears.

6. Select **Proceed**.

7. On the Fax Header screen, use the displayed keypad to enter the sender name for your fax source, such as your name or a business name. You can enter up to 40 characters.
8. On the Your Phone Number screen, use the displayed keypad to enter your fax number, up to 20 characters.

   **Note:** The name and phone number in the fax header identifies the source of the faxes you send.

9. On the DRD Setting screen, do one of the following:
   
   - If you have subscribed to a distinctive ring service from your telephone company, select **Proceed**. Select the ring pattern to be used for incoming faxes or select **All**. Go to step 12.
   
   - If you do not have a distinctive ring service, select **Skip** and go to the next step.

   **Note:** Distinctive ring services allows you to have several phone numbers on one phone line. Each number is assigned a different ring pattern. You can use one number for voice calls and another for
fax calls. Select the ring pattern assigned to fax calls in the DRD Setting. If you select a ring pattern other than All, Receive Mode is automatically set to Auto.

10. On the Receive Mode Setting screen, do one of the following:
   • If you have connected an external telephone or answering machine to the product, select Yes and go to the next step.
   • If you did not connect an external telephone or answering machine, select No and go to step 12. (Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)

11. On the next Receive Mode Setting screen, select Yes to receive faxes automatically or select No to receive faxes manually.

   Note: If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to answer every call and operate the product’s control panel or your phone to receive faxes.

12. On the Proceed screen, confirm the displayed settings and select Proceed, or press the back arrow to change the settings.

13. On the Run Check Fax Connection screen, select Start and follow the on-screen instructions to check the fax connection and print a report of the check result. If there are any errors reported, try the solutions on the report and run the check again.

   If the Select Line Type screen appears, select the correct line type.

   If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone detection function may drop the first digit of a fax number and send the fax to the wrong number.

Parent topic: Setting Up Basic Fax Features

Related tasks
Entering Characters on the LCD Screen

Selecting the Line Type

If you connect the product to a PBX phone system or terminal adapter, you must change the product's line type. PBX (Private Branch Exchange) is used in office environments where an external access code such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched Telephone Network), which is a standard home phone line.

   Note: This setting can be locked by an administrator. If you can't access or change this setting, contact your administrator for assistance.
1. Press the home button, if necessary.
2. Select Settings.

![General Settings Screen]

4. Scroll down and select Fax Settings.
5. Select Basic Settings.
6. Select Line Type.
7. Select PBX.
You see a screen like this:

8. Select **Use**.
9. Select **Access Code**.
10. Use the displayed keypad to enter the access code, such as 9, and select **OK**.

**Parent topic:** Setting Up Basic Fax Features

### Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. The number of rings should be higher than the number of rings your answering machine is set to for answering a call.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

![General Settings](image)

4. Scroll down and select **Fax Settings**.
5. Select **Basic Settings**.
6. Select **Rings to Answer**.

![Rings to Answer](image)
7. Select the number of rings and select **OK**. Make sure to select a number higher than the number of rings your answering machine is set to for answering a call.

**Note:** An answering machine picks up every call faster than the product, but the product can detect fax tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has started receiving the fax, then hang up the phone.

**Parent topic:** Setting Up Basic Fax Features

**Selecting Advanced Fax Settings**

You can select a variety of advanced fax settings.

**Note:** These settings can be locked by an administrator. If you cannot access or change these setting, contact your administrator for assistance.

1. Press the **home** button, if necessary.
2. Select **Settings**.
3. Select **General Settings**

4. Scroll down and select **Fax Settings**.
You see a screen like this:

![Fax Settings Screen](image)

5. Select the group of settings you want to change.

Send Settings - Fax
Print Settings - Fax
Basic Settings - Fax
Security Settings - Fax

Parent topic: Setting Up Fax Features

Send Settings - Fax

Set the send options you want to use for outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Rotation</td>
<td>Off</td>
<td>Sends an A4 or letter-size document that is placed long edge first into the ADF as an A3-size fax.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Quick Memory Send</td>
<td>Off</td>
<td>Sends the first page of a multi-page document as soon as it finishes scanning. Select this option to decrease the amount of time it takes to fax a document.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Batch Send</td>
<td>Off</td>
<td>Sorts outgoing faxes by recipient in the product's memory, and then sends them as a batch.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Save Failure Data</td>
<td>Off</td>
<td>Saves faxes that failed to be sent in the product's memory. You can resend the faxes from the product's Status Menu.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Print Settings - Fax

Set the print options you want to use for incoming faxes in the Receive Settings > Print Settings menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Reduction</td>
<td>On</td>
<td>Select to reduce the size of large received faxes to fit on the paper size in the selected paper source.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Select to print large incoming faxes at their original size on multiple sheets, if necessary.</td>
</tr>
<tr>
<td>Split Page Settings</td>
<td>Delete Print Data</td>
<td>Select how to split large incoming faxes across multiple sheets when using the Auto Reduction option.</td>
</tr>
<tr>
<td></td>
<td>After Split</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Overlap When Split</td>
<td></td>
</tr>
<tr>
<td>Acting Print</td>
<td>On (Split to Pages)</td>
<td>Select to split large incoming faxes across multiple sheets.</td>
</tr>
<tr>
<td></td>
<td>On (Reduce to Fit)</td>
<td>Select to reduce the size of large received faxes to fit on the paper size in the selected paper source.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Select to print large incoming faxes at their original size on multiple sheets, if necessary.</td>
</tr>
<tr>
<td>Auto Rotation</td>
<td>On</td>
<td>If you have loaded A5-size paper, select On to rotate landscape-oriented incoming faxes so that they print correctly on the paper.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Add Reception Information</td>
<td>On</td>
<td>Select On to include the date, time, the sender's information, and a page number in the header of your incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2-Sided</td>
<td>On</td>
<td>Select On to print incoming faxes double sided. You can also select the Binding Margin.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Start Timing</td>
<td>All Pages Received</td>
<td>Select to print incoming faxes after the product receives all of the pages of the document.</td>
</tr>
<tr>
<td></td>
<td>First Page Received</td>
<td>Select to print incoming faxes as soon as the product receives the first page of the document.</td>
</tr>
<tr>
<td>Collation Stack</td>
<td>On</td>
<td>Select On to print incoming faxes so that the pages are stacked in the correct page order. (When the product is low on memory, this option may not be available.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Suspend Time</td>
<td>Off</td>
<td>Select On to set a time period to stop automatic printing of faxes or reports and save received faxes in the product’s memory. (Make sure there is enough free memory before using this function.)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time to Stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Restart Time</td>
<td></td>
</tr>
<tr>
<td>Quiet Mode</td>
<td>On</td>
<td>Select On to reduce noise during printing. (Printing speed may be reduced.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Basic Settings - Fax

Set the basic options you want to use for incoming and outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Speed</td>
<td>Fast(33,600bps)</td>
<td>Sets the speed at which you send and receive faxes.</td>
</tr>
<tr>
<td></td>
<td>Medium(14,400bps)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow(9,600bps)</td>
<td></td>
</tr>
<tr>
<td>ECM</td>
<td>On</td>
<td>Turns on Error Correction Mode (ECM) to automatically correct errors in sent or received fax data.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off Error Correction Mode (ECM); color faxes cannot be sent or received.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dial Tone Detection</td>
<td>On</td>
<td>Automatically dials the number you enter for faxing when the product detects a dial tone.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic dial tone detection, which may be necessary if the product is connected to a PBX (Private Branch Exchange) or a TA (Terminal Adapter). However, turning this setting off may cause the product to drop the first digit of a fax number.</td>
</tr>
<tr>
<td>Dial Mode</td>
<td>Tone</td>
<td>Selects a tone dialing system and assigns each number a tone during dialing.</td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
<td>Selects a pulse dialing system and assigns each number a series of pulses during dialing. You can temporarily switch to Tone by pressing * during dialing.</td>
</tr>
<tr>
<td>Line Type</td>
<td>PSTN</td>
<td>Selects a standard phone line (Public Switched Telephone Network).</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
<td>Selects Private Branch Exchange, the type of phone line used in office environments where an access code such as 9 must be used to call an outside line.</td>
</tr>
<tr>
<td>Header</td>
<td>Fax Header</td>
<td>Select to enter the header information and your phone number for inclusion on outgoing faxes.</td>
</tr>
<tr>
<td></td>
<td>Your Phone Number</td>
<td></td>
</tr>
<tr>
<td>Receive Mode</td>
<td>Manual</td>
<td>Lets you confirm whether an incoming fax should be printed; a telephone must be connected to the product</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>Automatically receives and prints faxes.</td>
</tr>
<tr>
<td>Distinctive Ring</td>
<td>All</td>
<td>If you are using a Distinctive Ring Service on your phone line, your telephone company can assign two or more phone numbers to the same line and assign different ring patterns to each. If you use this service, select the number of rings for your fax number so your product can receive faxes on the correct number of rings. Select All for phones lines that do not use this service.</td>
</tr>
<tr>
<td></td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triple</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double&amp;Triple</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rings to Answer</td>
<td>1 to 9</td>
<td>Sets the number of rings before your product receives a fax. If Receive Mode is set to <strong>Auto</strong> and an answering machine is connected to the product, make sure this setting is set higher than the number of rings your answering machine is set to answer a call.</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>Off</td>
<td>Lets you start receiving faxes using your phone instead of operating the product (if the Receive Mode is set to <strong>Auto</strong>). When you select <strong>On</strong>, you must also set a <strong>Start Code</strong>. If you are using a cordless handset with its base connected to the product, you can start receiving the fax by entering the code using the handset.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Start Code</strong></td>
<td></td>
</tr>
<tr>
<td>Rejection Fax</td>
<td>Various</td>
<td>Lets you automatically reject faxes from blocked numbers, with blank headers, or from unrecognized contacts.</td>
</tr>
<tr>
<td>Receiving Paper Size</td>
<td>Various</td>
<td>Selects the paper size for incoming faxes.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Related tasks

- Selecting the Date and Time
- Starting a Scan Using the Product Control Panel

Related topics

- Setting Up Contacts and Contact Groups

Security Settings - Fax

Set the security options you want to use for fax data.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Dialing</td>
<td>Off</td>
<td>Does not restrict dialed fax numbers.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>On</td>
<td>Allows faxing only to numbers stored in the contacts list or history.</td>
</tr>
<tr>
<td></td>
<td><strong>Enter Twice</strong></td>
<td>Requires you to enter fax numbers twice to prevent errors.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Confirm Address List</td>
<td>Off</td>
<td>Selects whether or not to display a recipient confirmation screen before a fax is sent.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Backup Data Auto Clear</td>
<td>Off</td>
<td>Automatically erases sent or received fax data from your product's memory.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Clear Backup Data</td>
<td>—</td>
<td>Deletes all sent or received fax data remaining in your product's memory; run this function if you are giving away or disposing of your product.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Setting Up the Fax Utility - Windows

You can set up the FAX Utility for Windows for use with your product.

**Note:** Before using the FAX Utility for Windows, make sure you have set up the fax features on your product using the product control panel. Also first confirm that you can send and receive faxes using the control panel.

1. Do one of the following:
   - **Windows 10:** Click and select **EPSON Software**.
   - **Windows 8.x:** Navigate to the **Apps** screen.
   - **Windows (other versions):** Click or **Start > Programs** or **All Programs > EPSON Software**.
2. Select **FAX Utility**.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
You see this window:

4. Click **Select Printer** and follow the on-screen instructions to transfer your product's fax settings to the FAX Utility.

   **Note:** For detailed information, click **Help** or **Open Online Help**.

**Parent topic:** Setting Up Fax Features

**Setting Up Fax Features Using the Fax Utility - Mac**

You can set up your fax header and select your fax settings using the FAX Utility for Mac.
1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select the **FAX** option for your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Double-click **FAX Utility**, if necessary.

   You see this window:

   ![FAX Utility window]

3. Select your **FAX** product in the Printer list.

4. Select **Fax Settings**.

5. Follow the prompts that appear on the screen to enter your fax header information and select your fax settings.

   **Note:** For detailed information, select the FAX Utility ? icon.

**Parent topic:** Setting Up Fax Features

### Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You can also set up contact groups to send a fax message to multiple contacts.

- Setting Up Contacts Using the Product Control Panel
- Importing Contacts Using the Fax Utility - Windows
- Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac
Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.

**Note:** Contacts can be locked by an administrator. If you cannot access or change contacts, contact your administrator for assistance.

Creating a Contact

Editing or Deleting a Contact

Creating a Contact Group

Editing or Deleting a Contact Group

Parent topic: Setting Up Contacts and Contact Groups

Creating a Contact

You can create a list of contacts to save frequently used fax numbers.

**Note:** You can create up to 2,000 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select Fax.
You see a screen like this:

3. Select **Contacts**. Enter the administrator password, if necessary.
You see a screen like this:

4. Press the add contact icon.
5. Select **Add Contact**.
6. Select the number you want to use for the contact you are adding.
   You see a screen like this:

7. Select the **Contact** field, use the displayed keyboard to enter the contact name (up to 30 characters), and press **OK**.
8. Select the **Index Word** field, use the displayed keyboard to enter a word to use when searching for an entry (up to 30 characters), and press **OK**. (This field is optional.)
9. Select the **Fax Number** field, and use the numeric keypad on the LCD screen or the buttons on the product to enter the fax number. You can enter up to 64 characters.
   
   **Note:** If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the **Line Type** setting, enter the # pound sign instead of the code.
10. Set the **Fax Speed**, **Subaddress**, and **Password** settings, if necessary.
11. Select **OK**.
**Parent topic:** Setting Up Contacts Using the Product Control Panel

**Editing or Deleting a Contact**
You can edit or delete any of the contacts on your list.
1. Press the home button, if necessary.
2. Select **Fax**.
   
   You see a screen like this:

   ![Screen showing Fax settings](image)

   - Select **Contacts**. Enter the administrator password, if necessary.
   - Select the **Contacts** icon next to the contact you want to edit or delete.
You see a screen like this:

![Screen with details](image)

5. Do one of the following:
   - To delete the contact, select **Delete** and select **Yes** on the confirmation screen.
   - To edit the contact, select **Edit**, select the item you want to change, enter the correct information, and select **OK**. When you are finished editing, select **OK**.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

### Creating a Contact Group

You can create a group of contacts so that you can easily send faxes to multiple recipients.

**Note:** You can create up to 2,000 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select **Fax**.
You see a screen like this:

3. Select **Contacts**. Enter the administrator password, if necessary.

4. Press the **add contact icon**.

5. Select **Add Group**.

6. Select the number you want to use for the group you are adding.
You see a screen like this:

![Add Group Screen](image)

7. Select the **Group Name** field, use the displayed keyboard to enter the group name (up to 30 characters), and press **OK**.

8. Select the **Index Word** field, use the displayed keyboard to enter a word to use when searching for a group (up to 30 characters), and press **OK**. (This field is optional.)

9. Select **Contact(s) Added to the Group**.
   
   You see your contacts list.
   
10. Select the number next to each contact you want to include in your group.
    
    A check mark appears next to each selected contact.
    
11. Select **OK**.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

**Editing or Deleting a Contact Group**

You can edit an existing contact group to add or delete entries. You can also delete the entire contact group.

1. Press the home button, if necessary.
2. Select Fax.
3. Select **Contacts**. Enter the administrator password, if necessary.

4. Select the icon next to the group you want to edit or delete. You see a screen like this:
Note: If you want to delete the entire group, select Delete.

5. To edit the group, select Edit.
6. Select Contact(s) Added to the Group.
   You see a list of the contacts in your group.
7. To add or delete a contact, select the number next to it.
8. Select OK.

Parent topic: Setting Up Contacts Using the Product Control Panel

Importing Contacts Using the Fax Utility - Windows

You can edit contacts stored in your product and import contacts from your Windows Address Book to the PC-FAX Phone Book in the FAX Utility for Windows.

1. Do one of the following:
   - Windows 10: Click and select EPSON Software.
   - Windows 8.x: Navigate to the Apps screen.
   - Windows (other versions): Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
4. To edit the contacts list on your product, click Contacts.
5. Do one of the following:
   • To edit a contact, select it in the list and click the icon.
   • To delete a contact, select it in the list and click the icon.
6. To import fax numbers from your Windows Address Book into the FAX Utility PC-FAX Phone Book, select Edit PC-FAX Phone Book.
You see this window:

![Windows Address Book window]

7. Select File > Import From Windows Address Book.
8. Select the contacts you want to import and click OK.

**Note:** For detailed information, select Help or Open Online Help.

**Parent topic:** Setting Up Contacts and Contact Groups

**Related topics**
Setting Up Contacts and Contact Groups

**Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac**

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

**Note:** You can create up to 60 speed dial and group dial entries combined.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select the FAX option for your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
2. Double-click FAX Utility, if necessary.
You see this window:

You see this window:

3. Select your **FAX** product in the Printer list.
4. Select **Speed Dial/Group Dial List**.

You see this window:
5. To add an entry, double-click an empty entry.

   **Note:** To edit an entry, select it and change the information. To delete an entry, select it and press the **Delete** key on your keyboard.

6. Do one of the following:
   - To create a speed dial entry, select **Speed Dial**, enter a name and fax number, and click **OK**.
   - To create a group dial entry, select **Group Dial**, enter a name, select your desired fax numbers, and click **OK**.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the **`Icon`** icon.

9. When you are finished, click the **`Icon`** icon to save the entries to your product's memory.

**Parent topic:** Setting Up Contacts and Contact Groups

**Related topics**

Setting Up Contacts and Contact Groups

---

**Sending Faxes**

See these sections to send faxes using your product.

- Sending Faxes from the Product Control Panel
- Sending Faxes Using the Fax Utility - Windows
- Sending Faxes Using the Fax Utility - Mac

**Parent topic:** Faxing

---

**Sending Faxes from the Product Control Panel**

See these sections to send faxes using the product's control panel.

- Sending a Fax Using the Keypad, Contact List, or History
- Fax Sending Options
- Sending a Fax at a Specified Time
- Sending a Fax on Demand
- Sending a Stored Fax
- Dialing Fax Numbers from a Connected Telephone
Parent topic: Sending Faxes

Sending a Fax Using the Keypad, Contact List, or History

You can send a fax from your product control panel by entering the fax number, or selecting the number from either the contact list or fax history.

**Note:** You can send a black-and-white fax to up to 200 recipients at a time, or send a color fax to one recipient at a time. If your recipient’s fax machine does not print in color, your fax is automatically sent in black-and-white.

**Note:** The product can queue up to 50 black-and-white fax jobs. You can check or cancel fax jobs in the queue using the Status Menu.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.

You see a screen like this:

![Fax Settings Screen]

**Note:** To fax a double-sided document, place your document in the ADF and turn on the ADF 2-Sided setting. (You cannot fax double-sided documents in color.)
4. Do one of the following to select fax recipients:
   • Select Keypad and enter a fax number. Press OK when done. To add another fax number, repeat the same steps. You can also use the numeric keypad on the control panel to enter a fax number.

   **Note:** If direct dialing has been restricted, you can only select the number from the contact list or fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the **Line Type** setting, enter the # pound sign instead of the code. If your fax number requires a brief pause, select the icon to insert a pause symbol (–).

   • Select Contacts to display the contact list. Select the checkbox next to one or more contact (select the checkbox again to deselect it). You can also select the **Search for Contacts** field to search for recipients by name, index name, or entry number. Select **Close** when you are finished.

   • Select Recent to display the sent fax history. Select a recipient from the list and select **Menu**.

   **Note:** To delete entered recipients, select the **Enter Recipient** field, select the recipient you want to delete, and select **Remove**.

5. If you need to change any fax settings, select **Fax Settings** and select your settings.

6. If you want to preview your fax in black-and-white on the LCD, press the **icon.** (If the preview looks incorrect, select **Cancel**, reposition the document or change the fax settings, and repeat this step.)

   **Note:** If you do not touch the preview screen for 20 seconds, your product sends the fax automatically. You cannot preview images when the Direct Send setting is turned on.

7. If you want to save your fax settings for later use, select **Presets** and add a new entry.

8. Press the **Send** icon.

   **Note:** To cancel faxing, press the stop button. You can also cancel the job or check the job status from the Status Menu.

   Your product scans your original and prompts you to place additional pages, if necessary.

After scanning your originals, your product dials the number and sends the fax.
Note: Your product does not save sent color faxes to its memory. If the Save Failure Data option is enabled, faxes that failed to be sent are stored to the product’s memory and you can resend them from the Status Menu screen.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related tasks
Using Presets
Selecting the Line Type

Related topics
Placing Originals on the Product
Setting Up Contacts and Contact Groups

Fax Sending Options
While sending a fax, you can select Fax Settings and select these options.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Size (Glass)</td>
<td>Half Letter</td>
<td>Sets the size for a document placed on the scanner glass</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11x17in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td></td>
</tr>
<tr>
<td>Original Type</td>
<td>Text</td>
<td>Specifies the document type of your originals and adjusts the quality of your copies</td>
</tr>
<tr>
<td></td>
<td>Text &amp; Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Text &amp; Image(Best)</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color</td>
<td>Select whether to scan images in color or black and white</td>
</tr>
<tr>
<td></td>
<td>B&amp;W</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard</td>
<td>Adjusts the scan resolution and print quality of outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Super Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ultra Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>Auto</td>
<td>Automatically adjusts the darkness of outgoing faxes. Select this option when sending black-and-white text documents.</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
<td>Lets you select from various density levels</td>
</tr>
<tr>
<td>Remove Background</td>
<td>Auto</td>
<td>Automatically removes any background color on scanned images</td>
</tr>
<tr>
<td></td>
<td>Varying levels available</td>
<td>Lets you select from various levels of background color adjustment</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Varying levels available</td>
<td>Lets you adjust the sharpness level of outgoing faxes</td>
</tr>
<tr>
<td>ADF 2-Sided</td>
<td>Off</td>
<td>Select On to enable 2-sided faxing from the ADF. The Direct Send option and color faxing are disabled when you turn on this setting.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Continuous Scan (ADF)</td>
<td>Off</td>
<td>Select On to have the product to ask if you want to scan another page after a document in the ADF has finished scanning</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Direct Send</td>
<td>Off</td>
<td>Select On to send black-and-white faxes to a single recipient as soon as the connection is made, without saving the scanned image to memory. You cannot use this setting when sending a color fax or sending a fax to multiple recipients.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Priority Send</td>
<td>Off</td>
<td>Select On to send the current fax before other faxes waiting to be sent</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Send Fax Later</td>
<td>Off</td>
<td>Select On to send the current fax at a selected time</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Sender Information</td>
<td>Off</td>
<td>Lets you include a header, your phone number, or a destination list in the</td>
</tr>
<tr>
<td></td>
<td>Outside of</td>
<td>selected location on your outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Inside of Image</td>
<td></td>
</tr>
<tr>
<td>Notify Send result</td>
<td>Off</td>
<td>Sends a notification to the selected email address when an outgoing fax is</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>sent</td>
</tr>
<tr>
<td>Transmission Report</td>
<td>Print on Error</td>
<td>Lets you select when to print transmission reports</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do Not Print</td>
<td></td>
</tr>
<tr>
<td>Backup</td>
<td>Off</td>
<td>Saves a copy of the scanned fax to the selected email address or network</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>folder/FTP location</td>
</tr>
</tbody>
</table>

Parent topic: Sending Faxes from the Product Control Panel

Sending a Fax at a Specified Time

You can send a fax at a time of your choice.

**Note:** Make sure the product's date and time settings are correct. You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select **Fax**.
You see a screen like this:

4. Enter a fax number or select a number from the Contacts or Recent lists.
5. Select Fax Settings.
6. Select Send Fax Later.
7. Select On.
8. Select Time, use the displayed keypad on the LCD screen to enter your desired time, and select OK.
9. Press the Send icon.

Note: To cancel faxing, press the stop button.

After scanning your originals, your product dials the number and sends the fax at the specified time.

Note: If the product is turned off at the specified time, the fax is sent when it is powered on.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
You can store one scanned document (up to 100 black-and-white pages) and have it sent automatically when another fax machine requests it. Other fax users can receive the document by calling your fax number and using the polling receive function on their fax machines.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax Box.
4. Select Polling Send/Board.
5. Select Polling Send.
6. Select your settings, if necessary.
7. Select Add Document.
8. Press the Store icon.

Your document is scanned and stored until you overwrite or delete it.

You can store only one document at a time. Subsequent documents overwrite the existing document.
You can also delete a stored document from the Status Menu.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Stored Fax

You can store one black-and-white scanned document (up to 100 pages) and send it whenever necessary.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.
   You see a screen that looks like this:

![Fax interface screenshot]

4. Select the icon.
5. Select Extended Fax.
6. Select Store Fax Data and select On.
7. Select any other fax settings as necessary.
8. Select the Store icon.
   Your document is scanned, stored, and briefly previewed.
9. When you are ready to send the document, press the home button, if necessary, and select Fax Box.
10. Select Stored Documents.
11. Select the stored fax job you want to send.
12. Select the Send icon.
   You can store only one document at a time. Subsequent documents overwrite the existing document.
Dialing Fax Numbers from a Connected Telephone

If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax number from the connected telephone. If the recipient's phone number and fax number are the same, you can speak to the recipient before sending the fax.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Dial the fax number from the connected telephone. Speak to the recipient if necessary.

   **Note:** If you are using a pre-paid calling card, enter the number and password required to use the card before entering the destination fax number.

4. Select Fax on the LCD screen.
5. Select Fax Settings and select any settings as necessary.

   **Note:** Your product now communicates with the recipient's fax machine. Do not hang up the telephone.

6. When you hear a fax tone, press Send icon to start sending the fax.

   **Note:** If your recipient's fax machine does not print in color, your fax is automatically sent in black-and-white.

7. Hang up the telephone.
Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax and select the print command.

You see a window like this:

2. Select your product with the FAX option as the printer.

3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the Preferences or Properties button.

   Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen. For more information about selecting fax print settings, click Help.

4. Select the Page Range as necessary. (Leave the Number of copies set to 1.)

5. Click Print or OK.
If you’re faxing for the first time, you see a window like this one:

![Sender Information Window]

6. Enter your sender information so that recipients can identify the origin of the fax. Then click **OK** to save the sender information.
You see a window like this:

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.

   **Note:** For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.

9. Click Send to transmit your fax.

**Parent topic:** Sending Faxes

### Sending Faxes Using the Fax Utility - Mac

You can send a fax from a Mac printing program using the FAX Utility. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

![Printer settings](image)

3. Select your product **FAX** option as the **Printer** setting.

4. If necessary, click the arrow next to the Printer setting or the **Show Details** button to expand the print window.

5. Select the number of pages you are faxing as the **Pages** setting.

   **Note:** Leave the **Copies** setting set to 1.

6. Select **Recipient Settings** from the pop-up menu.
You see this window:

7. Do one of the following to choose your recipient:
   • Select a name or group from the **Recipient List**.
   • Enter a name, company, and fax number and click the + button.
   • Click the icon and select a recipient from your address book.

8. Select **Fax Settings** from the pop-up menu.
You see this window:

9. Select the **Color** and **Image Quality** settings you want to use for your fax.
10. Click **Fax**.

**Parent topic:** Sending Faxes

### Receiving Faxes

See these sections to receive faxes with your product.

- Fax Reception
- Receiving Faxes Automatically
- Receiving Faxes Manually
- Forwarding Received Faxes
- Receiving a Fax by Polling
- Viewing a Fax on the LCD Screen (Using the Fax Box)
- Selecting Received Fax Options Using the Fax Utility - Windows

**Parent topic:** Faxing

### Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to **Auto**.
If you connected a telephone to your product so you can use the same phone line for faxes and voice calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.

**Note:** If you run out of paper during fax printing, load more paper and press the button indicated on your product’s LCD screen to continue.

**Parent topic:** Receiving Faxes

### Receiving Faxes Automatically

To receive faxes automatically, make sure Receive Mode is set to **Auto** (the default setting for the product).

To change the Receive Mode if necessary, select **Settings > General Settings > Fax Settings > Basic Settings > Receive Mode**.

If an answering machine is connected, make sure the product’s **Rings to Answer** setting is set higher than the number of rings your answering machine is set to answer a call. For example, if the answering machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

**Parent topic:** Receiving Faxes

**Related references**

Basic Settings - Fax

**Related tasks**

Receiving Faxes Manually

### Receiving Faxes Manually

You can set up your product to receive faxes manually by setting the Receive Mode to **Manual**. This lets you check for a fax tone on the connected telephone before receiving a fax.

1. To change the Receive Mode, select **Settings > General Settings > Fax Settings > Basic Settings > Receive Mode** and select **Manual**.
2. When the connected telephone rings, answer the call.
3. If you hear a fax tone, select **Fax** on the LCD display.
4. Select **Send/Receive**.
5. Select **Receive**.
6. Press the **Receive** icon to start receiving the fax.
7. Hang up the telephone.

**Parent topic:** Receiving Faxes

**Related references**

- Basic Settings - Fax

**Related tasks**

- Receiving Faxes Automatically

### Forwarding Received Faxes

You can forward received faxes to another fax machine, or convert the faxes into PDF documents and forward them to a shared folder on the network or to an email address. Forwarded faxes are deleted from the product's memory. Before using this feature, make sure the date and time are set correctly, the forwarding destination is set up in the contact list, and the email server settings are configured.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

![General Settings menu](image)

4. Scroll down and select **Fax Settings**.
5. Select **Receive Settings**.
6. Select **Save/Forward Settings**.
7. Select **Unconditional Save/Forward**.
8. Select **Forward**.
9. Select **Yes**.

   **Note**: If you want to print the fax automatically before forwarding it, select **Yes and Print**.

10. Select **Add Entry** and select the forwarding destinations from the contacts list.
11. When you are finished selecting your forwarding destinations, select **Close**.
12. Confirm the displayed forwarding destinations and select **Close**.
13. Select **Options When Forwarding Failed**.
14. Select whether you want to print the faxes or save them in the printer’s inbox if forwarding received faxes fails.

**Parent topic**: Receiving Faxes

### Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

**Note**: You cannot use polling to receive a fax from a fax information service that uses audio guidance.

1. Press the \( \uparrow \) home button, if necessary.
2. Select **Fax**.
You see a screen like this:

![Image of a fax screen]

3. Press the icon.
4. Select Extended Fax.
5. Set Polling Receive to On.
7. Select Close.
8. Enter the fax number you expect to receive the fax from.
9. Press the Polling icon to start receiving the fax.

Parent topic: Receiving Faxes

Viewing a Fax on the LCD Screen (Using the Fax Box)

You can save received faxes in your product's memory and view them on the LCD screen.

Note: The Inbox can be locked by an administrator. If you cannot access the Inbox, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

![General Settings Menu](image)

4. Scroll down and select **Fax Settings**.
5. Select **Receive Settings**.
6. Select **Save/Forward Settings**.
7. Select **Unconditional Save/Forward**.
8. Set **Save to Inbox** to **On**.
9. Press the home button.
10. Select **Fax Box**.
11. Do one of the following:
    - Select **Inbox/Confidential Box** to view received documents.
    - Select **Stored Documents Box** to view saved documents that have not been sent when **Store Fax Data** is set to **On**.
    - Select **Polling Send Box** to view documents that are stored for fax polling.
12. Select the fax you want to view.
    You see the fax displayed on the screen.
13. Press the icon.
14. Select one of the printing or deleting options, and follow the on-screen instructions.

**Note:** Delete faxes after you print or view them to prevent the product's memory from filling up. When the memory is full, you can only forward or print incoming faxes.

Parent topic: Receiving Faxes

Selecting Received Fax Options Using the Fax Utility - Windows

You can select options for use with received faxes using the FAX Utility for Windows.

1. Do one of the following:
   - **Windows 10:** Click and select EPSON Software.
   - **Windows 8.x:** Navigate to the Apps screen.
   - **Windows (other versions):** Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
You see this window:

4. To save faxes received by your product on your computer, select **Save received faxes on this computer**.
5. Select the destination folder and other options, and click **OK**. You return to the FAX Utility window.
6. To receive notifications when received faxes arrive in the selected destination folder on your computer, select **Notify me if new faxes exist in forwarding folders**.
7. Select how often you want to be notified of received faxes and click OK.

   **Note:** For detailed information, click Help or Open Online Help.

**Parent topic:** Receiving Faxes

**Checking Fax Status**

You can check the status of current fax jobs, or faxes that have been received or sent on the product control panel.

1. Press the **Job/Status** button.
   
   You see a screen like this:

   ![Job Status Screen](image)

2. Do one of the following:
   
   - To check the status of current fax jobs, select the fax job you want to check.
   - To check the history of faxes that have been sent, received, or saved, select **Log** and select the job you want to check.

   **Note:** If you see a numbered icon above the icon on your product's LCD screen or the **Received Fax** light is flashing, received faxes have been temporarily saved to the product's memory.
Printing Fax Reports

You can print several types of fax reports whenever necessary. You can also print the fax log printed automatically by turning on Fax Log Auto Print.

1. Press the home button, if necessary.
2. Select Fax.
   
   You see a screen like this:

![Fax Settings Screen](image)

3. Press the icon.
5. Select the fax report you want to print.

Fax Report Options

Select the fax report or list you want to print.
Last Transmission
Print a report on the previous fax that was sent or received through polling.

Fax Log
View or print a report on recent fax transmissions.

Stored Fax Documents
Print a list of the fax jobs currently stored in the product's memory.

Fax Settings List
Print a list of the current fax communication settings.

Conditional Save/Forward List
Print a list of the current conditional save/forward settings.

Protocol Trace
Print a detailed report for the previous sent or received fax.

Parent topic: Printing Fax Reports
Using External USB Devices with Your Product

Follow the instructions here to work with an external USB device connected to your product.

Connecting a USB Device

Disconnecting a USB Device

Viewing and Printing from the LCD Screen

Transferring Files on a USB Device

Connecting a USB Device

Connect a USB device or its USB cable to the USB port on the front of the product.

Note: Epson cannot guarantee the compatibility of your device. Make sure the files on the device are compatible with the product.

USB Device Photo File Specifications

Parent topic: Using External USB Devices with Your Product

Related tasks

Disconnecting a USB Device

USB Device Photo File Specifications

You can use USB devices with your product containing files that meet these specifications.

| File format | JPEG with the DCF (Design Rule for Camera File system) version 1.0 or 2.0 standard*
|             | TIFF 6.0-compliant uncompressed images: RGB full-color or binary (not CCITT-encoded) |
| Image size  | 80 × 80 pixels to 10200 × 10200 pixels |
| File size   | Up to 2GB |
| Number of files | JPEG: Up to 9990
|               | TIFF: Up to 999
|               | PDF: Up to 999 |
Files stored on digital cameras with built-in memory are not supported.

Parent topic: Connecting a USB Device

### Disconnecting a USB Device

After you finish working with a USB device, follow these steps to remove it.

1. If your product is connected to your computer using a USB cable, do one of the following:
   - **Windows**: Open the My Computer, Computer, This PC, or Windows Explorer utility. Then right-click the name of your USB device (listed as a removable disk) and select **Eject**.
   - **Mac**: Drag the removable disk icon for your USB device from the desktop into the trash.

   **Caution**: Do not remove a USB device before completing the procedure above or you may lose data from the flash drive.

2. Pull the USB device or cable out of the USB port on the front of the product.

Parent topic: Using External USB Devices with Your Product

### Viewing and Printing from the LCD Screen

See these sections to view and print photos or other files displayed on your product's LCD screen.

- Printing JPEG Photos
- Printing TIFF and PDF Files
- Print Setting Options - Device Mode

Parent topic: Using External USB Devices with Your Product

### Printing JPEG Photos

You can select JPEG photos for printing as you view them on the LCD screen.

1. Press the home button, if necessary.
2. Select **Memory Device**.
3. Select **JPEG**.

   **Note**: If you have more than 999 JPEG images on your device, the images are divided into groups, and you must first select the group you want to display.
4. Do one of the following to select your photos:
   • In Tile View, select the thumbnail images of the photos you want to print.
   • In Single View, select the thumbnail image of the photo you want to print, then press the left or right arrow buttons to scroll through and select additional photos, or select Tile View to return to the thumbnail image view and select additional photos.
   • To select all photos, select the menu icon and select Select All Images.

5. Select Proceed to Print.

6. To change the print settings, select Basic Settings and select the necessary settings.

7. To adjust the photos (adjustments modify only your printed copies, not the original files), select Advanced and make the necessary adjustments.

8. Use the numeric keypad on the control panel or select Copies on the LCD screen and use the numeric keypad on the screen to select the number of copies (up to 99).

9. When you are ready to print, select the Print icon.

   Note: To cancel printing, press the stop button or select Cancel on the LCD screen, then select Cancel again to confirm.

Parent topic: Viewing and Printing from the LCD Screen
Related references
Print Setting Options - Device Mode

**Printing TIFF and PDF Files**

You can select and print TIFF or PDF files from a USB flash drive.

1. Press the home button, if necessary.

2. Select Memory Device.

3. Select TIFF or PDF.
   You see a list of the available files.

4. Select the file you want to print.
   You see information about the file.
5. Do the following as necessary:
   • To print more than one copy, use the numeric keypad on the control panel or select Copies on the LCD screen and use the numeric keypad on the screen to select the number of copies (up to 99).
   • To change the print settings, select Basic Settings or Advanced and select the necessary settings.

6. When you are ready to print, select the Print icon.

   \textbf{Note:} To cancel printing, press the \textbullet\ stop button or select Cancel on the LCD screen, then select Cancel again to confirm.

\textbf{Parent topic: Viewing and Printing from the LCD Screen}

\textbf{Related references}

Print Setting Options - Device Mode

\textbf{Print Setting Options - Device Mode}

Select the print settings you want to use when printing from a USB device.

\textbf{Note:} Not all options or settings may be available, depending on the file format.

\textbf{Basic Settings}

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setting</td>
<td>Various paper size and type settings</td>
<td>Indicates the source that contains the paper size and type you want to print on</td>
</tr>
<tr>
<td>Color Mode</td>
<td>B&amp;W</td>
<td>Prints the photo in black and white</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Prints the photo in color</td>
</tr>
</tbody>
</table>

\textbf{Advanced settings}

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>1-up</td>
<td>Print one photo per page</td>
</tr>
<tr>
<td></td>
<td>20-up</td>
<td>Print 20 photos per page</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>Print numbered photo thumbnails with date information</td>
</tr>
<tr>
<td>Print settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Paper Source</td>
<td>Various paper size and type settings</td>
<td>Indicates the source that contains the paper size and type you want to print on</td>
</tr>
<tr>
<td>Fit Frame</td>
<td>On</td>
<td>Automatically crops the photo to fit into the selected photo layout</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic cropping</td>
</tr>
<tr>
<td>Quality</td>
<td>Standard</td>
<td>Provides good quality for most prints</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>Provides the highest quality for special prints</td>
</tr>
<tr>
<td>Date</td>
<td>Various date formats</td>
<td>Prints the date the photo was taken on the photo in the format you select</td>
</tr>
<tr>
<td>Fix Photo</td>
<td>Automatic</td>
<td>Optimizes the Fix Photo adjustments for specific types of photos; select the option that best matches your photo content</td>
</tr>
<tr>
<td></td>
<td>People</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Night Scene</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enhance Off</td>
<td></td>
</tr>
<tr>
<td>Fix Red-Eye</td>
<td>On</td>
<td>Automatically fixes the red-eye effect in photos</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>2-Sided</td>
<td>On</td>
<td>Select On to print a document double sided. You can also select the Binding Margin.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Order</td>
<td>—</td>
<td>Select the printing order for multi-page documents.</td>
</tr>
</tbody>
</table>

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

**Parent topic:** Viewing and Printing from the LCD Screen

**Transferring Files on a USB Device**

You can transfer files to and from a USB device inserted into the USB port on the front of your product.  

[Setting Up File Sharing for File Transfers from Your Computer]
Transferring Files from a USB Device to Your Computer
Parent topic: Using External USB Devices with Your Product

Setting Up File Sharing for File Transfers from Your Computer

Before you transfer files from a computer to a USB device inserted into the USB port on the front of your product, you may need to set up your product's file sharing settings.

Caution: Remove the USB device before you change this setting or you may lose data from the device.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Printer Settings.
5. Select Memory Device Interface.

You see a screen like this:
You see a screen like this:

![Memory Device Interface](image)

6. Make sure Memory Device is set to Enable.
7. Select File Sharing.
8. Select the way your computer is connected to the product: either USB or Network.

Parent topic: Transferring Files on a USB Device

Related tasks
Disconnecting a USB Device

Transferring Files from a USB Device to Your Computer

You can transfer files to and from a USB device inserted into the USB port on the front of your product and a computer connected to your product.

Note: Do not transfer files to and from a USB device while you are printing from the device.

1. Make sure your product is connected to a computer.
2. Insert a USB device or its USB cable into the USB port on the front of your product.
3. Do one of the following to access your USB device files from your computer:
   - **Windows**: Open the My Computer, Computer, This PC, or Windows Explorer utility, then select the removable disk icon.
• **Mac with a USB connection**: Look for the removable disk icon on your desktop, then select it.

• **Mac with a network connection**: Select the hard drive icon on your desktop or select **Computer** from the **Go** menu, select your product in the **SHARED** section of the sidebar (you may need to widen the sidebar to see the name), and select the **USBSTORAGE** icon.

4. Select the folder that contains your files.

5. Drag the files you want to transfer to the desired folder on your computer or on your USB device.

**Note**: Your product's LCD screen does not update to display new information about your USB device after you copy files to it or delete files from it. Remove and insert the USB device to update the information.

**Parent topic**: Transferring Files on a USB Device

**Related tasks**

Connecting a USB Device
Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

When ink is expended, or the maintenance box and cassette rollers are at the end of their service life, you need to replace them. The maintenance box stores ink that gets flushed from the system during print head cleaning.

**Note:** Please dispose of your used Epson branded ink packs and maintenance boxes responsibly and in accordance with local requirements. If you would like to return your used ink packs and maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

**Check Ink and Maintenance Box Status**

- Purchase Epson Ink Packs and Maintenance Boxes
- Removing and Installing Ink Packs
- Printing with Black Ink and Expended Color Ink Packs
- Conserving Low Black Ink with Windows
- Replacing the Maintenance Box
- Replacing the Rollers for Paper Cassette 1
- Replacing the Rollers for Paper Cassettes 2 to 4
- Resetting the Roller Counter on the LCD Screen

**Check Ink and Maintenance Box Status**

Your product and its software will let you know when ink is low or expended, or when the maintenance box needs to be replaced.

**Note:** When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product, you can check ink and maintenance box status by using the product buttons or the utilities included with the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

**Checking Ink Status on the LCD Screen**

**Parent topic:** Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers
Checking Ink Status on the LCD Screen

When one of your ink packs is low or expended, you see a message on the LCD screen. Tap How To and follow the steps on the LCD screen to replace the ink pack.

You can also check the status of the ink packs and maintenance box from the product control panel.

1. Press the home button, if necessary.
2. Select the icon.
   You see a screen like this:

   ![Image of LCD screen showing ink and maintenance box levels](image)

   The ink and maintenance box levels are displayed at the bottom of the screen.

   **Note:** The displayed ink and maintenance box levels are approximate.

3. For more information, select the ink images at the bottom of the screen.

**Parent topic:** Check Ink and Maintenance Box Status

**Related tasks**

Removing and Installing Ink Packs
Replacing the Maintenance Box
Checking Ink and Maintenance Box Status - Windows

A low ink reminder appears if you try to print when ink is low. You can also check your ink or maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop and double-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Then click Details. You see this window:
2. Replace or reinstall the maintenance box or ink pack as indicated on the screen.

   **Note:** If any of the ink packs installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

3. To disable promotional offers, right-click the product icon in the Windows taskbar and select **Monitoring Preferences**.

   You see this window:
4. Deselect the **Display Epson Offers** checkbox.

**Parent topic:** Check Ink and Maintenance Box Status

**Related tasks**
- Removing and Installing Ink Packs
- Replacing the Maintenance Box

### Checking Ink and Maintenance Box Status - Mac

You can check the status of your ink and maintenance box using a utility on your Mac.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Select **EPSON Status Monitor**.

You see this window:
3. Do the following as necessary:
   • You can update the ink and maintenance box status by clicking Update.
   • Replace or reinstall the maintenance box or an ink pack as indicated on the screen.

   Note: If an ink pack installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

Parent topic: Check Ink and Maintenance Box Status
Related tasks
Removing and Installing Ink Packs
Replacing the Maintenance Box

Purchase Epson Ink Packs and Maintenance Boxes

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Note: This printer is designed for use with Epson ink packs only, not third-party ink packs or ink. Other brands of ink supplies are not compatible and, if described as compatible, may not function properly or continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank cartridge-free printers.

The included initial ink packs are designed for reliable printer setup and cannot be used as replacement ink packs or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All ink packs must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced ink packs.

Ink Supply Unit (Ink Pack) Part Numbers

Parent topic: Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

Ink Supply Unit (Ink Pack) Part Numbers

Use these part numbers when you order or purchase new ink packs.

Maintenance box part number: T6714
<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
<th>Extra High-capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T973</td>
<td>T974</td>
</tr>
<tr>
<td>Cyan</td>
<td>T973</td>
<td>T974</td>
</tr>
<tr>
<td>Magenta</td>
<td>T973</td>
<td>T974</td>
</tr>
<tr>
<td>Yellow</td>
<td>T973</td>
<td>T974</td>
</tr>
</tbody>
</table>

**Parent topic:** Purchase Epson Ink Packs and Maintenance Boxes

**Removing and Installing Ink Packs**

Make sure you have your replacement ink packs handy before you begin. You must install new ink packs immediately after removing the old ones.

1. If an ink pack is low or expended, a message appears on your product and on your computer screen. Note which ink packs need to be replaced.
2. Open the ink case.

![Ink case open](image)

**Note:** The illustrations in this section show the black ink pack, but the procedure is the same for the color ink packs on the other side of the product.
3. Press the handle on the ink pack you are replacing.

The ink pack pops out.

4. Lift up the ink pack and remove it from the ink case.

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink packs out of the reach of children.
5. Unpack the new ink pack

6. Remove any protective materials, and do not touch the green chip on the handle area.

7. Shake the ink pack horizontally 20 times as shown.

**Caution:** Do not remove any labels or seals, or ink will leak.
8. Place the ink pack in the case. Make sure the bottom of the ink pack fits over the base as shown.

9. Place the ink pack handle on the holder as shown.

10. Press in the handle until it clicks into place.
11. Select **Check** on the LCD screen to make sure the ink packs are installed correctly.

12. When you are finished, close the ink case.

**Parent topic:** Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

**Related concepts**

Purchase Epson Ink Packs and Maintenance Boxes

**Printing with Black Ink and Expended Color Ink Packs**

When a color ink pack is expended, you can temporarily continue printing from your computer using black ink. Replace the expended color ink pack as soon as possible for future printing.

**Note:** You cannot print with expended color ink using your product's control panel.

**Printing with Expended Color Ink Packs - Windows**

**Parent topic:** Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

**Printing with Expended Color Ink Packs - Windows**

If you see a message during printing telling you that you can temporarily print in black ink with an expended color ink supply unit, you can cancel your print job and select settings to print on plain paper or on an envelope.

**Note:** To use this feature, Epson Status Monitor must be enabled.

1. Click **Cancel** or **Cancel Print** to cancel your print job.

   **Note:** If the message screen appears on another computer on a network, you may need to cancel the print job using the product control panel.
2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the **Main** tab.
5. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
6. Select the **Black/Grayscale** or **Grayscale** checkbox.
7. Click **OK**.
8. Print your document.
   Epson Status Monitor 3 displays a print message.
9. Click **Print in Black** to print your document.

**Parent topic:** Printing with Black Ink and Expended Color Ink Packs

### Conserving Low Black Ink with Windows

When black ink runs low and there is more color ink, you may see a message telling you that you can print with a mixture of color inks to create composite black.

**Note:** The window appears only when you have selected **Plain Paper/Bright White Paper** as the paper type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor must be enabled.

- Click **Yes** to use a mixture of color inks to create black, or **No** to continue using the remaining black ink for the document you are printing.
- Click **Disable this feature** to continue using the remaining black ink.

**Note:** If you disable this feature, it remains disabled until you replace the black ink pack.

**Parent topic:** Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

### Replacing the Maintenance Box

Make sure you have a new maintenance box before you begin.

**Caution:** Do not reuse a maintenance box that has been removed and left uninstalled for more than a week. Keep the maintenance box away from direct sunlight.

1. Make sure the product is not printing.
2. Remove the new maintenance box from its package.

   **Caution:** Do not touch the green chip on the maintenance box. Do not remove the film on the box, or ink may leak.

3. Open the rear cover 1 (D1).

4. Grasp the maintenance box as shown and pull it out of its holder.

   **Note:** Do not tilt the used maintenance box or take it apart.
Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep the maintenance box out of the reach of children and do not drink the ink.

5. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal the bag and dispose of it carefully.

6. Insert the new maintenance box into the holder and push it all the way in.

7. Close the rear cover 1 (D1).

Parent topic: Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

Related concepts
Purchase Epson Ink Packs and Maintenance Boxes

Replacing the Rollers for Paper Cassette 1

When the rollers in paper cassette 1 need to be replaced, you see a message on the LCD screen. There are three rollers for paper cassette 1, two on the back of the printer and one on the cassette.

Note: Check that the arrows on the rollers point clockwise before installing them in paper cassette 1. There are different rollers for paper cassette 1 and the other paper cassettes.

1. Turn off the product.
2. Unplug the power cord.
3. Remove the replacement rollers from their package.

   **Caution:** Make sure not to damage or dirty the surface of the rollers. If there is any dirt or dust on the rollers, clean them with a soft, moist cloth. Using a dry cloth can damage the surface of the roller.

4. Pull out paper cassette 1.

5. Open rear cover 1 (D1).
6. Pull out rear cover 2 (D2).

7. Remove the roller cover inside the printer.
8. Pull up on the tabs, then slide the rollers to the left to remove them.

9. Insert the replacement rollers and slide them to the right until they click into place.

10. Replace the roller cover and press down on it until it clicks into place.
11. On paper cassette 1, pull up on the lever to release the roller.

12. Slide the roller towards the lever, then pull it out of the cassette.

13. Insert the pointed end of the replacement roller’s shaft into the hole on the cassette and gently slide the roller into the slot with the flat side of the shaft facing towards the front of the cassette.
14. Press down on the lever to lock the roller in place.

15. Insert the paper cassette all the way into the product.
16. Insert rear cover 2 (D2).
17. Close the rear cover 1 (D1).
Reset the maintenance roller counter for paper cassette 1 to keep track of roller usage.

Parent topic: Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

Replacing the Rollers for Paper Cassettes 2 to 4

When the rollers in paper cassettes 2 to 4 need to be replaced, you see a message on the LCD screen. There are three rollers for each paper cassette, two on the back of the printer and one on the cassette.

Note: Check that the arrows on the rollers point counterclockwise before installing them in paper cassettes 2 to 4. There are different rollers for paper cassette 1 and the other paper cassettes.

1. Turn off the product.
2. Unplug the power cord.
3. Remove the replacement rollers from their package.

**Caution:** Make sure not to damage or dirty the surface of the rollers. If there is any dirt or dust on the rollers, clean them with a soft, moist cloth. Using a dry cloth can damage the surface of the roller.

4. Pull out the paper cassette.
5. Open the rear cover (E) that matches with the paper cassette you removed.
6. Use a screwdriver to remove the three screws on the inner cover and remove the cover.

7. Pull down on the tabs, then slide the rollers to the right to remove them.
8. Insert the replacement rollers and slide them to the left until they click into place.

9. On the paper cassette you removed, pull up on the lever to release the roller.

10. Slide the roller towards the lever, then pull it out of the cassette.
11. Insert the pointed end of the replacement roller's shaft into the hole on the cassette and gently slide the roller into the slot with the flat side of the shaft facing towards the front of the cassette.

12. Press down on the lever to lock the roller in place.

13. Insert the paper cassette all the way into the product.
14. Use a screwdriver to secure the inner cover to the printer with the three screws you removed.
15. Close the rear cover (E).

Reset the maintenance roller counter for the paper cassette to keep track of roller usage.

**Parent topic:** Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

---

**Resetting the Roller Counter on the LCD Screen**

You must reset the roller counter after replacing the cassette rollers to clear the roller replacement message and to keep track of roller usage correctly.
1. Press the home button, if necessary.
2. Select Settings.
3. Select Maintenance.
   You see a screen like this:

   ![Maintenance screen]

4. Scroll down and select Maintenance Roller Information
5. Select Reset Maintenance Roller Counter.
6. Select the paper cassette in which you replaced the rollers.
7. Select Yes.
8. Select Yes again to confirm the reset.
9. If you want to feed a sheet of paper to check the roller installation, select Yes. (Otherwise, select No.)
10. Press the home button to exit.

Parent topic: Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

**Note:** When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product, you can clean the print head, adjust the print quality, and run a nozzle check by using the product buttons or the utilities included with the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

If running these utilities does not solve the problem, you may need to replace the ink packs.

- Print Head Maintenance
- Print Quality Adjustment
- Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

**Note:** You cannot clean the print head if ink is expended, and may not be able to clean it when ink is low. You must replace the ink pack first.

- Print Head Nozzle Check
- Print Head Cleaning

**Parent topic:** Adjusting Print Quality

**Related topics**

- Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers
Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.
   You see a screen like this:

6. Select Print Head Nozzle Check.
You see a screen like this:

7. Select **Start**.
   The nozzle pattern prints.
8. Check the printed pattern to see if there are gaps in the lines.
   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]
9. Do one of the following:
   • If there are no gaps, select OK.
   • If there are gaps or the pattern is faint, select NG and continue.

10. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the process as necessary.

   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, one of the ink packs may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Nozzle Check

**Related concepts**

Print Head Cleaning

**Related topics**

Loading Paper

**Checking the Nozzles Using a Computer Utility**

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the product.
2. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   • **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility and select Open Printer Utility**.
3. Select **Nozzle Check**.
You see a window like this:

4. Click **Print**.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**
   ![Print head is clean]

   **Print head needs cleaning**
   ![Print head needs cleaning]

6. If there are no gaps, click **Finish**.
   If there are gaps or the pattern is faint, clean the print head.

   **Parent topic:** Print Head Nozzle Check

   **Related concepts**
   - Print Head Cleaning

   **Related topics**
   - Loading Paper

   **Print Head Cleaning**
   If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

   **Cleaning the Print Head Using the Product Control Panel**
   **Cleaning the Print Head Using a Computer Utility**

   **Parent topic:** Print Head Maintenance

   **Related tasks**
   - Removing and Installing Ink Packs
Cleaning the Print Head Using the Product Control Panel

You can clean the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select **Settings**.
5. Select **Maintenance**.
   
   You see a screen like this:

   ![Maintenance Screen](image)

6. Select **Head Cleaning**.
You see a screen like this:

![Head Cleaning Screen](image)

7. Select **Start** to clean the print head.
   
   When the cleaning cycle is finished, you see a message on the screen.
   
   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

8. Select **Yes**.

9. Select **Start** to confirm that the print head is clean.

   If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

**Parent topic:** [Print Head Cleaning](#)

**Related topics**

- [Loading Paper](#)
- [Cleaning the Print Head Using a Computer Utility](#)

### Cleaning the Print Head Using a Computer Utility

You can clean the print head using a utility on your Windows or Mac computer.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
   - **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

4. Select **Head Cleaning**.
   You see a window like this:
   ![Head Cleaning window](image)
   - Click **Start** to clean the print head nozzles. Because cleaning consumes some ink, only clean the print head when faint areas or gaps appear in your printout. Use the "Nozzle Check" utility first to confirm that the print head needs to be cleaned.

5. Click **Start** to begin the cleaning cycle.
   The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is finished.
Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.

7. Check the printed pattern to see if there are gaps in the lines.
   
   **Print head is clean**
   
   ![Print Head Clean Pattern]
   
   **Print head needs cleaning**
   
   ![Print Head Clean Pattern]
   
   - If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

Parent topic: Print Head Cleaning

Related topics

Loading Paper

Print Quality Adjustment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to adjust the print quality.

**Note:** Banding may also occur if your print head nozzles need cleaning.
Adjusting the Print Quality Using the Product Control Panel

Adjusting the Quality for Each Paper Type

Parent topic: Adjusting Print Quality

Adjusting the Print Quality Using the Product Control Panel

You can adjust the print quality using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

![Maintenance menu](image)

6. Select Print Quality Adjustment.
7. Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.
8. Check the printed patterns on the alignment sheet and select the following on the LCD screen:
   • For patterns 1 and 2, select the number representing the pattern with the least misaligned vertical line.
   • For patterns 3 and 4, select the number representing the pattern with the least amount of separation or overlap.

9. Select Done.

Parent topic: Print Quality Adjustment

Related topics
Loading Paper

Adjusting the Quality for Each Paper Type
If you still notice dark or light bands in your printouts after adjusting the print quality, you can adjust the quality for each paper type.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select **Settings**.
5. Select **Maintenance**.
   
   You see a screen like this:

![Maintenance screen](image)

6. Scroll down and select **Print Quality Adjustment per Paper**.
7. Select one of the following options:
   - **Print Pattern** to adjust the paper type for your printer
   - **Enter Set Value** to enter paper type alignment information for use on multiple printers of the same model
8. Select a paper type.
9. If you printed a pattern, check the printed patterns on the alignment sheet and select the following on the LCD screen:
   • For patterns 1 and 2, select the number representing the pattern with the least misaligned vertical line.
   • For patterns 3 and 4, select the number representing the pattern with the least amount of separation or overlap.

10. Select Done.

Parent topic: Print Quality Adjustment
Related topics
Loading Paper
Cleaning the Paper Guide

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink. If paper does not feed correctly from the rear paper feed slot, you can use a cleaning sheet to clean the rollers.

1. If printouts are smeared or scuffed, load plain paper in the paper source that you want to clean in this size: A3 (11.7 × 16.5 inches [297 × 420 mm]).
2. Press the home button, if necessary.
3. Select Settings.
4. Select Maintenance.
   You see a screen like this:

6. Select the paper source you want to clean.
7. Follow the on-screen instructions to clean the paper guide.
8. Repeat these steps as necessary until the paper comes out clean. If you are using a cleaning sheet, repeat these steps up to 3 times.

   Note: If the paper is not clean after cleaning several times, try cleaning the other paper sources.
Parent topic: Adjusting Print Quality
Related topics
Loading Paper
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cord.
3. Disconnect any connected cables.
4. Remove all the paper from the product.
5. Clean the scanner glass and the glass area on the left with a soft, lint-free cloth (microfiber is recommended) moistened with a little glass cleaner.

**Caution:** Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.

![Scanner diagram]

**Note:** If lines appear on the printout or in scanned images, carefully clean the scanner glass on the left.
6. Raise the lever and open the ADF cover (F).

7. Use a soft, dry, lint-free cloth (microfiber is recommended) to clean the rollers and the interior of the ADF.
8. Pull out the paper cassette.

9. Use a soft, moist cloth to clean the cassette roller.

   **Caution:** Using a dry cloth can damage the surface of the roller.

10. Insert the paper cassette all the way into the printer.
11. Repeat steps 8 through 10 for any additional paper cassettes.
12. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described here.

**Caution:** During transportation and storage, follow these guidelines:

- Because the product is heavy, two or more people should lift and carry it using the hand position shown:

![Illustration of two people lifting a product](image)

- Avoid tilting the product, positioning it vertically, or turning it upside down; otherwise ink may leak.
- Remove the ink packs before transportation as described here, but leave the maintenance box installed; otherwise ink may leak.

**Note:** Before storing your product for a long period, replace low, expended, or expired ink to help prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Remove all the paper from the product.
3. Unplug the power cable.
4. Disconnect any connected cables.
5. Close the rear paper support and the output tray.
6. Open the ink case.

7. Press the handle on the ink pack.

   The ink pack pops out.

8. Lift up the ink pack and remove it from the ink case.

9. Push in the pop-out section and close the ink case.

10. Follow the previous steps to remove the color ink packs on the other side of the product.

11. Carefully transport the ink packs lying flat, with the ink supply port facing up.

   **Caution:** Do not drop or strike the ink packs; otherwise, ink may leak.
12. Remove the optional cabinet and paper cassettes (if they are installed) before lifting the product.

   **Note:** If the optional cabinet is installed, you can use the casters on the cabinet to roll the product instead of lifting it. Remove the cabinet stands and unlock the casters before moving the product. Do not roll the product over uneven or rough surfaces to avoid harsh impacts to the product.

13. Place the product in its original packing materials, if possible, or use equivalent materials with cushioning around the product. Make sure the box adequately protects the product control panel. Keep the product level during transportation.

Reinstall the ink packs as soon as possible after transportation to prevent the print head from drying out. If print quality has declined when you print again, clean the print head and adjust the print quality.

**Parent topic:** Cleaning and Transporting Your Product

**Related concepts**
- Print Head Cleaning
- Print Quality Adjustment

**Related tasks**
- Removing and Installing Ink Packs
Solving Problems

Check these sections for solutions to problems you may have using your product.

Product Status Messages
Job Status Error Codes
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving PostScript Printing Problems
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Faxing Problems
Solving USB Device Problems
Uninstall Your Product Software
Where to Get Help

Product Status Messages

You can often diagnose problems with your product by checking the messages and status icons on its LCD screen. You can also check for errors by pressing the Job/Status button and selecting Printer Status.

Note: If the screen is dark, press the screen to wake the product from sleep mode.
<table>
<thead>
<tr>
<th>LCD screen message</th>
<th>Condition/solution</th>
</tr>
</thead>
</table>
| Printer error. Turn the power off and on again. For details, see your documentation. | Turn the product off and then back on again. If the error persists, check for and remove any jammed paper or protective materials from the product. If the error still persists, contact Epson for support. If you see any of the following error codes, make sure you have not exceeded the loading capacity for any paper source:  
  • 000181  
  • 000184  
  • 000201  
  • 000204  
  • 000221  
  • 000224 |
<p>| Printer error. For details, see your documentation.   | The product may be damaged, but features such as scanning are still available. Contact Epson for support. |
| Printer error. For details, see your documentation.   | The product may be damaged. Contact Epson for support.                               |
| Paper out in XX. Load Paper. Paper Size XX/Paper Type XX | Load the size and type of paper in the paper source indicated.                      |
| Too many paper cassette units are installed. Turn the power off and uninstall the extra units. See your documentation for details. | You can install up to two optional paper cassette units. Remove any extra units. |
| Unsupported Paper Cassette Units have been installed. Turn the power off and uninstall. For details, see your documentation. | Unsupported optional paper cassette units are installed. Remove the unsupported units. |
| Cannot print because XX is out of order. You can print from another cassette. | Turn the product off and then back on again. Reinsert the indicated paper cassette. If the error persists, contact Epson for support. |</p>
<table>
<thead>
<tr>
<th>LCD screen message</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance rollers in XX is nearing the end of its service life. .</td>
<td>The maintenance rollers need to be replaced periodically for optimal performance. (Paper may not feed correctly from the paper cassette when the maintenance roller is near the end of its service life.)</td>
</tr>
<tr>
<td>Maintenance rollers in XX is at the end of its service life. Replace it and reset the maintenance roller counter</td>
<td>Replace the maintenance rollers.</td>
</tr>
<tr>
<td>You need to replace ink supply unit(s).</td>
<td>Replace the indicated ink packs.</td>
</tr>
<tr>
<td>Paper Setup Auto Display is set to Off. Some features such as paper size and type settings may be unavailable. For details, see your documentation.</td>
<td>AirPrint is not available when the Paper Setup Auto Display setting is disabled. Change Paper Setup Auto Display to On.</td>
</tr>
<tr>
<td>No dial tone detected.</td>
<td>Make sure the phone cable is connected correctly and the phone line works. If you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the Dial Tone Detection setting. (Turning off the Dial Tone Detection setting may cause the product to drop the first digit of a fax number.)</td>
</tr>
<tr>
<td>Failed to receive faxes because the fax data capacity is full. Touch the Job/Status at the bottom of the Home Screen for details.</td>
<td>Press the Job/Status button and select Printer Status and resolve any printer errors that prevented faxes from printing. Make sure the product is connected to a computer or that a USB device is connected to the product.</td>
</tr>
<tr>
<td>Combination of the IP address and the subnet mask is invalid.</td>
<td>There is a problem with the network connection to your product. Set up your product on the network again.</td>
</tr>
<tr>
<td>Update the root certificate to use cloud services.</td>
<td>Access the Web Config utility and update the cloud service root certificate.</td>
</tr>
<tr>
<td>LCD screen message</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Check if the port settings of printer (such as IP Address) or printer driver is correct by a computer.</td>
<td>Make sure the printer port is correctly configured. In Windows, make sure the port is set to a <strong>USBXXX</strong> setting for a USB connection or <strong>Epsonnet Print Port</strong> for a network connection.</td>
</tr>
<tr>
<td>Check if the port settings of printer (such as IP address) or printer driver is correct by a computer.</td>
<td></td>
</tr>
<tr>
<td>Recovery mode</td>
<td>An error has occurred during firmware updating. Connect your product using a USB cable and try downloading the Firmware Update from the Epson support site. If you still need help, contact Epson for support.</td>
</tr>
</tbody>
</table>

**Parent topic:** Solving Problems

**Related references**

Where to Get Help

**Related tasks**

Accessing the Web Config Utility
Checking for Software Updates
Selecting the Line Type
Connecting a Telephone or Answering Machine
Removing and Installing Ink Packs

**Related topics**

Wi-Fi or Wired Networking

### Job Status Error Codes

If a job does not complete successfully, you can check the error code for the reason. Press the **Job/Status** button, select **Log**, and select the incomplete job to display the error code and additional information.

<table>
<thead>
<tr>
<th>Code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>The product was turned off by a power failure.</td>
</tr>
<tr>
<td>101</td>
<td>Memory is full. Reduce the size of the print job.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
</tr>
<tr>
<td>102</td>
<td>Collated printing has failed due to a lack of available memory. Clear fonts and macros from the product's memory using the PDL Font, Macro option from the Settings &gt; General Settings &gt; System Administration &gt; Clear Internal Memory Data menu, reduce the size of the print job, or print one copy at a time.</td>
</tr>
<tr>
<td>103</td>
<td>Print quality was decreased due to a lack of available memory. If the quality of the printout is unacceptably low, try simplifying the page by reducing the number of graphics or the number and size of the fonts.</td>
</tr>
<tr>
<td>104</td>
<td>Reverse printing has failed due to a lack of available memory. Clear fonts and macros from the product's memory using the PDL Font, Macro option from the Settings &gt; General Settings &gt; System Administration &gt; Clear Internal Memory Data menu or reduce the data size of the print job.</td>
</tr>
<tr>
<td>106</td>
<td>Cannot print from the computer due to access control settings. Contact your product administrator.</td>
</tr>
<tr>
<td>107</td>
<td>User authentication failed and the job has been canceled. Contact your product administrator.</td>
</tr>
<tr>
<td>108</td>
<td>Confidential job data was deleted when the product was turned off.</td>
</tr>
<tr>
<td>109</td>
<td>The received fax was already deleted.</td>
</tr>
<tr>
<td>110</td>
<td>The job was printed 1-sided because the loaded paper does not support 2-sided printing.</td>
</tr>
<tr>
<td>111</td>
<td>Available memory is running low. Reduce the size of the print job.</td>
</tr>
<tr>
<td>120</td>
<td>Cannot communicate with a server using an open platform. Check the server or network for errors.</td>
</tr>
<tr>
<td>130</td>
<td>Collated printing has failed due to a lack of available memory. Reduce the size of the print job.</td>
</tr>
<tr>
<td>131</td>
<td>Reverse printing has failed due to a lack of available memory. Reduce the size of the print job.</td>
</tr>
<tr>
<td>132</td>
<td>The product's memory is full. Reduce the size of the print job.</td>
</tr>
<tr>
<td>133</td>
<td>The product's memory is full.</td>
</tr>
<tr>
<td>201</td>
<td>The product's memory is full. You can send pages individually, or print received faxes and delete them to free up memory space.</td>
</tr>
<tr>
<td>202</td>
<td>The line was disconnected by the recipient's fax machine. Wait a moment, then try again.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| 203  | The product cannot detect a dial tone.  
Make sure the phone cable is connected correctly and the phone line works. If you  
connected the product to a PBX (Private Branch Exchange) phone line or Terminal  
Adapter, change the **Line Type** setting to **PBX**. If you still cannot send a fax, turn off the **Dial Tone Detection** setting. (Turning off the Dial Tone Detection setting may cause the  
product to drop the first digit of a fax number.) |
| 204  | The recipient's fax machine is busy. Wait a moment, then try again. |
| 205  | The recipient's fax machine does not answer. Wait a moment, then try again. |
| 206  | The phone cable is incorrectly connected to the product's **LINE** and **EXT** ports. Connect  
the phone cable correctly. |
| 207  | The phone cable is not connected. Connect the phone cable. |
| 208  | The fax could not be sent to some of the specified recipients.  
Print a fax log to check which recipients failed to receive the fax. If the **Save Failure Data**  
setting is turned on, you can resend a fax from Job Status in the Job/Status Menu. |
| 301  | There is not enough storage space available to save the data in the external memory  
device. Clear space on the device or use a different device. |
| 302  | The external memory device is write-protected. Disable write protection. |
| 303  | No folder is available for saving the scanned file. Create a folder or use a different  
memory device. |
| 304  | The external memory device has been removed. Reinsert the device. |
| 305  | An error occurred while saving data to an external memory device. Reinsert the memory  
device or use a different device. |
| 306  | The product's memory is full. Wait until current jobs are finished processing. |
| 311  | A DNS error has occurred. Check the DNS settings for the server, computer, or access  
point. DNS settings for the server can be checked from the DNS Server option in the  
Setup menu. |
<table>
<thead>
<tr>
<th>Code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>312</td>
<td>An authentication error has occurred. Check the Server Settings in the Setup menu.</td>
</tr>
<tr>
<td>412</td>
<td></td>
</tr>
<tr>
<td>313</td>
<td>A communication error has occurred. Check the network connection or Server Settings in the Setup menu.</td>
</tr>
<tr>
<td>413</td>
<td></td>
</tr>
<tr>
<td>314</td>
<td>The data size exceeds the maximum size for the attached files. Increase the Attached File Max Size setting in the scan settings or lower the file size of the scanned image.</td>
</tr>
<tr>
<td>315</td>
<td>The memory is full. Retry after other ongoing jobs have finished.</td>
</tr>
<tr>
<td>327</td>
<td></td>
</tr>
<tr>
<td>322</td>
<td>An authentication error occurred. Check the Location settings.</td>
</tr>
<tr>
<td>323</td>
<td>A communication error has occurred. Check the Location settings or the network connection.</td>
</tr>
<tr>
<td>324</td>
<td>A file with the same name already exists in the specified folder. Delete the duplicate file or change the file name prefix in File Settings.</td>
</tr>
<tr>
<td>325</td>
<td>There is not enough storage space available in the specified folder. Increase the storage space in the specified folder, delete unnecessary files, or lower the file size of the scanned image.</td>
</tr>
<tr>
<td>326</td>
<td></td>
</tr>
<tr>
<td>328</td>
<td>The destination was wrong or the destination does not exist. Check the Location settings.</td>
</tr>
<tr>
<td>331</td>
<td>A communication error occurred while acquiring the destination list. Make sure the product is connected to the network correctly.</td>
</tr>
<tr>
<td>332</td>
<td>There is not enough space available for saving the scanned files in the specified folder. Delete unnecessary files from the specified folder.</td>
</tr>
<tr>
<td>333</td>
<td>The destination could not be found because the destination information was uploaded to the server before sending the scanned data. Select the destination again.</td>
</tr>
<tr>
<td>334</td>
<td>An error occurred while sending the scanned data.</td>
</tr>
<tr>
<td>341</td>
<td>A communication error has occurred. Make sure the product is connected to the computer or network correctly. Make sure you have installed Document Capture Pro or Document Capture. Make sure the Event Manager program is not being blocked by your firewall or security software.</td>
</tr>
</tbody>
</table>

369
<table>
<thead>
<tr>
<th>Code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>422</td>
<td>An authentication error has occurred. Make sure the settings are correct for the folder selected in <strong>Save/Forward Settings</strong> in the <strong>Settings</strong> menu.</td>
</tr>
<tr>
<td>423</td>
<td>A communication error has occurred. It is also possible that a file with the same name is open or the file is a read-only file. Check the network connection, make sure the settings are correct for the folder selected in the <strong>Save/Forward Settings</strong> in the <strong>Settings</strong> menu, close the duplicate file, or disable read-only protection.</td>
</tr>
<tr>
<td>425</td>
<td>There is not enough storage space available in the forwarding destination folder. Increase the storage space in the destination folder.</td>
</tr>
<tr>
<td>428</td>
<td>The destination was wrong or the destination does not exist. Make sure the settings are correct for the folder selected in <strong>Save/Forward Settings</strong> in the <strong>Settings</strong> menu.</td>
</tr>
</tbody>
</table>

**Parent topic:** Solving Problems

**Related tasks**
- Connecting a Telephone or Answering Machine
- Viewing a Fax on the LCD Screen (Using the Fax Box)
- Selecting the Line Type
- Selecting Advanced Fax Settings
- Setting User Feature Restrictions (Access Control)
- Entering a User ID and Password for Printing

**Related topics**
- Sending Faxes
- Wi-Fi or Wired Networking

**Running a Product Check**

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.
6. Select **Print Head Nozzle Check**.
   You see a screen like this:

   ![Print Head Nozzle Check](image)

   - Load Letter/A4 Plain Paper to print a nozzle check pattern and touch Start.

7. Select **Start**.
   The nozzle pattern prints.
8. Do one of the following, depending on the results of the product check:
   • If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.
   • If the page prints but the nozzle check pattern has gaps, clean the print head.
   • If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Quality Adjustment
Uninstall Your Product Software
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Scroll down and select System Administration. Enter the administrator password, if necessary.
5. Scroll down and select Restore Default Settings.
You see a screen like this:

![Restore Default Settings](image)

6. Select one of these options:
   - **Network Settings**: Resets all network settings
   - **Copy Settings**: Resets all settings for copying
   - **Scan Settings**: Resets all settings for scanning
   - **Fax Settings**: Resets all settings for faxing
   - **Clear All Data and Settings**: Resets all control panel settings including the contacts list

You see a confirmation screen.

7. Select **Yes** to reset the selected settings. (Select **No** if you want to cancel the operation.)

**Parent topic**: Solving Problems

---

**Solving Setup Problems**

Check these sections if you have problems while setting up your product.

- **Product Does Not Turn On or Off**
- **Noise After Ink Installation**
- **Software Installation Problems**

**Parent topic**: Solving Problems
Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

• If you cannot turn on your product, make sure the power cord is securely connected and hold down the power button a little longer.

• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off your product, unplug the power cord, plug the power cord back in, then turn your product on and off again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation

If you hear noises from your product after installing ink, check the following:

• The first time you install the ink packs, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on.

• If the product's print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems

If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions on the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your system administrator.

• If you are printing over a network, make sure your product is set up properly on the network.

Parent topic: Solving Setup Problems
Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

**Note:** Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

- **Product Cannot Connect to a Wireless Router or Access Point**
- **Network Software Cannot Find Product on a Network**
- **Product Does Not Appear in Mac Printer Window**
- **Cannot Print Over a Network**
- **Cannot Scan Over a Network**

**Parent topic:** Solving Problems

**Product Cannot Connect to a Wireless Router or Access Point**

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product’s LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

- Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.
• Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router's address list. To obtain your product's MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the network connection or adapter settings in the Windows Control Panel and set the Internet metric setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Selecting Wireless Network Settings from the Control Panel
Printing a Network Status Sheet
Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify the connection using your product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.
• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product’s network settings to their factory defaults.
  2. **Windows only:** Uninstall your product software.
  3. Restart your router following the instructions in your router documentation.

  **Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router, so note the next step before restarting it.

  4. Download your product software from the Epson website using the instructions on the *Start Here* sheet.
  5. If you have replaced your router, reinstall your product software to connect to the new router.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

  • Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

**Parent topic:** Solving Network Problems

**Related concepts**

Uninstall Your Product Software
Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in Mac Printer Window

If your product does not appear in the Mac printer window, try these solutions:

• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.
• If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna icon with connection bars on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.
**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

- Try restarting your router following the instructions in your router documentation.

  **Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

- Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

- Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  - Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  - Try connecting your product to a different port or a different router, access point, switch, or hub.
  - Try connecting with a different Ethernet cable.
  - Try printing to your product from another computer on the network.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

- If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic:** Solving Network Problems

**Related concepts**

Uninstall Your Product Software

**Related tasks**

Printing a Network Status Sheet

**Related topics**

Wi-Fi or Wired Networking
Cannot Scan Over a Network

If you have problems scanning over a network, try these solutions:

• If you cannot scan from your product control panel, make sure you restarted your computer after installing the product software. Make sure the Event Manager program is not being blocked by your firewall or security software.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try restarting Epson Scan 2 again.

• Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

  **Windows 10:** Click ![Start](1.png) and select **EPSON > Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.

  **Windows 8.x:** Navigate to the **Apps** screen, select **EPSON**, and select **Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.

  **Windows (other versions):** Click ![Start](1.png) or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.

  **Mac:** Open the **Applications** folder, click **Epson Software**, and click **Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

**Parent topic:** Solving Network Problems

**Related tasks**

- Starting a Scan Using the Product Control Panel
- Starting a Scan Using the Epson Scan 2 Icon
- Entering a User ID and Password for Scanning
Solving Copying Problems

Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Originals Do Not Feed From the Automatic Document Feeder

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
• Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder
If your originals do not feed when placed in the ADF, try these solutions:

• Make sure the ADF icon lights up on the Copy, Fax, or Scan screen on the LCD screen. If not, reload the originals.
• Make sure the size, weight, and number of your originals are supported by the ADF.
• Make sure the originals are loaded correctly.
• Make sure the document is not curled or creased.
• Try cleaning the inside of the ADF.
• Do not load originals above the arrow mark on the ADF edge guide.

Parent topic: Solving Copying Problems
Related references
Document Jams in the Automatic Document Feeder (F)
Related tasks
Placing Originals in the Automatic Document Feeder
Cleaning Your Product

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems

Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Cassette (C1/C2/C3/C4)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)
Paper Ejection Problems

Parent topic: Solving Problems

**Paper Feeding Problems**

If you have problems feeding paper, try these solutions:

- If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the cassette or rear feed slot.
- Be sure to insert the paper cassette all the way into your product.
- If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
- Do not load more than the recommended number of sheets.
- Make sure the ink cases are closed.
- Make sure your paper meets the specifications for your product.
- If paper jams when you print on both sides of the paper, try loading fewer sheets.
- Make sure the paper size and paper type settings are correct for the paper source.
- If paper does not feed correctly after replacing the maintenance rollers, make sure you installed the maintenance rollers correctly.
- If you installed an optional paper cassette unit, be sure to enable the cassette unit in the printing software.
- If your product pauses during printing, make sure the front cover is closed.
- The maintenance rollers may be at the end of their service life. Check the maintenance roller status and replace them if necessary.
- For best results, follow these guidelines:
  - Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Do not load binder paper with holes in the cassette.
• Follow any special loading instructions that came with the paper.

**Parent topic:** Solving Paper Problems

**Related references**
- Paper Jam Problems in the Front Cover (A)
- Paper Jam Problems in the Rear Paper Feed Slot (B1)
- Paper Jam Problems in the Cassette (C1/C2/C3/C4)
- Paper Jam Problems in the Rear Cover 1 (D1)
- Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
- Document Jams in the Automatic Document Feeder (F)
- Paper Loading Capacity
- Paper Specifications

**Related tasks**
- Cleaning the Paper Guide

**Related topics**
- Loading Paper

**Paper Jam Problems in the Front Cover (A)**

If paper has jammed in the front cover, follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Open the front cover.
3. Remove any paper inside, including torn pieces.

![Paper Removal Image]

**Caution:** Be careful to not touch any parts inside the product to prevent damage to it.

4. Close the front cover.

**Note:** If any torn pieces of paper remain in the product, select **Settings > Maintenance > Remove Paper** after clearing the paper jam error.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

**Parent topic:** Solving Paper Problems

**Related references**
- Paper Jam Problems in the Rear Paper Feed Slot (B1)
- Paper Jam Problems in the Cassette (C1/C2/C3/C4)
- Paper Jam Problems in the Rear Cover 1 (D1)
- Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
- Document Jams in the Automatic Document Feeder (F)

**Related topics**
- Loading Paper
Paper Jam Problems in the Rear Paper Feed Slot (B1)

If paper has jammed in the rear paper feed slot, carefully remove the paper.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Cassette (C1/C2/C3/C4)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)
Related topics
Loading Paper

Paper Jam Problems in the Cassette (C1/C2/C3/C4)

If paper has jammed in the cassette, follow the steps here to clear the jam.

Note: If the optional paper cassette units are installed, do not remove more than one paper cassette at a time.

1. Cancel the print job, if necessary.
2. Pull out the paper cassette.

3. Carefully remove any paper jammed inside the product.

4. Carefully follow all paper loading instructions and reload the paper.
5. Keep the cassette flat as you gently insert it.
6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.
Paper Jam Problems in the Rear Cover 1 (D1)

If paper has jammed in the rear cover 1, follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Open rear cover 1 (D1).
3. Carefully remove any jammed paper.

4. Pull out rear cover 2 (D2).
5. Remove any jammed paper from the duplexer.

6. Insert rear cover 2 (D2).
7. Close rear cover 1 (D1).
8. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
- Paper Jam Problems in the Front Cover (A)
- Paper Jam Problems in the Rear Paper Feed Slot (B1)
- Paper Jam Problems in the Cassette (C1/C2/C3/C4)
- Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
- Document Jams in the Automatic Document Feeder (F)

Related topics
- Loading Paper

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

If paper has jammed in any of the optional paper cassettes, follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Open rear cover (E) on the optional paper cassette unit with the jammed paper.
3. Carefully remove any paper jammed inside.

4. Close rear cover (E).

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

**Parent topic:** Solving Paper Problems

**Related references**

- Paper Jam Problems in the Front Cover (A)
- Paper Jam Problems in the Rear Paper Feed Slot (B1)
- Paper Jam Problems in the Cassette (C1/C2/C3/C4)
- Paper Jam Problems in the Rear Cover 1 (D1)
- Document Jams in the Automatic Document Feeder (F)

**Related topics**

- Loading Paper
Document Jams in the Automatic Document Feeder (F)

If you have problems with document jams in the automatic document feeder (ADF), follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Raise the lever and open the ADF cover.
4. Carefully remove any jammed pages.
5. Close the ADF cover, then raise the document cover.
6. Carefully remove any jammed pages.

7. Lower the document cover.
8. Raise the ADF input tray and carefully remove any jammed pages.

9. Lower the ADF input tray.
10. Reload your originals.

**Caution:** Make sure you do not load the ADF beyond its capacity for your paper size. Also make sure your originals are not bent, folded, or curled and do not have tape, staples, or other materials that could obstruct the feeder.

11. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

**Parent topic:** Solving Paper Problems

**Related references**
- Paper Jam Problems in the Front Cover (A)
- Paper Jam Problems in the Rear Paper Feed Slot (B1)
- Paper Jam Problems in the Cassette (C1/C2/C3/C4)
- Paper Jam Problems in the Rear Cover 1 (D1)
- Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Paper Ejection Problems

If you have problems with paper ejecting properly, try these solutions:

• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
• Make sure the printer status is not offline or pending.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.

• Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system’s memory.

• In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.

• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.

• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check
Using AirPrint
Entering a User ID and Password for Printing

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:

   • **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printing preferences.

   • **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

   • **Windows 7**: Click , select Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

   • **Windows Vista**: Click , select Control Panel, and click Printer under Hardware and Sound. Right-click your product name, select Printing Preferences, and select your product name again if necessary.
• **Windows XP:** Click **Start** and select **Printers and Faxes.** (Or open the **Control Panel,** select **Printers and Other Hardware,** if necessary, and **Printers and Faxes.**) Right-click your product name, select **Printing Preferences,** and select your product name again if necessary.

2. Click the **Maintenance** tab.

3. Click the **Extended Settings** button.

4. Select **Enable EPSON Status Monitor 3** and click **OK.**

5. Click the **Monitoring Preferences** button.

6. Click the checkbox for the option that adds the shortcut icon to the taskbar.

7. Click **OK** to close the open program windows.

**Parent topic:** Solving Problems Printing from a Computer

### Printing is Slow

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.

- If you are using Windows 7, close the **Devices and Printers** window before you print.

- Make sure **Quiet Mode** is turned off.

- Clear space on your hard drive or run a defragmentation utility to free up existing space.

- Close any programs you are not using when you print.

- If your product is connected to a USB hub, connect it directly to your computer instead.

- If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

- If you are using the Windows PostScript printer software, try selecting **Fast** as the **Print Quality** setting on the Advanced tab of the printer software.

For the fastest printing, select the following settings in your product software:

- Make sure the paper type setting matches the type of paper you loaded.

- Turn on any high speed settings in your product software.

- Select a lower print quality setting.

- Make sure the ink drying time has not been increased for double-sided printing.
• **Windows**: Click the *Maintenance* or *Utility* tab, select *Extended Settings* or *Speed and Progress*, and select the following settings:
  • *Always Spool RAW Datatype*
  • *Page Rendering Mode*
  • *Print as Bitmap*

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select *Computer* or *My Computer*. Double-click the C: drive and open these folders: *ProgramData > EPSON > PRINTER*.

   **Note**: If you do not see the ProgramData folder, open the *Organize* menu and select *Folder and search options*. In the window that appears, click the *View* tab, select *Show hidden files, folders, and drives* in the Advanced settings list, and click *OK*.

2. Right-click the EPAUDF01.AUD file and select *Delete*.
3. Restart your computer and try printing again.

**Parent topic**: Solving Problems Printing from a Computer

**Related references**
- Windows System Requirements
- Mac System Requirements
- Paper or Media Type Settings - Printing Software

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Extended Settings - Windows
- Selecting Basic Print Settings - Mac

---

**Solving PostScript Printing Problems**

Check these solutions if you have problems using the PostScript printing software.

- Nothing Prints Using the PostScript Printing Software
- Documents Print Incorrectly Using the PostScript Printing Software
- Accessing Printer Properties - PostScript - Windows

**Parent topic**: Solving Problems
Nothing Prints Using the PostScript Printing Software

If your document doesn't print, try these solutions:

• Make sure your product is turned on and connected to your computer.
• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving PostScript Printing Problems
Related topics
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Documents Print Incorrectly Using the PostScript Printing Software

If your document does not print correctly, try these solutions:

• If the file you are printing was created in an application that allows you to change the data format, such as Adobe Photoshop, make sure the settings in the application match the printer software settings.
• EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• In Windows, the product cannot print binary data if it is connected to the computer using a USB cable. Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer properties.
• In Windows, select the appropriate substitution fonts on the Device Settings tab in the printer properties.
• In Windows, if the printed colors are incorrect, try adjusting the Color Mode setting on the Advanced tab of the printer software.
• In Windows, if printing is slow, try selecting Fast as the Print Quality setting on the Advanced tab of the printer software.

Parent topic: Solving PostScript Printing Problems
Related tasks
Accessing Printer Properties - PostScript - Windows

Accessing Printer Properties - PostScript - Windows

You can access the printer properties to view and change product settings for PostScript printing.

1. Do one of the following:
   • Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.
Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click the postscript driver for your product, and select Printer properties.

Windows 7: Click and select Devices and Printers. Right-click the postscript driver for your product and select Printer properties.

Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound, then right-click the postscript driver for your product and select Properties.

Windows XP: Click Start and select Printers and Faxes. Right-click the postscript driver for your product and select Properties.

2. Click any tab to view and change the printer property settings.

Parent topic: Solving PostScript Printing Problems

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:

- Turn off any mirror or inversion settings in your printing application.
- Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks

- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the **Skip Blank Page** setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Page Layout and Content Problems

Related concepts

- Print Head Nozzle Check
- Print Head Cleaning

Related tasks

- Selecting Basic Print Settings - Windows
- Selecting Extended Settings - Windows
- Selecting Basic Print Settings - Mac
- Selecting Printing Preferences - Mac

Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- Make sure you selected the correct margins for your paper size in your printing program.
- Make sure your paper is positioned correctly for feeding into the product.
You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If you are using the PostScript printer software, EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• If you are using the Windows PostScript printer software, the product cannot print binary data if it is connected to the computer using a USB cable. Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer properties.
• If you are using the Windows PostScript printer software, select the appropriate substitution fonts on the Device Settings tab in the printer properties.

Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.
• Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Slanted Printout

If your printouts are slanted, try these solutions:

• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Adjust the print quality.
• Make sure the product is not printing while tilted or at an angle.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Turn off any high speed settings in your product software.
• Adjust the print quality in the product software.
• If you continue to see horizontal bands or streaks in your printouts after cleaning the print head and adjusting the print quality, make print quality adjustments for each paper type.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Quality Adjustment

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac

Related topics
Loading Paper
Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers

Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this setting on will decrease print speed.)
• In Windows, if the paper is still smeared after selecting the **Thick Paper and Envelopes** setting, select the **Short Grain Paper** setting in the Extended Settings of the printer software.

• Remove each sheet from the output tray as it is printed.

• Avoid handling printouts on glossy paper right after printing to allow the ink to set.

• Turn off any high speed settings in your product software.

• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Adjust the density and/or ink drying time settings.

• If printed copies are smeared, lower the copy density setting on the product control panel.

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.

• Adjust the print quality in the product software.

• Clean the paper path.

**Note:** Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

Print Head Cleaning
Print Quality Adjustment

**Related references**

Available Epson Papers
Paper Specifications

**Related tasks**

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows

### Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink packs may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Adjust the print quality in the product software.
• Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Quality Adjustment

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cleaning the Paper Guide

Related topics
Replacing Ink Supply Units (Ink Packs), Maintenance Boxes, and Cassette Rollers
Loading Paper

Grainy Printout

If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.
• If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.

**Note:** Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Nozzle Check
- Print Head Cleaning
- Print Quality Adjustment

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Additional Layout and Print Options - Windows
- Selecting Basic Print Settings - Mac
- Selecting Printing Preferences - Mac

**Related topics**
- Loading Paper

**Incorrect Colors**

If your printouts have incorrect colors, try these solutions:

• Make sure the paper type setting matches the paper you loaded.

• Make sure the **Black/Grayscale** or **Grayscale** setting is not selected in your printer software.

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.

• The ink packs may be old, and you may need to replace them.

• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
• For best results, use genuine Epson paper.
• If you are using the Windows PostScript printer software, try adjusting the **Color Mode** setting on the Advanced tab of the printer software.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Nozzle Check
- Print Head Cleaning

**Related references**
- Available Epson Papers

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Additional Layout and Print Options - Windows
- Selecting Basic Print Settings - Mac
- Managing Color - Mac

---

**Solving Scanning Problems**

Check these solutions if you have problems scanning with your product.

**Scanning Software Does Not Operate Correctly**

If your scanning software does not operate correctly, try these solutions:

• Make sure your computer has adequate memory and meets the system requirements for your operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
**Cannot Start Epson Scan 2**

If you cannot start Epson Scan 2, try these solutions:

- Make sure your product is turned on and any interface cables are securely connected at both ends.
- Make sure Epson Scan 2 is selected as your scanning program.
- Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.
- Check the connection setting and test the connection using Epson Scan 2 Utility:
  - **Windows 10:** Click \(\equiv\) and select **EPSON > Epson Scan 2 Utility.** Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset.**
  - **Windows 8.x:** Navigate to the **Apps** screen and select **Epson Scan 2 Utility.** Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset.**
  - **Windows (other versions):** Click \(\equiv\) or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility.** Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset.**
  - **Mac:** Open the **Applications** folder, click **Epson Software,** and click **Epson Scan 2 Utility.** Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset.**
- Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both versions and install one version.
- If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
- If the user restriction feature (Access Control) is enabled, a user ID and password are required to scan. If you do not know the user ID or password, contact your administrator for assistance.

**Parent topic:** Solving Scanning Problems
Related tasks
Starting a Scan Using the Epson Scan 2 Icon
Entering a User ID and Password for Scanning

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If the Image Type setting is Black & White, adjust the Threshold and scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.
**Caution:** Do not spray glass cleaner directly on the scanner glass.

- Make sure any interface cables are securely connected at both ends.

**Parent topic:** Solving Scanned Image Quality Problems

**Related tasks**

Cleaning Your Product

**Straight Lines in an Image Appear Crooked**

If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.

**Parent topic:** Solving Scanned Image Quality Problems

**Related topics**

Placing Originals on the Product

**Image is Distorted or Blurry**

If a scanned image appears distorted or blurry, try these solutions:

- Do not move your original or your product during scanning.
- Your product will not operate properly while tilted at an angle. Place your product on a flat, stable surface that extends beyond its base in all directions.
- Adjust these Epson Scan 2 settings (if available) and try scanning again:
  - Increase the **Resolution** setting.
  - If the **Image Type** setting is **Black & White**, adjust the **Threshold** setting.
  - If the **Image Type** setting is **Color** or **Grayscale**, select the **Unsharp Mask** setting.
  - If the **Image Type** setting is **Black & White**, select **Text Enhancement**. If the **Image Type** setting is **Color** or **Grayscale**, change the **Text Enhancement** setting to **High**.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**

Additional Scanning Settings - Advanced Settings Tab

**Image Colors are Patchy at the Edges**

If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.
Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark

If your scanned image is too dark, try these solutions:

• If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, try these solutions:

• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the Advanced Settings tab and adjust the Brightness setting.
  • If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to Color or Grayscale, change the Text Enhancement setting to High.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Descreening setting.
• Select a lower Resolution setting.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

415
Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try scanning again:

- If the **Image Type** setting is **Color** or **Grayscale**, adjust the **Contrast** setting.
- If the **Image Type** setting is **Black & White** or **Grayscale**, adjust the **Color Enhance** setting.

Parent topic: Solving Scanned Image Quality Problems

Related references

Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related topics

Placing Originals on the Product

Solving Faxing Problems

Check these solutions if you have problems faxing with your product.

- **Cannot Send or Receive Faxes**
- **Cannot Receive Faxes with a Telephone Connected to Your Product**
- **Fax Memory Full Error Appears**
- **Sent Fax Quality is Poor**
- **Sent Fax is Received in an Incorrect Size**
- **Received Fax Quality is Poor**
- **Received Fax is Not Printed**

Parent topic: Solving Problems
Cannot Send or Receive Faxes

If you cannot send or receive faxes, try these solutions:

• If an error code is displayed on the control panel, try the solutions suggested in the error code list.
• If you are faxing from a computer, use the Epson FAX Utility to send your fax.
• Make sure the recipient's fax machine is turned on and working.
• Make sure paper is loaded correctly in your product.
• Make sure you have set up your header information and have not blocked your caller ID. Otherwise, your faxes might be rejected by the recipient's fax machine.
• If user restriction has been enabled, you may need to enter a user name and password. Contact your administrator for assistance.
• If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can receive faxes automatically.
• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
• Print a fax connection report using your product control panel or fax software to help diagnose the problem.
• Verify that the telephone wall jack works by connecting a phone to it and testing it.
• If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the product's dial tone detection setting. (Turning off the dial tone setting may cause the product to drop the first digit of a fax number.)
• If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to enable faxing over the line. Contact your DSL provider for the necessary filter.
• If your telephone line has static, turn off your product's error correction mode fax communication setting and try faxing again.
• Try lowering your product's fax speed setting.
• Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a color fax.
• If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to prevent disruption of incoming faxes.
• If you have subscribed to a call forwarding service, the product may not be able to receive faxes. Contact your service provider for assistance.
• Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot receive faxes.
• If you cannot send faxes at a specified time, make sure the date and time are set correctly on the product.
• If you cannot receive A3-size faxes, make sure you selected the correct paper size setting for the paper source containing the A3-size paper. Also, be sure to enable the paper source to receive faxes as the Auto Select Settings option.

Note: If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax transmission will work when using VoIP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received by your voice mail service.

Parent topic: Solving Faxing Problems

Related references
Job Status Error Codes

Related tasks
Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard
Selecting the Line Type
Selecting Advanced Fax Settings
Receiving Faxes Automatically
Printing Fax Reports
Viewing a Fax on the LCD Screen (Using the Fax Box)

Related topics
Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product

If you cannot receive faxes when a telephone is connected to your product, try these solutions:
• Make sure your telephone is connected to your product's EXT port.
• Make sure the Receive Mode is set to Manual.
**Note:** When answering a call that is a fax, wait until the product's LCD screen displays a message that a connection has been made before you hang up.

**Parent topic:** Solving Faxing Problems

**Fax Memory Full Error Appears**

If you see an error message telling you that the product's fax memory is full, try these solutions:

- If you set the product to save received faxes in the product's memory or inbox, delete any faxes you have already read.

  **Note:** Your product can store up to 200 faxes before its inbox is full.

- If you set the product to save received faxes on a computer, turn on the selected computer. Once the faxes are saved on the computer, they are deleted from the product's memory.

- If you set the product to save received faxes on a USB device, connect the selected USB device containing the save fax folder to the product. Once the faxes are saved on the USB device, they are deleted from the product's memory.

  **Note:** Make sure the USB device has enough available memory and is not write protected.

- If the memory is full, try the following:
  - Send a monochrome fax using the direct sending feature
  - Send your faxes in smaller batches
  - If the product cannot print a received fax due to a product error, such as a paper jam, the memory full error may appear. Clear any product errors, then ask the sender to resend the fax.

**Parent topic:** Solving Faxing Problems

**Related references**

Fax Sending Options

**Related tasks**

Viewing a Fax on the LCD Screen (Using the Fax Box)

**Sent Fax Quality is Poor**

If the sent fax quality is poor, try these solutions:

- Clean the scanner glass.
• Clean the ADF.
• Try changing the resolution or density setting on the control panel.
• Try changing the original type setting on the control panel.
• If you are sending a monochrome fax to a single recipient, try sending the fax using the Direct Send feature.

**Note:** If you send a high-resolution monochrome fax without using the Direct Send feature, the product may automatically lower the resolution.

• Try enabling the error correction mode (ECM) setting.

**Parent topic:** Solving Faxing Problems

### Sent Fax is Received in an Incorrect Size

If your recipient receives a fax in an incorrect size, try these solutions:

• If you are trying to fax an A3-size document, make sure the recipient's fax machine supports the paper size. If the message **OK (Reduced Size)** appears in the fax transmission report, the recipient's fax machine does not support A3-size documents.

• If you are sending a fax using the scanner glass, make sure your original is placed correctly and that the correct paper size is selected on the control panel.

• Clean the scanner glass and document cover.

**Parent topic:** Solving Faxing Problems

**Related tasks**

- Placing Originals on the Scanner Glass
- Cleaning Your Product

### Received Fax Quality is Poor

If you receive a poor quality fax, try these solutions:

• Try enabling the error correction mode (ECM) setting.

• Contact the fax sender and ask them to send the fax in a higher resolution.

• Try reprinting the received fax.

**Parent topic:** Solving Faxing Problems
Received Fax is Not Printed

If a received fax is not printed, try these solutions:

- Make sure the product is free of errors. The product cannot print received faxes if an error has occurred with the product, such as a paper jam.
- If the product has been set to save received faxes in the product's memory or inbox, received faxes are not automatically printed. Check the Receive Settings options on the product control panel and change them, if necessary.

Parent topic: Solving Faxing Problems
Related references
Print Settings - Fax

Solving USB Device Problems

Check these solutions if you have problems using USB devices with your product.

Cannot View or Print from a USB Device
Cannot Save Files on a USB Device
Cannot Transfer Files To or From a USB Device

Parent topic: Solving Problems

Cannot View or Print from a USB Device

If you cannot view or print photos or documents from a USB device connected to your product, try these solutions:

- Make sure memory devices are enabled on the product.
- Make sure your device is compatible with the product.
- Make sure the files on your device are in the correct format.

Parent topic: Solving USB Device Problems
Related references
Interface Specifications
External USB Device Specifications

Related tasks
Setting Up File Sharing for File Transfers from Your Computer

Related topics
Viewing and Printing from the LCD Screen

Cannot Save Files on a USB Device

If you cannot save files on a USB device connected to your product, try these solutions:

- To save faxes on a USB device, create a folder in the Fax Output settings on the product control panel.
- Make sure the device is not write-protected.
- Make sure the device has enough available space.
- Make sure memory devices are enabled on your product.
- Make sure the device is compatible with the product.

Parent topic: Solving USB Device Problems

Related references
Interface Specifications
Print Settings - Fax

Related tasks
Setting Up File Sharing for File Transfers from Your Computer

Cannot Transfer Files To or From a USB Device

If you have problems transferring files to or from a USB device connected to your product, try these solutions:

- Make sure your device is compatible with the product.
- Make sure your product is securely connected to your computer.
- Make sure that the file sharing setting for your product is enabled.

Parent topic: Solving USB Device Problems
Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows

You can uninstall and then re-install your product software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:
   - **Windows 10**: Click and select (Settings) > Apps or System > Apps & features. Then select the program you want to uninstall and select Uninstall.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

   **Note**: If you see a User Account Control window, click Yes or Continue.

   Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON, select your product, then click EPSON Printer Software Uninstall.

   **Note**: If you see a User Account Control window, click Yes or Continue.

   In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
   • **Windows 10**: Select *Epson Scan 2* and click *Uninstall*.
   • **Windows 8.x/Windows 7/Windows Vista**: Select *Epson Scan 2* and click *Uninstall/Change*.
   • **Windows XP**: Select *Epson Scan 2* and click *Change/Remove*.

5. Restart your computer, then see the *Start Here* sheet to re-install your software.

   **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic**: Uninstall Your Product Software

### Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. Click *Downloads*.
3. Select your operating system, click *Utilities*, locate the Uninstaller utility, and click *Download*.
4. Run the file you downloaded.
5. Double-click the *Uninstaller* icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click *Uninstall*.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

   **Note**: If you uninstall the printer driver and your product name remains in the *Print & Fax*, *Print & Scan*, or *Printers & Scanners* window, select your product name and click the — (remove) icon to remove it.

**Parent topic**: Uninstall Your Product Software
Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson’s support website at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Then call: (866) 212-8743, 6 AM to 6 PM, Pacific Time, Monday through Friday.
Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Automatic Document Feeder (ADF) Specifications
Fax Specifications
Ink Pack Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications
PS3 Mode Fonts
PCL Mode Fonts (URW)
Symbol Sets

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3 or later
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003

Windows Server supports only the printer driver, Epson Scan 2, and Document Capture Pro Server; any additional included software is not supported.

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.

**Parent topic:** Technical Specifications

## Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.

**Parent topic:** Technical Specifications
Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.

**Single-sheets**

**Size**
- 13 × 19 inches (330 × 483 mm)
- A3 (11.7 × 16.5 inches [297 × 420 mm])
- 11 × 17 inches (279 × 432 mm)
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- Legal (8.5 × 14 inches [216 × 356 mm])
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- 3.5 × 5 inches (89 × 127 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- Half Letter (5.5 × 8.5 inches [140 × 216 mm])

**Paper types**
- Plain paper and paper distributed by Epson

**Weight**
- 17 lb (64 g/m²) to 68 lb (256 g/m²)

**Envelopes**

**Size**
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

**Paper types**
- Plain bond paper

**Weight**
- 20 lb (75 g/m²) to 24 lb (90 g/m²)

Parent topic: Technical Specifications
Printable Area Specifications

Single sheets

1. Margin: 0.12 inch (3 mm) minimum
2. Reduced print quality area/top: 1.93 inches (49 mm)
3. Reduced print quality area/bottom: 2.13 inches (54 mm)

Envelopes
1 Left/right margins: 0.12 inch (3 mm) minimum  
2 Top/bottom margins: 0.20 inch (5 mm) minimum  
3 Reduced print quality area/(right): 2.13 inches (54 mm)  
4 Reduced print quality area/left: 1.93 inches (49 mm)

Parent topic: Technical Specifications

## Scanning Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scanner type</strong></td>
<td>Flatbed, color</td>
</tr>
<tr>
<td><strong>Photoelectric device</strong></td>
<td>CIS</td>
</tr>
<tr>
<td><strong>Effective pixels</strong></td>
<td>14040 × 20400 pixels at 1200 dpi</td>
</tr>
</tbody>
</table>
| **Document size**            | Maximum: 11.7 × 17 inches (297 × 431.8 mm)  
Scanning glass: A3 (11.7 × 16.5 inches [297 × 420 mm]) |
| **Scanning resolution**      | 1200 dpi (main scan)  
2400 dpi (sub scan)                                                |
| **Output resolution**        | 50 to 4800, 7200, and 9600 dpi  
(50 to 4800 dpi in 1 dpi increments)                                  |
| **Image data**               | Color:  
16 bits per pixel per color internal  
8 bits per pixel per color external  
Black and white:  
16 bits per pixel internal  
1 bit per pixel external |
| **Light source**             | LED                                                                     |

Parent topic: Technical Specifications
Automatic Document Feeder (ADF) Specifications

<table>
<thead>
<tr>
<th>Paper size</th>
<th>A6 (4.1 × 5.8 inches [105 × 148 mm]) landscape to A3 (11.7 × 16.5 inches [297 × 420 mm])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper type</td>
<td>Plain paper, high quality paper, recycled paper</td>
</tr>
<tr>
<td>Paper weight</td>
<td>14 lb (52 g/m²) to 35 lb (128 g/m²)</td>
</tr>
<tr>
<td>Sheet feeding capacity</td>
<td>Total thickness: 0.2 inch (5 mm)</td>
</tr>
<tr>
<td></td>
<td>Approximately 50 sheets at 20 lb (75 g/m²)</td>
</tr>
</tbody>
</table>

**Note:** Depending on the quality of the paper, originals that meet the ADF specifications still may not feed or scan correctly.

Parent topic: Technical Specifications

Fax Specifications

<table>
<thead>
<tr>
<th>Fax type</th>
<th>Walk-up black-and-white and color fax capability (ITU-T Super Group 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support line</td>
<td>Standard analog telephone lines</td>
</tr>
<tr>
<td></td>
<td>PBX (Private Branch Exchange) telephone systems</td>
</tr>
<tr>
<td>Speed</td>
<td>Up to 33.6 kbps</td>
</tr>
</tbody>
</table>
Resolution

<table>
<thead>
<tr>
<th>Monochrome</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>203 pixels per inch × 98 lines per inch (8 pixels per mm × 3.85 lines per mm)</td>
</tr>
<tr>
<td>Fine</td>
<td>203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7 lines per mm)</td>
</tr>
<tr>
<td>Super Fine</td>
<td>203 pixels per inch × 392 lines per inch (8 pixels per mm × 15.4 lines per mm)</td>
</tr>
<tr>
<td>Ultra Fine</td>
<td>406 pixels per inch × 392 lines per inch (16 pixels per mm × 15.4 lines per mm)</td>
</tr>
<tr>
<td>Photo</td>
<td>203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7 lines per mm)</td>
</tr>
</tbody>
</table>

Color

200 × 200 dpi

Page memory

Up to 550 pages (ITU-T No. 1 chart; monochrome draft mode)

Redial

2 times (with 1 minute interval)

Interface

RJ-11 Phone Line
RJ-11 Telephone set connection

Parent topic: Technical Specifications

Ink Pack Specifications

Note: This printer is designed for use with Epson ink packs only, not third-party ink packs or ink. Other brands of ink supplies are not compatible and, if described as compatible, may not function properly or continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank cartridge-free printers.

The included initial ink packs are designed for reliable printer setup and cannot be used as replacement ink packs or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All ink packs must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced ink packs.

Color

Cyan, Magenta, Yellow, Black
### Ink pack life
Unopened package: do not use if the date on the package has expired

### Temperature
- **Storage**: –4 to 104 °F (–20 to 40 °C)
- 1 month at 104 °F (40 °C)
- Ink freezes at –9.4 °F (–23 °C)
- Ink thaws and is usable after approximately 12 hours at 77 °F (25 °C)

**Parent topic:** Technical Specifications

**Related references**

- Ink Supply Unit (Ink Pack) Part Numbers

## Dimension Specifications

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Stored: 24.4 inches (621 mm)</th>
<th>Printing: 27.5 inches (699 mm)</th>
<th>Stored: 45.7 inches (1162 mm)</th>
<th>Printing: 48.8 inches (1240 mm)</th>
<th>31 inches (787 mm)</th>
<th>Stored: 29.8 inches (758 mm)</th>
<th>Printing: 34.1 inches (866 mm)</th>
<th>34.4 inches (873 mm)</th>
<th>141.3 lb (64.1 kg)</th>
<th>254.8 lb (111.5 kg)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Height</strong> (printer only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Height</strong> (printer with two optional cassette units and cabinet)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Depth</strong> (printer only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Depth</strong> (printer with two optional cassette units and cabinet)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong> (printer only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong> (printer with two optional cassette units and cabinet)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Electrical Specifications

- **Power supply rating**: 100 to 240 V
- **Rated frequency range**: 50/60 Hz
- **Rated current**: 1.3 to 0.7 A
- **Power consumption**:
  - Standalone copying: Approx. 40 W (ISO/IEC24712)
  - Ready mode: 20 W
  - Sleep mode: 1.6 W
  - Power off mode: 0.45 W

Environmental Specifications

- **Temperature**
  - Operating: 50 to 95 °F (10 to 35 °C)
  - Storage: –4 to 104 °F (~20 to 40 °C)
  - 1 month at 104 °F (40 °C)
- **Humidity** (without condensation)
  - Operating: 20 to 80% RH
  - Storage: 5 to 85% RH

Interface Specifications

- **Interface type**
  - Super-Speed USB (Device Class for computers)
  - Hi-Speed USB (for Mass storage class for external storage)

**Note**: Epson cannot guarantee the operation of externally connected devices.
Related references
USB Device Photo File Specifications

External USB Device Specifications
Do not use devices with the following requirements:
• Dedicated driver
• Security settings
• Built-in USB hub

Note: Use only external storage devices with independent AC power sources. External storage devices that are powered via USB are not recommended. Epson cannot guarantee the operation of externally connected devices.

Magneto-optical drive 1.3GB
Hard disk and USB flash drives 2TB
Formatted in FAT, FAT32, or exFAT.

Parent topic: Technical Specifications

Network Interface Specifications

Note: Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location.

Wi-Fi

Standard IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location

Security WEP (64/128 bit)
WPA2-PSK (AES)
WPA-2 Enterprise

Frequency band 2.4 GHz
Communication mode

Infrastructure mode
Wi-Fi Direct (Simple AP)

Note: Wi-Fi Direct (Simple AP) mode available for IEEE 802.11b.

Ethernet

Standards
IEEE802.3i (10BASE-T)
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T); to prevent risk of radio interference, use a Category-5e or higher shielded twisted pair cable
IEEE802.3az (Energy Efficient Ethernet); connected device should be IEEE802.3az compliant

Communication mode
Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full duplex, 100Mbps Half duplex

Connector
RJ-45

Security Protocol
• IEEE802.1X (requires a connected device compliant with IEEE802.1X)
• IPSec/IP Filtering
• SSL/TLS; HTTPS Server/Client and IPPS
• SMPTPS; STARTTLS and SSL/TLS
• SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States
Safety: UL60950-1
EMC: FCC part 15 Subpart B class B

Canada
Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN ICES-3 (B)/NMB-3 (B)
This equipment contains the following wireless module:

• Manufacturer: Askey Computer Corporation.
• Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

**Notice for Argentina**

Fax Module

![CNC ID: H-17496](image1)

WLAN Module

![CNC ID: C-12902](image2)

**Notice for Mexico**

Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

Product Model: C522A (WF-C869R)
Brand: EPSON
IFT Certification Number: TTDEPC516-1983
WLAN Module Model: WLU6320-D69 (RoHS)
Brand: EPSON
IFT Certification Number: RCPEPWL14-0107

Notice for Paraguay
Imported by:
Fastrax, S.A.
Av. Perú esq. Río de Janeiro, Barrios Las Mercedes, Asunción, Paraguay
Imported by:
Sol Control S.R.L.
Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asunción, Paraguay

Notice for Peru
Product Model: WF-C869R (C522A)
Brand: EPSON
This product uses a fax module:
FCC ID: BKMFA01AC522A
This product uses the following WLAN module:
WLAN Module Model: WLU6320-D69 (RoHS)
FCC ID: BKMFBWLU6320
Product Manufacturer: Seiko Epson Corporation
Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan

Parent topic: Technical Specifications

PS3 Mode Fonts

Scalable Fonts

<table>
<thead>
<tr>
<th>Font name</th>
<th>Family</th>
<th>HP equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nimbus Mono</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Courier</td>
</tr>
<tr>
<td>Letter Gothic</td>
<td>Medium, Bold, Italic,</td>
<td>Letter Gothic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nimbus Mono PS</td>
<td>Regular, Bold, Oblique, Bold Oblique</td>
<td>Courier PS</td>
</tr>
<tr>
<td>Font name</td>
<td>Family</td>
<td>HP equivalent</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Nimbus Roman No4</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>CG Times</td>
</tr>
<tr>
<td>URW Classico</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>CG Omega</td>
</tr>
<tr>
<td>URW Coronet</td>
<td>—</td>
<td>Coronet</td>
</tr>
<tr>
<td>URW Clarendon Condensed</td>
<td>—</td>
<td>Clarendon Condensed</td>
</tr>
<tr>
<td>URW Classic Sans</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Univers</td>
</tr>
<tr>
<td>URW Classic Sans Condensed</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Univers Condensed</td>
</tr>
<tr>
<td>Antique Olive</td>
<td>Medium, Bold, Italic</td>
<td>Antique Olive</td>
</tr>
<tr>
<td>Garamond</td>
<td>Antiqua, Halbfett, Kursiv, Kursiv Halbfett</td>
<td>Garamond</td>
</tr>
<tr>
<td>Mauritius</td>
<td>—</td>
<td>Marigold</td>
</tr>
<tr>
<td>Algiers</td>
<td>Medium, Extra Bold</td>
<td>Albertus</td>
</tr>
<tr>
<td>NimbusSansNo2</td>
<td>Medium, Bold, Italic</td>
<td>Arial</td>
</tr>
<tr>
<td>Nimbus Roman No9</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Times New</td>
</tr>
<tr>
<td>Nimbus Sans</td>
<td>Medium, Bold, Oblique, Bold Oblique</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Nimbus Sans Narrow</td>
<td>Medium, Bold, Oblique, Bold Oblique</td>
<td>Helvetica Narrow</td>
</tr>
<tr>
<td>Palladio</td>
<td>Roman, Bold, Italic, Bold Italic</td>
<td>Palatino</td>
</tr>
<tr>
<td>URW Gothic</td>
<td>Book, Demi, Book Oblique, Demi Oblique</td>
<td>ITC Avant Garde Gothic</td>
</tr>
<tr>
<td>URW Bookman</td>
<td>Light, Demi, Light Italic, DemiItalic</td>
<td>ITC Bookman</td>
</tr>
<tr>
<td>URW Century Schoolbook</td>
<td>Roman, Bold, Italic, Bold Italic</td>
<td>New Century Schoolbook</td>
</tr>
<tr>
<td>Nimbus Roman</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Times</td>
</tr>
<tr>
<td>URW Chancery Medium Italic</td>
<td>—</td>
<td>ITC Zapf Chancery Medium Italic</td>
</tr>
<tr>
<td>Symbol</td>
<td>—</td>
<td>Symbol</td>
</tr>
<tr>
<td>URW Dingbats</td>
<td>—</td>
<td>Wingdings</td>
</tr>
</tbody>
</table>
### PCL Mode Fonts (URW)

#### Scalable Fonts

<table>
<thead>
<tr>
<th>Font name</th>
<th>Family</th>
<th>HP equivalent</th>
<th>Symbol set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nimbus Mono</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Courier</td>
<td>1</td>
</tr>
<tr>
<td>Letter Gothic</td>
<td>Medium, Bold, Italic</td>
<td>Letter Gothic</td>
<td>1</td>
</tr>
<tr>
<td>Nimbus Mono PS</td>
<td>Regular, Bold, Oblique, Bold Oblique</td>
<td>Courier PS</td>
<td>3</td>
</tr>
<tr>
<td>Nimbus Roman No4</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>CG Times</td>
<td>2</td>
</tr>
<tr>
<td>URW Classico</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>CG Omega</td>
<td>3</td>
</tr>
<tr>
<td>URW Coronet</td>
<td>—</td>
<td>Coronet</td>
<td>3</td>
</tr>
<tr>
<td>URW Clarendon Condensed</td>
<td>—</td>
<td>Clarendon Condensed</td>
<td>3</td>
</tr>
<tr>
<td>URW Classic Sans</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Univers</td>
<td>2</td>
</tr>
<tr>
<td>Font name</td>
<td>Family</td>
<td>HP equivalent</td>
<td>Symbol set</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>URW Classic Sans Condensed</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Univers Condensed</td>
<td>3</td>
</tr>
<tr>
<td>Antique Olive</td>
<td>Medium, Bold, Italic</td>
<td>Antique Olive</td>
<td>3</td>
</tr>
<tr>
<td>Garamond</td>
<td>Antiqua, Halbfett, Kursiv, Kursiv Halbfett</td>
<td>Garamond</td>
<td>3</td>
</tr>
<tr>
<td>Mauritius</td>
<td>—</td>
<td>Marigold</td>
<td>3</td>
</tr>
<tr>
<td>Algiers</td>
<td>Medium, Extra Bold</td>
<td>Albertus</td>
<td>3</td>
</tr>
<tr>
<td>NimbusSansNo2</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Arial</td>
<td>3</td>
</tr>
<tr>
<td>Nimbus Roman No9</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Times New</td>
<td>3</td>
</tr>
<tr>
<td>Nimbus Sans</td>
<td>Medium, Bold, Oblique, Bold Oblique</td>
<td>Helvetica</td>
<td>3</td>
</tr>
<tr>
<td>Nimbus Sans Narrow</td>
<td>Medium, Bold, Oblique, Bold Oblique</td>
<td>Helvetica Narrow</td>
<td>3</td>
</tr>
<tr>
<td>Palladio</td>
<td>Roman, Bold, Italic, Bold Italic</td>
<td>Palatino</td>
<td>3</td>
</tr>
<tr>
<td>URW Gothic</td>
<td>Book, Demi, Book Oblique, Demi Oblique</td>
<td>ITC Avant Garde Gothic</td>
<td>3</td>
</tr>
<tr>
<td>URW Bookman</td>
<td>Light, Demi, Light Italic, DemiItalic</td>
<td>ITC Bookman</td>
<td>3</td>
</tr>
<tr>
<td>URW Century Schoolbook</td>
<td>Roman, Bold, Italic, Bold Italic</td>
<td>New Century Schoolbook</td>
<td>3</td>
</tr>
<tr>
<td>Nimbus Roman</td>
<td>Medium, Bold, Italic, Bold Italic</td>
<td>Times</td>
<td>3</td>
</tr>
<tr>
<td>URW Chancery Medium Italic</td>
<td>—</td>
<td>ITC Zapf Chancery Medium Italic</td>
<td>3</td>
</tr>
<tr>
<td>Symbol</td>
<td>—</td>
<td>Symbol</td>
<td>4</td>
</tr>
<tr>
<td>URW Dingbats</td>
<td>—</td>
<td>Wingdings</td>
<td>5</td>
</tr>
<tr>
<td>Dingbats</td>
<td>—</td>
<td>ITC Zapf Dingbats</td>
<td>6</td>
</tr>
<tr>
<td>Font name</td>
<td>Family</td>
<td>HP equivalent</td>
<td>Symbol set</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>---------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Standard Symbol</td>
<td>—</td>
<td>SymbolPS</td>
<td>4</td>
</tr>
<tr>
<td>URW David</td>
<td>Medium, Bold</td>
<td>HP David</td>
<td>7</td>
</tr>
<tr>
<td>URW Narkis</td>
<td>Medium, Bold</td>
<td>HP Narkis Tam</td>
<td>7</td>
</tr>
<tr>
<td>URW Miryam</td>
<td>Medium, Bold, Italic</td>
<td>HP Miryam</td>
<td>7</td>
</tr>
<tr>
<td>URW Koufi</td>
<td>Medium, Bold</td>
<td>Koufi</td>
<td>8</td>
</tr>
<tr>
<td>URW Naskh</td>
<td>Medium, Bold</td>
<td>Naskh</td>
<td>8</td>
</tr>
<tr>
<td>URW Ryadh</td>
<td>Medium, Bold</td>
<td>Ryadh</td>
<td>8</td>
</tr>
</tbody>
</table>

**Bitmap Font**

Line Printer, Symbol set 9

**OCR/Barcode Bitmap Font for PCL5**

<table>
<thead>
<tr>
<th>Font name</th>
<th>Family</th>
<th>Symbol set</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR A</td>
<td>—</td>
<td>10</td>
</tr>
<tr>
<td>OCR B</td>
<td>—</td>
<td>11</td>
</tr>
<tr>
<td>Code 39</td>
<td>9.37cpi, 4.68cpi</td>
<td>12</td>
</tr>
<tr>
<td>EAN/UPC</td>
<td>Medium, Bold</td>
<td>13</td>
</tr>
</tbody>
</table>

**Note:** Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts may not be readable. Print a sample and check for readability before printing large quantities.

**Parent topic:** Technical Specifications

**Symbol Sets**

Your product can access a variety of symbol sets. Many of these symbol sets differ only in the international characters specific to each language.

**Note:** Since most software handles fonts and symbols automatically, you may never need to adjust your product settings. However, if you write your own product control programs, or if you use older software that cannot control fonts, refer to these tables for details on the symbol sets.
When you consider which font to use, also consider which symbol set to combine with the font. Available symbol sets vary depending on the mode and font you choose.

**PCL5 Mode Symbol Sets**

<table>
<thead>
<tr>
<th>Symbol set name</th>
<th>Attribute</th>
<th>Font classification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13</td>
</tr>
<tr>
<td>Norweg1</td>
<td>0D</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>Roman Extension</td>
<td>0E</td>
<td>— — — — — — ✓ — — — — —</td>
</tr>
<tr>
<td>Italian</td>
<td>0I</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>ECM94-1</td>
<td>0N</td>
<td>✓ ✓ ✓ — — — — ✓ — — — — —</td>
</tr>
<tr>
<td>Swedis2</td>
<td>0S</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>ANSI ASCII</td>
<td>0U</td>
<td>✓ ✓ ✓ — — ✓ ✓ — — — — —</td>
</tr>
<tr>
<td>UK</td>
<td>1E</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>French2</td>
<td>1F</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>German</td>
<td>1G</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>Legal</td>
<td>1U</td>
<td>✓ ✓ ✓ — — — — — ✓ — — —</td>
</tr>
<tr>
<td>8859-2ISO</td>
<td>2N</td>
<td>✓ ✓ ✓ — — — — — ✓ — — —</td>
</tr>
<tr>
<td>ISO 8859/4 Latin 4</td>
<td>4N</td>
<td>✓ ✓ ✓ — — — — — — — ✓ — —</td>
</tr>
<tr>
<td>Spanish</td>
<td>2S</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>Roman-9</td>
<td>4U</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>PSMath</td>
<td>5M</td>
<td>✓ ✓ ✓ — — ✓ ✓ — — — — —</td>
</tr>
<tr>
<td>8859-9ISO</td>
<td>5N</td>
<td>✓ ✓ ✓ — — — — — ✓ — — —</td>
</tr>
<tr>
<td>WiTurkish</td>
<td>5T</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>MsPublishin</td>
<td>6J</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>VeMath</td>
<td>6M</td>
<td>✓ ✓ ✓ — — — — — — — — —</td>
</tr>
<tr>
<td>8859-10ISO</td>
<td>6N</td>
<td>✓ ✓ ✓ — — ✓ ✓ — — — — —</td>
</tr>
<tr>
<td>Symbol set name</td>
<td>Attribute</td>
<td>Font classification</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1  2  3  4  5  6  7  8  9  10 11 12 13</td>
</tr>
<tr>
<td>DeskTop</td>
<td>7J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Math-8</td>
<td>8M</td>
<td>✓   ✓   ✓   —   —   —   ✓   ✓   —   —   —   —   —</td>
</tr>
<tr>
<td>Roman-8</td>
<td>8U</td>
<td>✓   ✓   ✓   —   —   —   —   —   ✓   —   —   —   —</td>
</tr>
<tr>
<td>WiE.Europe</td>
<td>9E</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Pc1004</td>
<td>9J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>8859-15ISO</td>
<td>9N</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   ✓   —   —   —</td>
</tr>
<tr>
<td>PCTk437</td>
<td>9T</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Windows</td>
<td>9U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>PsText</td>
<td>10J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>IBM-US</td>
<td>10U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   ✓   —   —   —</td>
</tr>
<tr>
<td>IBM-DN</td>
<td>11U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   ✓   —   —</td>
</tr>
<tr>
<td>McText</td>
<td>12J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   ✓   —</td>
</tr>
<tr>
<td>PCMultiling</td>
<td>12U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   ✓</td>
</tr>
<tr>
<td>VeInternati</td>
<td>13J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>PcEur858</td>
<td>13U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>VeUS</td>
<td>14J</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>PiFont</td>
<td>15U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>PcE.Europe</td>
<td>17U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Unicode 3.0</td>
<td>18N</td>
<td>✓   ✓   ✓   —   —   —   —   —   ✓   ✓   —   —   —</td>
</tr>
<tr>
<td>WiBalt</td>
<td>19L</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>WiAnsi</td>
<td>19U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>PcBlt755</td>
<td>26U</td>
<td>✓   ✓   ✓   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Pc866Cyr</td>
<td>3R</td>
<td>✓   ✓   —   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Greek8</td>
<td>8G</td>
<td>✓   ✓   —   —   —   —   —   —   —   —   —   —   —</td>
</tr>
<tr>
<td>Symbol set name</td>
<td>Attribute</td>
<td>Font classification</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13</td>
</tr>
<tr>
<td>WinGrk</td>
<td>9G</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>WinCyr</td>
<td>9R</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>Pc851Grk</td>
<td>10G</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>ISOcyr</td>
<td>10N</td>
<td>✓ ✓ — — — — ✓ — — — —</td>
</tr>
<tr>
<td>Pc8Grk</td>
<td>12G</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>ISOGrk</td>
<td>12N</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>Pc866Uk</td>
<td>14R</td>
<td>✓ ✓ — — — — — — — — — —</td>
</tr>
<tr>
<td>Hebrew7</td>
<td>0H</td>
<td>✓ — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>8859-8ISO</td>
<td>7H</td>
<td>✓ — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Hebrew8</td>
<td>8H</td>
<td>✓ — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Pc862Heb</td>
<td>15H</td>
<td>— — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>PC-862, Hebrew</td>
<td>15Q</td>
<td>— — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Arabic8</td>
<td>8V</td>
<td>— — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>HPWARA</td>
<td>9V</td>
<td>— — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Pc864Ara</td>
<td>10V</td>
<td>— — — — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Symbol</td>
<td>19M</td>
<td>— — ✓ — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Wingdings</td>
<td>579L</td>
<td>— — ✓ — — ✓ — — — — — —</td>
</tr>
<tr>
<td>Zapfdingba ts</td>
<td>14L</td>
<td>— — ✓ — — ✓ — — — — — —</td>
</tr>
<tr>
<td>OCR A</td>
<td>0O</td>
<td>— — — — — — — — — ✓ —</td>
</tr>
<tr>
<td>OCR B</td>
<td>1O</td>
<td>— — — — — — — — — ✓ —</td>
</tr>
<tr>
<td>OCR B Extension</td>
<td>3Q</td>
<td>— — — — — — — — — ✓ —</td>
</tr>
<tr>
<td>Code3-9</td>
<td>0Y</td>
<td>— — — — — — — — — ✓ —</td>
</tr>
<tr>
<td>Symbol set name</td>
<td>Attribute</td>
<td>Font classification</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>EAN/UPC</td>
<td>8Y</td>
<td>—</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications
Notices

Check these sections for important notices about your product.

**Note:** Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

**Important Safety Instructions**

Before using your Epson product, read and follow these safety instructions.

- **General Product Safety Instructions**
- **Optional Cabinet Safety Instructions**
- **Ink Pack Safety Instructions**
- **Wireless Connection Safety Instructions**
- **LCD Screen Safety Instructions**
- **Telephone Equipment Safety Instructions**

**Parent topic:** Notices

### General Product Safety Instructions

- Be sure to follow all warnings and instructions marked on the product.
- Use only the type of power source indicated on the product's label.
- Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
- Make sure the AC power cord meets the relevant local safety standard.
- Place the product near a wall outlet where the plug can be easily unplugged.
- Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

• Allow space behind the product for the cables, and space above the product so that you can fully raise the document cover.

• Leave enough space in front of the product for the paper to be fully ejected.

• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

• Do not place or store the product outdoors.

• Do not place the product near excessive heat sources or in direct sunlight.

• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.

• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

• When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

• Do not sit or lean on the product. Do not place heavy objects on the product.

• Do not touch the flat white cable inside the product.

• Do not move the print head by hand; this may damage the product.

• Do not put your hand inside the product while it is printing.

• Do not spill liquid on the product or use the product with wet hands.

• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.
• Do not press too hard on the scanner glass when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any other functions.
• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise, ink may leak.

Parent topic: Important Safety Instructions

Optional Cabinet Safety Instructions

• Do not install any other product on the cabinet besides the printer and paper cassettes mentioned in this manual.
• Do not climb on the cabinet or place heavy objects on it.
• Make sure the printer or paper cassettes are securely attached to the cabinet using the attachments and screws supplied with the cabinet.
• Make sure the casters on the cabinet are locked when using the printer.
• Do not move the cabinet when the casters are locked.
• Avoid rolling the cabinet over uneven or rough surfaces with the printer installed.

Parent topic: Important Safety Instructions

Ink Pack Safety Instructions

• Keep ink packs and maintenance boxes out of the reach of children and do not drink the ink.
• Be careful when you handle used ink packs; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately. If ink gets in your mouth, see a doctor right away.
• Do not put your hand inside the product or touch the ink packs during printing.
• Install a new ink pack immediately after removing an expended one. Leaving ink packs uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the ink pack; this can cause leakage.
• Do not remove the transparent seal from the ink supply area. This may cause the ink pack to become unusable.
• Do not touch the green IC chip on the side of the handle. This may prevent normal operation.
• Do not shake ink packs too vigorously; otherwise ink may leak.
• Use an ink pack before the date printed on its package.
• Do not disassemble an ink pack or a maintenance box. Ink may get in your eyes or on your skin.
• Store ink packs in a cool, dark place.
• After bringing an ink pack inside from a cold storage site, allow it to warm up at room temperature for at least 12 hours before using it.
• Store ink packs with the bottom facing down.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.
• Do not subject your product to sudden changes in temperature or humidity; this may cause condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk of fire, electric shock, and personal injury, including the following:

• Do not use the Epson product near water.

• Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.

• Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company. For products approved after July 23, 2001 , the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.
If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. But if advance notice isn't practical, the telephone company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of the equipment. If this happens the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment may not be used on coin service provided by the telephone company. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering fax header information.

According to the FCC's electrical safety advisory, we recommend that you may install an AC surge arrester in the AC outlet to which this equipment is connected. Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources and that this is a major nationwide problem.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Innovation, Science and Economic Development Canada technical specifications.

2. The Ringer Equivalence Number indicates the maximum number of devices allowed to be connected to a telephone interface. The termination of an interface may consist of any combination of devices subject only to the requirement that the sum of the RENs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)

Le présent produit est conforme aux spécifications techniques applicables d’Innovation, Sciences et Développement économique Canada.

L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une combinaison quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs n’excède pas cinq.

CAN ICES-3(B)/NMB-3(B)
Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY’S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at [http://www.jamsadr.com](http://www.jamsadr.com) or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson’s address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™ is a trademark of Seiko Epson Corporation.

Epson Store℠ is a service mark of Epson America, Inc.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, iPhone, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. App Store is a service mark of Apple Inc., registered in the U.S. and other countries.

Google® is a registered trademark and Android™, Chromebook™, Google Chrome™, Google Cloud Print™, and Google Drive™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials

Default Delay Times for Power Management for Epson Products

Copyright Attribution

Parent topic: Notices

libTIFF Software Acknowledgment

Copyright © 1988-1997 Sam Leffler


Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2019 Epson America, Inc.
6/19
CPD-52584R4

Parent topic: Copyright Notice